
5700 Dot Com ct 
Suite 1010 
Oviedo, FL 32765 
1-800-557-7590 
www.flyelite.com 

PI-1000 
Instruction Manual

Topics Included: 
• Startup Guide 
• Troubleshooting Procedures 
• G-1000 Features Description 
• G-1000 Simulator Users Guide 
• Vispro Instructor Station Users Guide 

http://www.flyelite.com
http://www.flyelite.com




ELITE PI-1000 Start-Up Guide

The following instructions are based on the PI-1000 two computer configuration; The computer, 
labeled MAIN, runs the G1000 program and the VisPro Instructor Station.  The computer 
labeled VISUAL runs the Lockheed Martin Prepar3D visual scenery.

1. Start Prepar3d on the visual computer.

When powered on, the visual computer should automatically run the program Prepar3D or P3D. 
If the program does not run on its own, click on the P3D icon on the VISUAL computer and allow 
to program to boot up. The simulator visuals will appear on the monitors when P3D is finished 
booting.

2. Start VisPro Instructor Station on the MAIN computer desktop.

Click the icon for VisPro (shown below), or select the VisPro program from the computer’s 
program list. Make sure the simulator is not paused before opening VisPro (pause and un-
pause pressing the “ptt” button on the right yoke handle).

               Open VisPro Program Icon

3. Start the G1000 Student Simulator program on the MAIN computer desktop.
Click the program icon to launch the G1000 PFD, MFD and Standby Instrument Display (shown 
below) or find the program from the computer’s program list.

              G1000 Student Simulator Program Icon



“UNABLE TO CONNECT” ERROR: If you receive this error message, UN-PAUSE the simulator. 
Pause and un-pause pressing the “ptt” button on the right side of the yoke. Once the simulator 
is in “free flight” mode (not paused), press ok on the error message.

Ensure the IP Address for the VISUAL computer (Prepar3D) and the IP Address in the blank 
field “Enter IP Manually” (shown below) are the same. 

If the IP Address in the field “Enter IP Manually” does not match the one next to the one next to 
(Prepar3D), manually enter the IP shown next to (Prepar3D) in the blank field and ensure the 
box next to Enter IP manually is checked.

Then press “Connect” 



If the “G1000 Student Simulator”  program for the G1000 instruments does not connect:
Ensure the IP address shown for P3D matches the IP address in the blank field under “Enter IP 
Manually.” If the two IP addresses shown are not the same, manually enter the IP address in the 
blank field so that it matches the IP address listed under “Simulators Found on the LAN” next to 
P3D. Ensure the box is checked next to “Enter IP Manually” then press “Connect.”



ERROR: G1000 connects but the screens are blank. 
If the screens of the G1000 do not appear (the instruments and map do not appear), click the 
tab in the program called “Window Positions.” Follow these steps after the G1000 is connected.
After checking the boxes, return to the “main” tab and press “Exit” to save the changes for the 
next time the program starts.

Under the section called “Display Options” ensure the boxes are checked for “Show PFD” 
“Show MFD” and “Show IESI.” (shown below)



If the G1000 screens DO NOT APPEAR after checking the boxes in the previous step you may 
need to re-select the display from the drop down menu under PFD and MFD (shown below).
Click the drop down box and RE-SELECT the SAME DISPLAY by clicking on it from the drop 
down menu. In the example shown below “\DISPLAY12” was already showing under MFD, click 
on the words “\DISPLAY12” and select the SAME display (\DISPLAY12) from the drop down list. 
This cycles the displays and the MFD and PFD should now appear on the G1000 monitors.



CHANGING AIRCRAFT

On the instructor station, click the “reposition” page then “select aircraft.”
Choose the aircraft you wish to fly then press “OK.” You will need to wait for the visual to reload 
and for the G1000 engine instruments to change to the appropriate aircraft.

The G1000 should automatically change to the aircraft engine instruments selected on the 
instructor station. If they do not, you many change it manually in the G1000 program, select the 
aircraft from the drop down menu to match the one you selected from the instructor station, then 
press “Save.”



Shut Down Procedure:

Click the icon shown
to the right, from the
instructor station then 
scroll down to 
Remote PC, then click 
“Shut Down.”

This will turn off the 
visual computer.

Then, click on the start
menu on the lower left
corner of the instructor 
station screen, and
click “Shut Down.”
This will power off
the instructor station
computer.

Once the computers are
shut down completely, 
you may turn off the 
main power source,
usually by flipping 
a switch on the
power supply or by
using a remote button.
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Flight Controls Configuration Guide 

!  
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Access Flight Control Configuration 
You will need to configure your hardware to get the maximum possible experience.  To 
access the settings page go to the Add-ons menu from the Visual Computer, and select 
ELITE Config. Remember, when you are finished, click OK to save your settings. 

On some systems, the configuration window does not work in full screen mode, so it is 
recommended that you get out of full screen mode first. You can switch to windowed 
mode by hitting ALT+Enter, and then use the same key combination to revert back to full 
screen mode after you finish adjusting the plugin settings. 

The Main Tab 
When the ELITE Hardware Configuration window opens, the Main tab will always be the 
default one to be displayed. Here, you can see information about which aircraft you 
have selected, select a COM port for detecting serial ELITE hardware (or use the Scan 
button for automatic detection), and determine which ELITE USB hardware is being 
detected by the plugin that is working with Microsoft Flight Simulator. 

In the Configuration box, you can also choose if the settings you will be adjusting would 
apply globally for all aircraft (Global), or just the aircraft you have selected (Aircraft), and 
you can also choose to Override settings you are using with saved settings from the list. 
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The Flight Controls Tab 
In the Flight Controls tab you can verify the proper functionality of your flight controls by 
moving the yoke, rudder, and toe brakes by seeing how they react on the display. If any 
of the items are moving in the opposite direction than you anticipate (such as an 
indication of turning right when you turn the yoke left), you can select the RVS (reverse) 
button to correct the behavior. You can also assign functions to the rocker switch and 
the push buttons on the yoke of an ELITE flight console. 

!  
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The Flight Controls Calibration Tab 
In the FC (Flight Controls) Calibration tab, you will be able to calibrate your Aileron, 
Elevator, and Rudder controls. To do so, follow these instructions: 

1. Do not touch the controls, so they are at their neutral position. Click the Center 
Position button, and then the Set button under it to lock in the center position for 
the yoke and rudder. 

2. Click the Limits button, and move the yoke all the way to the left, right, forward, 
and backwards, and the rudder fully to the left and to the right, to put the controls 
through their full range of motion. Then push the Set button under it to lock in the 
calibration values. 

3. Optionally, if you choose, to set a null or non-usable area, click Null Zone, hold 
the controls to the desired null value and press the Set button beneath Null Zone. 

4. Next to the Brakes settings, click the Limits button, depress the toe brakes to the 
full extent, and press the Set button. 

5. Click OK when you are finished adjusting the ELITE Hardware Configuration 
settings, and the calibration changes will be saved. 

!  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The Power Quadrant Tab 
On the Power Quadrant tab, you can configure your throttle quadrant for use with 
different types of aircraft configurations. On this page you can select what type of 
engine that your chosen plane has (piston, turboprop, jet or other) and how many 
engines there are. 

You can also select the type of throttle quadrant you are using (single-engine, multi-
engine, or King Air), as well as choose a lever assignment of your choice to best meet 
your needs for your aircraft configuration, for example on with a single-engine quadrant 
you can choose throttle/prop/mixture, or prop/throttle/mixture. 

If the aircraft you are using has a reversed axis, press the RVS (reverse) button for 
each axis you want to make reversed. You can also choose to turn off the landing gear 
and flap switches for configurations where your aircraft doesn’t have them or you have 
another hardware device with gear and flap controls. 

!  
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The Power Quadrant Calibration Tab 
The Power Quadrant (PQ) Calibration tab is where you can calibrate the different axis 
on your ELITE throttle devices. To do so, follow these instructions: 

1. Select the type of throttle quadrant you are using. You can choose Single Engine 
(for SEL quadrant or Vernier ECUs), Twin Engine (MEL quadrant), or King Air. 

2. Move all of the levers to the very bottom (0%), and press the bottom Set button. 
The dashes at that point will turn from red to green, indicating acceptance of the 
bottom-point calibration value. 

3. Move all of the levers to the middle (50%), or with King Air quadrants, to the 
detent positions indicated on the screen. Then press the middle Set button, and 
these dashes will change to green to indicate acceptance of the mid-point 
calibration value. 

4. Move all of the levers all the way forward (100%), then press the upper Set 
button. Those dashes should also change to green, to indicate acceptance of the 
top-point calibration value. 

5. Once all of the indicator markings have become green, the calibration has been 
completed. If you make a mistake at any point, you can press the Reset button to 
start again. You can also reset the calibration for all of your throttle quadrants by 
clicking Reset All. Click OK when you are finished adjusting the ELITE Hardware 
Configuration settings, and the calibration changes will be saved. 
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The Avionics Panel Tab 
On the avionics panel tab, you can create custom assignments for the buttons on the 
Tremble or Apollo GPS modules on AP2000, AP3000, or AP4000 avionics panel. 

In the Autopilot box, ALT Hold fixes a Microsoft bug with the altitude hold function, and 
APR makes the autopilot capture the glide slope. These options are checked by default. 

To assign a custom function to a GPS button, press any one of the GPS buttons. When 
you push the button, the option menu that corresponds to that button will become 
selected. You can then assign a function to the button from that dropdown menu. You 
can then push another button, and do the same, until you have assigned a function to 
all of the buttons you choose. You can also assign a function to the INSTR and MAP 
buttons. 

If you have an AP1000, check the box for “AP1000 connected” and a different set of 
button options will appear. To assign functions to them, follow the direction of the 
previous paragraph. 
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The Pro Panel Tab 
In the Pro Panel tab, you can adjust the settings for the Pro Panel for custom unique 
configurations. If you have a piston or turboprop/jet configuration with three or four 
engines, choose the Set button that corresponds to the configuration you are using. 
Then choose a desired starter/magneto configuration from the list that appears, and 
click OK. 

You can also assign which engine’s fuel supply that the fuel selector would respond to 
for aircraft with two, three, or four engines. 

You can also choose which aircraft lights would be controlled by the Nav light, Strobe 
light, and Landing light switches. Remember to click OK to save all of your changes. 

!  
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Once you have finished adjusting all of your settings 
in the ELITE Hardware Configuration window,  

you must click OK to save your changes. 

Support Information 

If you need assistance please visit 

www.support.flyelite.com 

Copyright 2015 by ELITE Simulation Solutions, All Rights Reserved
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INTRODUCTION 
The Garmin G1000 provides pilots with a dazzling amount of information and capabilities.  The 
ELITE PI-1000 is an advanced aviation training device (AATD) uses the G1000 emulation by 
Flight 1 Tech which is the most advanced non-OEM product available for G1000 training.  ELITE 
hardware, coupled with the Flight 1 Tech VisPro Instructor /Operator Station (IOS) and 
Lockheed Martin P3D visual scenery provide the best “benefit-to-cost” ratio for G1000 training 
available. 

It is not a real G1000. It simulates the form and function of the real G1000 avionics suite.  It 
is designed to accurately simulate the features and functions VFR and IFR pilots use most 
frequently. We think you’ll be surprised at the depth of the simulation and functionality that 
will allow maximum transfer of training from the AATD to the cockpit.  Unlike OEM 
equipment, we are able to present the option of several aircraft, including 2 light piston twin 
engine models and at a substantial cost savings over original equipment.  The trade-off, 
however, is the inability to simulate a few characteristics as explained further in this 
document. 

There are many different versions of the real G1000 hardware and software, so what we’ve 
simulated in this training device may not exactly match what you’re used to. This software is 
modeled after the Garmin G1000 Cessna Nav III, Diamond and Beech aircraft variations of the 
G1000 software, with an integrated GFC 700 Automatic Flight Control System (AFCS). 

What follows is worth a careful read so you’ll fully understand just how much you can do with 
this simulation. We’ll follow the same structure the real Garmin G1000 Pilot’s Guide does, 
since you may be familiar with it. 

SYSTEM OVERVIEW 

System Description 
The ELITE PI-1000 simulates the G1000 Integrated Flight Deck as installed in Cessna Nav III 
aircraft (Cessna 172R, 172S, 182T, T182T, 206, and T206) the Diamond DA40, DA42 and 
Beech Baron G58. Each aircraft configuration features the appropriate V-speeds and Engine 
Indication System (EIS) layout. 

The displays and controls for each of the following Line Replaceable Units (LRUs) are 
presented: 

• GDU 1040B Primary Flight Display (PFD) 
• GDU 1040B Primary Flight Display (MFD) 
• GMA 1347 Audio System with Integrated Marker Beacon Receiver 

The instructor, via the Instructor / Operator Station (IOS), has the ability to manually fail 
specific components of the G1000 PFD and MFD displays. 
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G1000 Controls 
PFD/MFD 
Controls 

The real functionality of most PFD/MFD controls is simulated: 

• NAV Frequency Transfer Key 

• Dual NAV Knob 
• Heading Knob 
• CRS/BARO Knob 
• Dual COM Knob 
• COM Frequency Transfer Key 
• Direct-to Key 
• FPL Key 

• CLR Key (DFLT MAP) 
• Dual FMS Knob 
• MENU Key 
• PROC Key 
• ENT Key 

• Dual ALT Knob 

The COM and NAV VOL/ID knobs and the Joystick are not functional. 

The following GFC 700 AFCS controls are simulated: 

• AP Key 
• HDG Key 
• NAV Key 
• APR Key 
• VS Key 
• FLC Key 
• FD Key 

• ALT Key 
• VNV Key 
• BC Key 
• NOSE UP/NOSE DN Keys 
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Audio Panel Controls 
The real functionality of most Audio Panel controls is simulated: 

• COM1 MIC 
• COM1 
• COM2 MIC 
• COM2 
• MKR/MUTE 
• DME 
• NAV1 
• ADF 
• NAV2 
• Reversionary Mode Button 

The COM3 MIC, COM3, PA, TEL, MUSIC, SPKR, HI SENS, AUX, REC, PLAY, INTRCOM, and MAN SQ buttons and the PILOT 
and PASS 
knobs are not functional. 

Secure Digital (SD) Cards 
The use of Secure Digital cards for storing databases and software system updates is not 
simulated. 

The G1000 navigational database can be manually upgraded by purchasing an upgrade 
from Navigraph.com and Flight1 Aviation Technologies. 

G1000 Simulator software updates are available via a button on the main G1000 Simulator 
interface. 

System Power-Up 
When the MFD powers up, a simulated power-up screen is displayed. 

PFD initialization is not simulated at this time. 

System Operation 

Normal Display Operation 
As on the real G1000, the G1000 PFD presents graphical flight instrumentation and the MFD 
displays a full-color moving map with navigation information, as well as the Engine Indication 
System (EIS). 

Reversionary Display Operation 
Reversionary Mode (in which all important flight information is displayed on one display) 
can be manually activated by pressing the Display Backup button on the Audio Panel. 
Reversionary Mode is simulated on both the PFD and the MFD.  Reversionary Mode is 
realistically simulated after a display failure. 

AHRS Operation 
Loss of attitude and heading information, due to failure of the internal Attitude and Heading 
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Reference System (AHRS) inertial sensors, can be also be simulated via the IOS.  When 
enabled, red ‘X’ flags display over the corresponding flight instruments. 

Other AHRS failures, annunciations, and message advisories are not simulated. 

G1000 System Annunciations 
Instructors can manually fail individual Line Replaceable Units (LRUs) and other components of 
the G1000. When failed, appropriate failure flags and/or indications will display on the PFD 
and MFD to indicate failure of the responsible components. 

LRUs and other components that can be failed include: 

• GIA 63 Integrated Avionics Unit 
• GTX1 and GTX2 Transponders 
• GRS 77 AHRS 
• GMU 44 Magnetometer 
• GDC 74A Air Data Computer 
• GFC 700 Automatic Flight Control System 
• VHF Comm Radio 
• VHF Nav Radio 
• DME 
• RAIM Availability 
• Traffic 
• Attitude 
• Airspeed 
• Vertical Speed 
• Heading 
• Altitude 
• Engine Indicators 
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GPS Receiver Operation 
GPS information collected by the Integrated Avionics Units may be viewed on the AUX - GPS 
STATUS 
page on the MFD. The GPS Status page displays a basic simulation of: 

• Satellite constellation diagram 
• Satellite signal information status 
• GPS receiver status 
• RAIM (Receiver Autonomous Integrity Monitoring) Prediction 
• SBAS Selection 
• GPS Satellite Signal Strengths 

RAIM Prediction at the aircraft present position is simulated, and RAIM can be made 
unavailable via the IOS. 

RAIM Prediction at specific waypoints, WAAS Disabling, and GPS sensor annunciations are not simulated. 

Accessing G1000 Functionality 

Menus 
The MENU Key, when pressed, displays a context-sensitive list of options related to the 
currently displayed window/page. Options can be selected using the FMS knob and the ENTER 
Key. 

Not all menus or options are simulated. 

MFD Page Groups 
Information on the MFD is presented on pages which are grouped according to function. The 
following page groups and pages are simulated: 

Map Pages (MAP) 
• Navigation Map 
• Traffic Map 
• Terrain Proximity 

Stormscope®, Weather Data Link, Terrain-SVS, and TAWS-B pages are not simulated. 
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Waypoint Pages (WPT) 
• Airport Information Pages 

-Airport Information (INFO-1 softkey) 
• Intersection Information 
• NDB Information 
• VOR Information 

Airport Directory, Departure Information, Arrival Information, Approach Information, Weather Information, 
and User 
Waypoint Information pages are not simulated. 

Auxiliary Pages (AUX) 
• Trip Planning (in Automatic page mode and Flight Plan mode only) 
• Utility (with usable Generic Count Up Timer) 
• GPS Status (including RAIM Prediction at present position) 
• System Setup (with configurable Time Format, Temperature Display Units, and MFD 
Data 

Bar 
Fields) 

• System Status 

SiriusXM Satellite pages and the Video page are not simulated. 

Flight Plan Pages (FPL) 
• Active Flight Plan 
• Flight Plan Catalog 

Nearest Pages (NRST) 
• Nearest Airports 
• Nearest Intersections 
• Nearest NDB 
• Nearest VOR 

Nearest User Waypoints, Nearest Frequencies, and Nearest Airspaces pages are not simulated. 

Procedure Pages (PROC) 
• Departure Loading 
• Arrival Loading 
• Approach Loading 

MFD System Pages 
In the Auxiliary (AUX) Page Group, there are two system pages: System Setup and System 
Status. 

The System Setup Page allows management of various system parameters. Manual 
configuration of 
Time Format, Temperature Display Units, and MFD Data Bar Fields  are simulated. 

The System Status Page, which displays the status and software version numbers for all 
detected system 
LRUs as well as information on all system databases, is simulated. 
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IOS Failures  only affect the display of relevant data on the PFD and MFD displays. Triggered failures do not affect 
LRU Status on the System Status page. 
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Display Backlighting 
Automatic and manual adjustment of display backlighting is not simulated. 

FLIGHT INSTRUMENTS 

Flight Instruments and Supplemental Flight Data 

All real G1000 flight instrumentation is simulated. The following flight instruments and 
supplemental flight data are displayed on the PFD: 

• Airspeed Indicator, showing 
o Indicated airspeed 
o True airspeed 
o Trend vector 
o Airspeed awareness ranges 
o V-speed reference flags 

• Attitude Indicator with slip/skid indication 
• Altimeter (standard or metric values), showing 

o Trend vector 
o Barometric setting 
o Reference altitude 

• Vertical Deviation, Glideslope, and Glide path Indicators 
• Vertical Speed Indicator (VSI) 
• Vertical Navigation (VNV) indications 
• Outside air temperature (OAT) (in degrees Celsius or Fahrenheit) 
• Horizontal Situation Indicator, showing 

o Turn Rate Indicator 
o Bearing pointers and information windows 
o Navigation source 
o Course Deviation Indicator (CDI) (including flight phase annunciation, OBS 
scaling, and 

OBS mode) 
o DME Information Window 

• Transponder Mode, Code, and Ident/Reply 
• Timer/References Window, showing 

o Generic timer 
o V-speed values (configurable) 
o Barometric Minimum Descent Altitude (MDA) 

• Wind data: 
o Wind direction arrows with headwind/tailwind and crosswind components 
o Wind direction arrow and numeric speed 
o Wind direction arrow with numeric True direction and numeric speed 
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PFD Annunciations and Alerting Functions 

System Alerting 
The following alerts are simulated on the PFD (along with the associated softkey 
annunciations and audio alerts): 

Warning Alerts (red): 

• LOW VOLTS 
• OIL PRESSURE 

Caution Alerts (yellow): 

• LOW FUEL L 
• LOW FUEL R 
• LOW VACUUM 

System Message Advisories (white) and Safe Operating Annunciations (green) are not simulated. 

G1000 System Annunciations 
The only System Annunciations simulated are those related to the failures listed in the “G1000 
System 
Annunciations” sub-section of the “System Overview” section of this document (above). 

Marker Beacon Annunciations 
Marker Beacon Annunciations are fully simulated. 

Traffic Annunciation 
The G1000 Student Simulator features a robust Traffic Annunciation simulation that works 
with the AI aircraft generated by the flight simulation. Traffic is displayed symbolically on the 
PFD Inset Map, the MFD Navigation Map Page, and various other MFD page maps. Refer to the 
“Hazard Avoidance” section of this document (below) for more details about the Traffic 
Information Service (TIS) simulation. 

TAWS Annunciations 

Terrain Awareness and Warning System (TAWS) obstacle annunciations appear at the top of 
the PFD 
to the left of the Altimeter. 

Altitude Alerting 
Altitude alerting is simulated: 

• Upon passing through 1,000 feet of the selected altitude 
• When the aircraft passes within 200 feet of the selected altitude 
• After reaching the selected altitude, if the aircraft deviates +/- 200 feet 

Low Altitude Annunciation 
A “LOW ALT” annunciation (when the aircraft is low at the FAF on a WAAS approach) is not 
simulated at this time. 
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Minimum Descent Altitude/Decision Height Alerting 
MDA and DH can be set in the Timer/Reference Window, and the associated visual 
annunciations and aural alerts are simulated. 

Abnormal Operations 

A b n o r m a l G P S 
Conditions 
Abnormal GPS Conditions are not 
simulated. 

U n u s u a l 
Attitudes 
Unusual Attitude functionality on the PFD is fully simulated. Red chevrons appear starting at 
50 degrees above and 30 degrees below the horizon line. PFD de-cluttering occurs if pitch 
exceeds +30/-20 degrees or bank exceeds 65 degrees. 

ENGINE INDICATION SYSTEM 
(EIS) 
All real Engine Display, Lean Display, and System Display indications are simulated on the 
MFD Engine Indication System (EIS), and are accessible via softkeys. In manually-activated 
Reversionary Mode, EIS data is displayed on the left side of the PFD. 

E n g i n e 
Display 
The Engine Display shows critical engine and electrical parameters. All real Engine Display 
gauges, indicators, and readouts are simulated for the aircraft configuration selected in the 
main interface. 

C e s s n a N a v I I I a i r c r a f t 
configuration: 

• Engine Manifold Pressure Gauge (MAN IN) Models 182T, T182T, 206H, T206H 
• Tachometer (RPM) 
• Fuel Flow Indicator (FFLOW GPH) 
• Oil Pressure Indicator (OIL PRES) 
• Oil Temperature Indicator (OIL TEMP) 
• Cylinder Head Temperature Indicator (CHT) Models 182T, T182T, 206H, T206H 
• Exhaust Gas Temperature Indicator (EGT) Normally-aspirated Aircraft 
• Turbine Inlet Temperature Indicator (TIT) Turbocharged Aircraft 
• Vacuum Pressure Indicator (VAC) Models 172R and 172S 
• Fuel Quantity Indicator (FUEL QTY GAL) 
• Engine Hours (Tach) (ENG HRS) Models 172R and 172S 
• Voltmeter (M, E BUS VOLTS) 
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• Ammeter (M, S BATT AMPS) 

Diamond DA40 aircraft 

configuration: 
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• Engine Manifold Pressure Gauge (MAN IN HG) 
• Tachometer (RPM) 
• Fuel Flow Indicator (FUEL FLOW GPH) 
• Cylinder Head Temperature Indicator (CHT) 
• Oil Temperature Indicator (OIL TEMP) 
• Oil Pressure Indicator (OIL PRES) 
• Ammeter (AMPS) 
• Voltmeter (VOLTS) 
• Fuel Quantity Indicator (FUEL QTY GAL) 

The expanded DA40 Engine page is not simulated. 

Diamond DA42 aircraft configuration: 

• Engine Load Indicator (LOAD %) 
• Tachometer (RPM) 
• Fuel Flow Indicator (FUEL FLOW GPH) 
• Oil Temperature Indicator (OIL TEMP) 
• Oil Pressure Indicator (OIL PRES) 
• Coolant Temperature Indicator (COOLANT TEMP) 
• Fuel Temperature Indicator (FUEL TEMP) 
• Fuel Quantity Indicator (FUEL QTY GAL) 

Lean Display 
The Lean Display provides information for engine leaning. All real Lean Display gauges, 
indicators, and readouts (including Cylinder selection) are simulated for the aircraft 
configuration selected in the main interface. 

Cessna Nav III aircraft configuration: 

• Engine Manifold Pressure Gauge (MAN IN) Models 182T, T182T, 206H, T206H 
• Tachometer (RPM) 
• Fuel Flow (FFLOW GPH) 
• Exhaust Gas Temperature Bar Graph (EGT °F) 
• Cylinder Head Temperature Bar Graph (CHT) 
• Fuel Quantity Indicator (FUEL QTY GAL) 

Lean Assist is not fully simulated at this time. 

Diamond DA40 aircraft configuration: 

• Engine Manifold Pressure Gauge (MAN IN HG) 
• Tachometer (RPM) 
• Fuel Flow (FFLOW GPH) 
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• Exhaust Gas Temperature Bar Graph (EGT °F) 
• Cylinder Head Temperature Bar Graph (CHT °F) 

Lean Assist is not fully simulated at this 
time. 

S y s t e m 
Display 
The System Display shows critical engine, fuel, and electrical parameters. All real System 
Display gauges, indicators, and readouts (including fuel calculations) are simulated for the 
aircraft configuration selected in the interface. 

C e s s n a N a v I I I a i r c r a f t 
configuration: 

• Engine Manifold Pressure Gauge (MAN IN) Models 182T, T182T, 206H, T206H 
• Tachometer (RPM) 
• Oil Pressure (OIL PSI) 
• Oil Temperature (OIL °F) 
• Engine Hours (Tach) (ENG HRS) Models 182T, T182T, 206H, T206H 
• Vacuum Pressure Indicator (VAC) Models 182T, T182T, 206H, T206H 
• Fuel Flow (FFLOW GPH) 
• Calculated Fuel Used (GAL USED) 
• Set Fuel Remaining (GAL REM) 
• Fuel Quantity Indicator (FUEL QTY GAL) 
• Voltmeter (M, E BUS VOLTS) 
• Ammeter (M, S BATT AMPS) 

Diamond DA40 aircraft 

configuration: 

• Engine Manifold Pressure Gauge (MAN IN HG) 
• Tachometer (RPM) 
• Oil Temperature (OIL °F) and Oil Pressure (OIL PSI) 
• Voltmeter (VOLTS) and Ammeter (AMPS) 
• Fuel Flow (FFLOW GPH) 
• Fuel Pressure (FPRESS PSI) 
• Set Fuel Remaining (GAL REM) 
• Calculated Fuel Used (GAL USED) 
• Calculated Endurance (ENDUR) 
• Calculated Range (RANGE NM) 
• Total Time in Service (TTL TIME IN 

SVC) Diamond DA42 aircraft configuration: 
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• Engine Load Indicator (LOAD %) 
• Tachometer (RPM) 
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• Voltmeter (VOLTS) 
• Ammeter (AMPS) 
• Gearbox Temperature Indicator (GEARBOX °C) 
• Coolant Temperature Indicator (COOLANT °C) 
• Oil Temperature Indicator (OIL °C) 
• Oil Pressure Indicator (OIL BAR) 
• Deice Fluid Indicator (DEICE FLUID) (Optional) 

Fuel Display 
The Diamond DA40 and DA42 aircraft configurations also feature a Fuel Display. All real 
Fuel Display gauges, indicators, and readouts (including fuel calculations) are simulated. 

Diamond DA42 aircraft configuration: 

• Engine Load Indicator (LOAD %) 
• Tachometer (RPM) 
• Fuel Quantity Indicator (FUEL GAL) 
• Fuel Flow Indicator (FUEL GPH) 
• Fuel Temperature Indicator (FUEL °C) 
• Set Fuel Remaining (GAL REM) 
• Calculated Fuel Used (GAL USED) 
• Calculated Endurance (ENDUR) 
• Calculated Range (RANGE NM) 
• Total Time in Service (TTL TIME IN SVC) 

AUDIO PANEL AND CNS 

Overview 
The Communication/Navigation/Surveillance (CNS) system includes the Audio Panel, 
communication radios, navigation radios, and Mode S transponder. Most Audio Panel and CNS 
elements are simulated, within the limits of the flight simulation. 

COM Operation 
Most communications radio functionality is simulated, and works with the air traffic control 
feature. Features simulated include: 

• COM transceiver selection and activation 
• Manual tuning and auto-tuning from both the PFD and MFD 
• 25-kHz frequency spacing 

Transmit/Receive indications, 8.33-kHz frequency spacing, automatic squelch, and volume control, are not 
simulated. 
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NAV Operation 
Most navigation radio functionality is simulated, including: 

• NAV radio selection and activation via the PFD CDI Softkey 
• NAV radio audio monitoring 
• VOR/LOC ID, manual tuning and auto-tuning from both the PFD and MFD 
• Marker beacon receiver indications and audio 

Volume control is not simulated. 

GTX 33 Mode S Transponder 
Most transponder features are simulated, and work with the Air Traffic Control feature.  
Features simulated include: 

• Transponder Mode Selection (Ground, Standby, Manual On, Manual and Auto Altitude) 
• Reply Status 
• Transponder code entry via softkeys 
• VFR Code 
• Ident 

Entry of a transponder code using the PFD FMS knob, and Flight ID Reporting are not simulated. 

Additional Audio Panel Functions 
Audio panel power-up, Speaker, Intercom, Intercom Volume and Squelch, PA System, 
Clearance Recorder and Player, and entertainment inputs are not simulated. 

FLIGHT MANAGEMENT 

Introduction 
The information to successfully navigate the aircraft using the GPS sensors is displayed on 
the PFD and the MFD. Most of the flight management features of the real G1000 is 
simulated. 

Navigation Status Box 
As on the real G1000, the Navigation Status Box located at the top of the PFD contains two 
fields that display: the active flight plan leg or flight plan annunciations, and distance and 
bearing to the next waypoint or flight plan annunciations. 

The Navigation Status Box located at the top of the MFD contains four data fields that can be 
configured on the AUX – SYSTEM SETUP Page. 

Configuration of the MFD Navigation Status Box data fields to display Endurance, Enroute Safe Altitude, Fuel On 
Board, Fuel 
Over Destination, Minimum Safe Altitude, Track Angle Error, or Vertical Speed Required is not simulated. 
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Using Map Displays 
Some of the most useful features of the G1000 are its many map displays. In the G1000 
Student 
Simulator, the following maps are simulated: 

• PFD Inset Map 
• MFD Navigation Page Map 
• MFD Waypoint Pages Map 
• MFD Nearest Pages Map 
• MFD Active Flight Plan Page Map 
• MFD Trip Planning Page Map (Automatic page mode only) 

Map Orientation 
By default, all maps are displayed using a North Up (NORTH UP) orientation. PFD and MFD 
maps can individually be changed to Heading Up (HDG UP), Track Up (TRK UP), or Desired 
Track Up (DTK UP) orientations via the main interface. 

Map Range 
As on the real G1000, all maps feature 28 different ranges, from 500 feet to 2000 NM. 

Auto Zoom 
Auto zoom, which allows the G1000 to change the map display range to the smallest 
range clearly showing the active waypoint, is not simulated. 

Map Panning and Measuring Bearing and Distance 
Map panning, and measuring bearing and distance using the G1000 Joystick, is not simulated. 

Topography 
As on the real G1000, all navigation maps can display various shades of topography colors 
representing land elevation. Topographic data can be displayed or removed using the TOPO 
Softkey. A Topographic Scale can be toggled on and off on the “Options 2” tab of the main 
G1000 Student Simulator interface. 

Configuring the topographic data using the Map Setup Menu is not simulated at this time. 

Map Symbols 
Symbols displayed on the maps 

include: Land symbols 

• Highways and roads 
• Railroads 
• Large Cities (>200,000) 
• Medium Cities (>50,000) 
• Small Cities (>5,000) 
• States and Provinces 
• Rivers and Lakes 

Aviation symbols 
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• Active Flight Plan Leg 
• Non-active Flight Plan Legs 
• Active Flight plan Waypoint 
• Large Airports 
• Medium Airports 
• Small Airports 
• Intersections 
• NDB 
• VOR 
• Class B Airspace/TMA 
• Class C Airspace/TCA 
• Class D Airspace 
• Restricted Areas 
• MOAs 
• Other/ADIZs 

Display of Latitude/Longitude, minor roads and non-major highways, User Waypoints, Taxiways, Runway 
Extensions, and TFRs are not simulated at this time. 

Configuring map symbols using the Map Setup Menu is not simulated. 

Map De-clutter 
Like on the real G1000, four levels of map de-clutter are available that remove 
progressively more information from the map. 

Airways 
Low Altitude and High Altitude Airways can be toggled on and off using the AIRWAYS softkey 
on the Map page of the MFD. Low Altitude Airways are drawn in gray and High Altitude 
Airways are drawn in green. Airway waypoints (VORs, NDBs and Intersections) are also 
displayed. 

Toggling airways using the MENU key, and selecting an airway range using the Map Setup menu is not simulated. 

Track Vector 
Like on the real G1000, the Navigation Map can display a track vector that shows the 
projected position of the aircraft in 60 seconds (including up to 90 degrees of a turn). The 
Track Vector can be toggled on and off on the “Options 2” tab of the main G1000 Student 
Simulator interface. 

Selection of additional look-ahead times using the Map Setup Menu is not simulated. 

Wind Vector 
Display of a Wind Vector on the MFD Navigation Map is not simulated at this time. 

Nav Range Ring 
The Nav Range Ring shows the ground track on a rotating compass card. The range is 
determined by the map range. The Nav Range Ring can be toggled on and off on the “Options 
2” tab of the main G1000 
Student Simulator interface. 
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Fuel Range Ring 
The Fuel Range Ring shows the range of the aircraft given the current fuel state. A dashed 
green circle indicates the selected range to reserve fuel. A solid green circle indicates the 
total endurance range. If only reserve fuel remains, the range is indicated by a solid yellow 
circle. The Fuel Range Ring can be toggled on and off on the “Options 2” tab of the main 
interface. The amount of fuel remaining must be manually set on the G1000 Engine System 
page. 

Field of View (SVS) 
Display of the boundaries of the PFD Synthetic Vision System (SVS) lateral field of view 
on the MFD Navigation Map is not available, as the SVS is not simulated. 

Waypoints 
Information is available for Airport, Intersection, NDB, and VOR waypoints. On all MFD 
Waypoints pages, waypoints can be selected by entering the ICAO identifier. If duplicate 
entries exist for an identifier, a Duplicate Waypoints Window is displayed. Frequency auto-
tuning and Direct-to Navigation is possible directly from these pages. 

Airports 
Information is available for every airport in the updatable worldwide Navigraph navigation 
database. Like in the real G1000, after engine startup, the Airport Information Page defaults 
to the airport where the aircraft is located. After a flight plan has been loaded, the Airport 
Information Page defaults to the destination airport. 

On all Airport Information pages, airports can be selected by entering the ICAO identifier, 
facility name, or location name. If duplicate entries exist for an identifier, a Duplicate 
Waypoints Window is displayed. Frequency auto-tuning and Direct-to Navigation is possible 
directly from these pages. 

The MFD Airport Information pages feature most of the information available on the real G1000 
pages. 

Fuel Availability, UTC Offset, Lighting Availability, and AOPA Directory information are not displayed in the 

simulation. The PFD Airport Information Window features most of the information in the 

real G1000 window. City, UTC Offset, and Region are not displayed in the simulation at this time. 

The MFD Nearest Airport page simulates most real functionality, including displaying a 
line to the nearest airport on the Navigation Map. 

The Nearest Airports window on the PFD displays most real G1000 information. 

Intersections 
The Intersection Information and Nearest Intersection pages feature most of the information on 
the real 
G1000 pages. 

Nearest VOR and Reference VOR information is not displayed in the simulation. 
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NDBs 
The NDB Information and Nearest NDB pages feature most of the information on the real 
G1000 pages. 

NDB Type and Nearest Airport information is not displayed in the simulation. 

VORs 
The VOR Information and Nearest VOR pages feature most of the information on the real 
G1000 pages. 

VOR Class, Magnetic Variation, and Nearest Airport Information are not displayed in the simulation. 

User Waypoints 
User-created waypoints and their associated pages are not simulated. 

Airspaces 
The following types of airspaces are displayed on maps: Class B/TMA, Class C/TCA, Class D, 
Restricted, and MOA (Military). 

Other, Air Defense Interdiction Zone (ADIZ), and Temporary Flight Restriction (TFR) airspace is not displayed in 

the simulation. The Nearest Airspaces Page on the MFD and Airspace Alerts on the PFD are not simulated. 

Direct-to Navigation 
Most real G1000 Direct-to functionality is simulated in both the MFD and PFD Direct-to 
Windows, including setting VNV Altitude at Arrival, and selecting an active flight plan 
waypoint as a Direct-To destination. 

Selection of a RECENT, USER or AIRWAY waypoint as a Direct-to destination; selecting a manual Direct-to course; 
selection of a waypoint as a Direct-to destination using the Joystick pointer; and setting an along-track VNV 
offset are not simulated. 

Flight Planning 
As on the real G1000, a flight plan is built by entering waypoints one at a time, adding 
waypoints along airways, and inserting departures, arrivals, or approaches as needed. Fight 
planning information can be entered from either the MFD or PFD. The flight plan is displayed 
on maps using different line widths, colors, and types, based on the type of leg and the 
segment of the flight plan currently being flown (departure, enroute, arrival, approach, or 
missed approach). 

Flight Plan Creation 
As on the real G1000, flight plans can be created via the: 

• Active Flight Plan page on the MFD 
• Active Flight Plan Window on the PFD 
• Flight Plan Catalog page on the MFD 

Importing and exporting flight plans to/from an SD card is not simulated. 

Adding Waypoints to an Existing Flight Plan 
Waypoints can be added to the active flight plan, in front of existing waypoints. 
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Creating and adding user waypoints to the existing flight plan using the Joystick pointer, and adding waypoints 
to stored flight plans, is not simulated. 

Adding Airways to a Flight Plan 
Airways can be added to the active flight plan if there is a waypoint in the flight plan that is 
part of the desired airway and is not part of an arrival or approach procedure. 

Adding Procedures to a Stored Flight Plan 
Adding procedures to a stored flight plan is not simulated. 

Flight Plan Storage 
As on the real G1000, up to 99 flight plans can be stored. An active flight plan can be stored 
from the 
Active Flight Plan page (MFD) or the Active Flight plan Window (PFD) using the MENU key. 

The active flight plan is erased when the G1000 Student Simulator software is restarted or 
when another flight plan is activated. Details about each stored flight plan can be viewed on 
the Flight Plan Catalog 
Page and on the Stored Flight Plan Page. 

Flight plans are stored in the Flight Plan Catalog in the order created, and can be individually 
deleted. 

Alphanumeric sorting based on flight plan name, inverting a stored flight plan, copying a stored flight plan, and 
editing a stored flight plan is not simulated. 

Display of the selected stored flight plan on the Flight Plan Catalog page map is not 
simulated. 

Flight Plan Editing 
The active flight plan can be edited via the Active Flight Plan page (MFD) or the Active Flight 
Plan 
Window (PFD), and the edits made affect navigation as soon as they are entered. You can: 

• Delete the active flight plan using the MENU key 
• Delete flight plan items using the CLR key 
• Delete an entire arrival or approach from the PFD Active Flight Plan Window using the 
CLR key 
• Delete an individual waypoint using the CLR key 

Deleting an entire airway from an active flight plan, and deleting an individual waypoint, an entire 
airway, or an entire procedure from a stored flight plan, is not simulated. 

Changing the comment (name) of an active or stored flight plan is not simulated. 

Along Track Offsets 
Along track offsets are not simulated. 

Parallel Track 
Parallel track is not simulated. 

Activating a Flight Plan Leg 
A highlighted leg can be made the “active leg” (the flight plan leg which is currently used for 



25

navigation guidance) via the MENU key. 
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Inverting a Flight Plan 
An active flight plan may be inverted (reversed) for navigation back to the original departure 
point using the MENU key. 

Inverting a stored flight plan is not simulated. 

Flight Plan Views 
Flight plan views (leg-to-leg vs. cumulative distance, wide and narrow views, and collapsing 
airways) are not simulated. 

Closest Point of FPL 
Creation of a new user waypoint along the flight plan at the location closest to a 
chosen reference waypoint is not simulated. 

Vertical Navigation 
Vertical guidance based on specified altitudes at waypoints in the active flight plan, or VNV 
Direct-to, is simulated, and both manual and autopilot-coupled guidance (VPTH) are 
supported. 

VNV along-track offsets are not simulated at this time. 

Altitude Constraints 
Altitude constraints associated with lateral waypoints can be manually entered, or are 
automatically entered for procedures (from the published “Cross as” altitudes in the 
navigation database). Altitude constraints can be followed using Vertical Path Tracking 
Mode (VPTH). 

Procedures 
The simulation of G1000 Procedures functionality is comprehensive. Departure, Arrival, and 
Approach procedures can be added and removed from active flight plans using the PROC 
key. 

Departures 
Departures procedures can be loaded into the active flight plan using the PROC key. 

Viewing available departures on the Airport Information page using the DP softkey is not simulated. 

Arrivals 
Arrival procedures can be loaded into the active flight plan using the PROC key, and 
removed by highlighting the header in the Active Flight plan (on the PFD) and pressing 
the CLR key. 

Viewing available arrivals on the Airport Information page using the STAR softkey is not simulated. 

Approaches 
Non-precision and precision approaches can be loaded into an active flight plan, activated, or 
activated as “Vector-to-Final,” using the PROC key. Approaches can be removed by highlighting 
the header in the Active Flight plan (on the PFD) and pressing the CLR key. Missed approach 
procedures are simulated, including Course to Altitude (CA) legs and manually activating a 
missed approach via the PROC MENU (or by manually activating the next leg). 
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The LD APR softkey on the Nearest Airport page, and the ability to view available approaches on the Airport Info 
page using the 
A P R s o f t k e y, a r e n o t 
simulated. 

T r i p 
Planning 
Automatic Page and Flight Plan Modes are simulated, and trip planning information, fuel 
information, and other information for a specified flight plan or flight plan leg based on 
automatic data is displayed on the AUX – TRIP PLANNING page of the MFD. Weight planning is 
also available, based on fuel sensor data and the active flight plan (to estimate remaining 
fuel). 

Manual entry of data via Manual Page and Waypoints mode is not 
simulated. 

R A I M 
Prediction 
RAIM (Receiver Autonomous Integrity Monitoring) Prediction at the aircraft present 
position is 
simulated on the AUX-GPS STATUS page. RAIM can be made unavailable via the IOS. 

RAIM Prediction at a selected waypoint and WAAS Disabling are not 
simulated. 

A b n o r m a l 
Operation 
Reversion to Dead Reckoning (DR) Mode in Enroute (ENR) or Oceanic (OCN) phases of 
flights is not simulated. 

H A Z A R D 
AVOIDANCE 

X M S a t e l l i t e 
Weather 
Optional subscription-based XM Satellite Weather services are not 
simulated. 

W X - 5 0 0 
Stormscope 
An optional WXC-500 Stormscope is not 
simulated. 
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Te r ra i n a nd O bs t a c l e 
Proximity 
Red and yellow obstacle icons (<1000’ AGL and >1000’ AGL) are displayed 
on the: 

• PDF Inset Map 
• Navigation Map page 
• Terrain Proximity page 
• Trip Planning page 
• Flight plan page 

The display and color of an obstacle icon is dependent on the aircraft height above the 
obstacle. 
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Terrain-SVS 
Terrain-SVS is not simulated. 

TAWS-B 
Three TAWS-B Aural Alerts and annunciations are simulated: 

• Excessive Descent Rate Caution: “TERRAIN” and “Sink Rate” 
• Excessive Descent Rate Warning: “PULL UP” and “Pull Up” 
• Altitude Callout “500” (just aural alert): “Five Hundred” 
• Reduced Required Obstacle Clearance Caution: “TERRAIN” and “Caution, Obstacle; 

Caution, Obstacle”) 

Forward Looking Terrain Avoidance, Premature Descent Alerting, the Negative Climb Rate After Takeoff Alert 
(“Don’t Sink”), and 
the dedicated TAWS-B page are not simulated at this time. 

Traffic Information Service (TIS) 
Basic Traffic Information Service (TIS) functionality is simulated, to help you detect and 
avoid aircraft generated by the flight simulation. Traffic Advisory symbols, vectors, altitude 
differences, and altitude trends are displayed on the: 

• PFD Inset Map 
• Navigation Page Map 
• Traffic Map Page 
• Trip Planning Page 
• Nearest Pages 
• Active Flight Plan Page 

TIS Alerts simulated include: 
• Aural “Traffic” 
• “TRAFFIC” annunciation on PFD 

Additionally, the PFD Inset Map auto-displays when a Traffic Advisory is detected. 

Traffic Advisory System (TAS) 
The Mode S transponder-based Traffic Advisory System is not simulated. 

ADS-B Traffic 
The GDL 90 data link radio-based Automatic Dependent Surveillance-Broadcast (ADS-B) 
Traffic function is not simulated. 
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AUTOMATIC FLIGHT CONTROL SYSTEM 
The G1000 Student Simulator includes an integrated Garmin GFC 700 digital Automatic Flight 
Control System (AFCS) that realistically simulates the Flight Director and Autopilot. Flight 
Director Command bars and AFCS status are displayed on the PFD. 

AFCS Status Alerts and Overspeed Protection are not simulated. 

Vertical modes simulated include: 

• Pitch Hold Mode (PIT) 
• Selected Altitude Capture Mode (ALTS) 
• Altitude Hold Mode (ALT) 
• Vertical Speed Mode (VS) 
• Flight Level Change Mode (FLC) 
• Vertical Navigation Modes (VPTH, ALTV) 
• Glidepath Mode (GP) (WAAS Only) 
• Glideslope Mode (GS) 
• Go Around Mode (GA) 

Pressing the GA key command engages the flight director in a wings-level, pitch-up attitude, allowing the 
execution of a missed approach or a go around. 

Automatic activation of the missed approach when the selected navigation source is GPS or when the navigation 
source is 
VOR/LOC and a valid frequency has been tuned is not simulated at this time. 

Lateral modes simulated include: 

• Roll Hold Mode (ROL) 
• Heading Select Mode (HDG) 
• Navigation Modes (GPS, VOR, LOC, BC) 
• Approach Modes (GPS, VAPP, LOC) 

Control Wheel Steering (CWS) is not simulated. 

ADDITIONAL FEATURES 
The following additional G1000 features are not simulated: 

• Synthetic Vision System (SVS)(Optional) 
• SafeTaxi® diagrams 
• ChartView and FliteCharts® electronic charts (Optional) 
• AOPA Airport Directory 
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• XM Radio entertainment (Optional) 
• Scheduler 
• Electronic Checklists (Optional) 
• Flight Data Logging 
• Auxiliary Video (Optional) 

ABNORMAL OPERATION 

Reversionary Mode 
Reversionary Mode (in which all important flight information is displayed on one display) 
can be manually activated by pressing the Display Backup button on the Audio Panel. 
Reversionary Mode is simulated on both the PFD and the MFD. 

The instructor, via the IOS, can realistically simulate the switch to Reversionary Mode after a 
display failure, and present students with challenging scenarios that test their ability to deal 
with failures when they’re least likely to be able to handle them. 

G1000 FAILURES 
Recognize, Interpret, and Respond to G1000 Failures 
  

The instructor, via the IOS, can execute spontaneous G1000 specific realistic failures. 

!  
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!  

 VISPRO, the native IOS for P3D based simulation,  lets you control the simulation’s 
environment, change the weather, reposition the student’s aircraft, and trigger malfunctions ... all 
in real time as the simulation is running. It gives you professional-quality tools for monitoring, 
instruction, and analysis. 

!  

  

The G1000 Failures selection, allows the instructor to fail the following Line Replaceable Units 
(LRUs) and individual components: 

• GIA 63 Integrated Avionics Unit 
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• GTX1 and GTX2 Transponders 
• GRS 77 AHRS 
• GMU 44 Magnetometer 
• GDC 74A Air Data Computer 
• GFC 700 Automatic Flight Control System 

  

Additional failures include: 
• VHF Comm Radio 
• VHF Nav Radio 
• DME 
• RAIM Availability 
• Traffic 
• Attitude 
• Airspeed 
• Vertical Speed 
• Heading 
• Altitude 
• Engine Indicators 

 Reversionary Mode 

A unique feature is the ability to realistically simulate the automatic switch to Reversionary Mode 
after a display failure. 

 

!  

In the airplane, you can only simulate Reversionary Mode by manually dimming one display, and 
manually switching both displays to Reversionary Mode by pressing the red Display Backup 
button on the audio panel. What the student sees (the primary flight instruments and engine data 
on both displays) is realistic, but manually setting up Reversionary Mode like this provides a far 
less realistic training experience than generating a spontaneous display failure from VISPRO. 

  

The G1000 Failures allows students to experience what it’s actually like to experience an in-flight 
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display failure. Failures don’t always occur in cruise, when it’s easy to deal with them. With the 
G1000 Failures, you can present students with challenging scenarios that test their ability to deal 
with failures when they’re least likely to be able to handle them. 

  

Standby Instruments 

To enable students to practice safely flying the simulation without reference to the glass displays 
at all, an ISIS (integrated standby instrument system) consisting of Airspeed Indicator, Attitude 
Indictor, and Altimeter are provided. 
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introduction

For more than twenty-five years, tech-savvy flight schools, flight instructors, and pilots have been using 
Microsoft’s Flight Simulator software to train and stay proficient (including FlightSafety International, 
Embry-Riddle Aeronautical University, and the U.S. Navy).

As we talked to people in the aviation community who were using Flight Simulator for training, we repeatedly 
heard the same complaint: “There’s no instructor station!”

So, we created one.

The Flight1 Aviation Technologies Virtual Instructor Station Pro (VISPRO) is standalone software that integrates 
with Microsoft® Flight Simulator X and Lockheed Martin® Prepar3D™. VISPRO lets you control the simulation’s 
environment, change the weather, reposition the student’s aircraft, trigger malfunctions and much more ... all 
in real time as the simulation is running. It gives you professional-quality tools for monitoring, instruction 
and analysis.

Designed to be compliant with the FAA’s Advanced Aviation Training Device (AATD) requirements for an 
Instructor Station, VISPRO can be used as part of an FAA-approved training device that students can log hours 
in (when under the supervision of a certified instructor).

VISPRO and Flight Simulator can be run on two separate computers over a network, or on the same computer, 
and combines a powerful Instructor Station with an interactive Moving Map. The Instructor Station and the 
Moving Map are displayed in different windows and can each be displayed on its own monitor.

No matter how you set things up, one thing’s for sure: VISPRO will revolutionize the way you use Microsoft’s 
simulation products for training.
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About This User's Guide:
VISPRO is a feature-packed software product that offers many powerful features that you'll want to familiarize 
yourself with prior to use. Please read through this User's Guide to become familiar with your new software. 
Taking the time to do this now will allow you to get the most out of VISPRO.

This PDF features an extensive set of bookmarks to help you find the information you're looking for. Use 
the Bookmark option in Adobe Acrobat Reader to make it easier to find the information you need.

VISPRO Communication Module:
The VISPRO Communication Module allows VISPRO to communicate with Flight Simulator, therefore, the 
VISPRO Communication Module must be installed on each PC that is running Flight Simulator. For more 
information, see the VISPRO Communication Module section on pages 7 and 8.

Software Activation:
In order to use your new software, it must first be activated on the PC that it's installed on. Activation is fast and 
easy, and can be done at any time, 24 hours a day. The Activation Console will appear at the end of the 
installation routine and you will be required to enter your product serial number, along with your name and 
your Email address. For more information, see the Activating Your Software section on page 6.

important information

Product Support and Software Updates:
Flight1 Aviation Technologies strives to provided timely, reliable support through both our self-service Product 
Knowledge Base and our staffed Support Ticket System.

• Product support is available by clicking on the 'SUPPORT' tab at our website, http://www.flight1tech.com
• For problems with product activation, please visit our Activation website at www.flight1tech.com/register

This section includes important information about VISPRO that you should familiarize yourself with prior to 
using your new software.

Printing This User's Guide:
Even though this User's Guide is designed in color to make it easy to 
read on your computer screen, if you wish to print this User's Guide 
and save ink at the same time, please choose to print in Grayscale, 
via your PCs print dialog screen.

To ensure that the entire Pilot's Guide prints, make sure to choose 
Reduce to Printer Margins and Auto-Rotate and Center in the Adobe 
Acrobat Reader print dialog box.

Plane Icon Maker and Object Customization:
Plane Icon Maker is a separate utility installed with VISPRO that allows you create a custom Moving Map aircraft 
icon. In addition, an object customization file is provided that allows you to adjust the color, line width and 
transparency of objects rendered on the Moving Map and the Google Earth Export View to suit your particular 
setup and personal preference. For more information, see the Plane Icon Maker section on pages 69 ~ 71 and 
the Object Customization section on pages 71 and 72.
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setup tips and user information

VISPRO Custom Plug-Ins:
Custom plug-ins add even more functionality to VISPRO. They allow VISPRO to interact with even more parts 
of the Flight Simulator (or an add-on aircraft or gauge). VISPRO supports custom plug-ins for individual pilots, 
flight schools, manufacturers and other industry organizations. From the highly-popular G1000 Failures plug-in, 
to just about anything you can imagine, custom plug-ins expand your Instructor Station to do just about anything. 
For more information, visit:

http://www.flight1tech.com/Products/InstructorStationSoftware/CustomPluginsforVISPRO.aspx

important information

Setup Tips and User Information:
We've provided a number of Setup Tips and User Information below and on the next page to help you answer 
some more common questions that you might have. If, after reading through this User's Guide, you have a 
question or comment, please contact us using the Product Support information above.

• So that VISPRO can communicate with Flight Simulator, the VISPRO Communication Module must be 
installed on each PC that is running Flight Simulator, regardless if VISPRO is running on the same PC or not. 
The VISPRO Communication Module does not need to be installed on the PC running only VISPRO.

• Because VISPRO can control up to 16 individual Flight Simulator sessions, it's important to keep in mind that 
many functions are session-specific, therefore, you need to remember to switch to the desired Flight Simulator 
session to make that particular student's aircraft active before controlling those functions. 

• To avoid confusion between instructor and student, we don't suggest the student pause and resume Flight 
Simulator from within Flight Simulator itself. We suggest that only the instructor pause and resume 
Flight Simulator from within the Moving Map or the Instructor Station.

• Each student's Flight Simulator session will be displayed on the Moving Map with an aircraft icon. The active 
Flight Simulator session that the instructor has control of will be displayed with a green aircraft icon. All 
other Flight Simulator sessions will be displayed with a red aircraft icon.

• If the Moving Map doesn't automatically snap to the aircraft icon of the active Flight Simulator session when 
you switch Flight Simulator sessions, press the  button to enable Aircraft Following.

• In the default configuration, each aircraft icon is labeled with the Flight Simulator PCs IP address. To make 
it easier for you to keep track of each student's Flight Simulator session, the aircraft icon labels can be 
renamed. For example, you might want to rename each student's aircraft icon with the student's name.

• If the aircraft's Flight Track is not visible on the Moving Map, press the  button to display the Flight Track.

• The Zoom Level of the Moving Map can be changed using your mouse's scroll wheel or your keyboard. 
Zooming In or Out using your mouse's scroll wheel allows for more precise Zoom Level changes.

• The aircraft's Flight Track (including the Flight Plan path and other information, such as NAVaids, Airspace 
Boundaries and more) can be exported into Google Earth. This gives you the ability to debrief and study the 
Flight Track in a much more realistic manner, using Google Earth's satellite imagery and viewing tools.

• Before a Flight Plan can be loaded through the Flight Plan page, the Flight Plan must first be created and 
saved either from within Flight Simulator or through a 3rd-party flight planner.

• To display a Flight Plan on the Moving Map, the saved Flight Plan must be loaded through the Flight Plan 
page in the Instructor Station.

• Microbursts and Downdrafts can be created anywhere and at anytime within Flight Simulator by right-clicking 
in the desired locations on the Moving Map.
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setup tips and user information

• If multiple Microbursts and Downdrafts are displayed and you don't want to delete them all at the same time, 
use the latitude, longitude and altitude values to determine which Microbursts and Downdrafts you want 
to delete.

• In order to create a malfunction for a selected instrument, receiver, etc., that particular instrument, receiver, 
etc. must be modeled in the Flight Simulator aircraft that the student is flying. 

• The Flight Data Recorder will continuously record Flight Data for all connected Flight Simulator sessions at 
the same time, however, only Flight Data for the currently active Flight Simulator session can be viewed on 
the Record-Playback page. Make sure to first switch to the Flight Simulator session you want to view or export 
Flight Data for.

• When saving Flight Tracks, only the active Flight Track is saved. If you are connected to multiple Flight Simulator 
sessions and want to save multiple Flight Tracks, you will need to first switch to the desired inactive aircraft 
to make that Flight Track active, then save it separately.

• The student's aircraft can be placed at any position along the Flight Track to allow the student to begin flying 
again from that position. This allows the student to re-fly the entire flight or a specific portion of the flight to 
gain practice in areas deemed necessary.

• Flight Tracks can be exported into a tab-delineated format for analysis in a spreadsheet program.

• The student's aircraft can be repositioned at any airport or on any runway in Flight Simulator and positioned 
at the end of the runway, in the ready for takeoff position or position it at specific positions around the 
selected runway.

• The fuel, passenger and baggage loading of the student's aircraft can be changed at any time before flight or 
even during flight. For example, you could change the fuel quantity in one fuel tank during flight to simulate a 
fuel imbalance caused by incorrect use of the aircraft's fuel selector.

• If you are experiencing an incompatibility with the Moving Map and the 3-D graphics card and/or display 
drivers on the PC running VISPRO (e.g. the Moving Map doesn't render properly), you can use the Disable 
Hardware Acceleration option to fix it. 

• VISPRO supports the use of touchscreen monitors. Enable the On-Screen Keyboard option to enable you to 
input data when you touch a field.

• VISPRO features an Update Check function which makes it easy to keep your software up to date. The 
Update Check function can be configured to automatically check for updates, either every time VISPRO is 
started or at user-defined intervals. 

• Any changes made through the Advanced Weather page, except for the Dispatch METAR Weather function, 
deleting Microbursts and Downdrafts, and changing the season and the time of day, which are all 
session-specific, affect all connected Flight Simulator sessions on a global basis. 

• In order to use the Real World METAR Weather function, the PC that is running VISPRO must be connected 
to the Internet and have an active Internet connection.

• When using the Closest Airport option, METAR weather is updated once every minute to ensure the latest 
METAR weather information is applied to Flight Simulator. When the active student's aircraft nears a weather 
station, the weather will be automatically updated to reflect that weather station's METAR information.

• When you use Real World METAR Weather, the current weather METAR string can be dispatched to the 
active Flight Simulator session, so the student can view the METAR information.

• The aircraft icon displayed on the Moving Map, in addition to a number of different objects rendered on the 
Moving Map, can be customized to suit your personal preferences.
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activating your software

Software Activation:
The Activation Console will appear at the end of the installation routine and you will be required to enter your 
product serial number, along with your name and your Email address. The software will not function unless it 
has been successfully activated on the PC that VISPRO is installed on.

If necessary, you can re-activate your software at any time by running the Activation Console from your 
Start Menu at: Start - All Programs | Flight1 Aviation Technologies | VISPRO | Activate.

In the default configuration, activation requires that the PC you're installing VISPRO on be connected to the 
Internet. If your PC is not connected to the Internet, you have the option of using a different Internet-connected PC 
to activate your software. For more information, please visit http://www.flight1tech.com/register

You can View your Registration Information or Reset your Registration at any time by clicking on 
the Product drop-down box at the top of the Activation Console.

1) Enter the product Serial Number in field 1.

The Serial Number is printed on a sticker on the inside 
of the DVD case. This sticker may be located behind 
the DVD or any included printed material.

2) Enter your full name in field 2.

3) Enter your Email address in field 3.

4) Re-enter your Email address in field 4 to confirm it.

In order to use your new software, it must first be activated on the PC that it's installed on. Activation is fast and 
easy, and can be done at any time, 24 hours a day.

5) Ensure that your PC is connected to the Internet, then 
press the Activate Now button. After the activation 
process completes (this process should only take 
a few seconds), press the OK button to close the 
Activation Console.

 If your PC is not connected to the Internet, press 
the *This Computer Has No Internet Connection 

button and follow the on-screen prompts.

If you have any trouble activating your software, click 
the Help Menu Bar option at the top of the Activation 
Console or visit www.flight1tech.com/Support.aspx

Press Activate Now

Enter Information
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vispro communication module

So that VISPRO can communicate with Flight Simulator, the VISPRO Communication Module must be installed 
on each PC that is running Flight Simulator, regardless if VISPRO is running on the same PC or not.

Installing the VISPRO Communication Module on the Local PC:
The VISPRO Communication Module Installer runs automatically at the end of the VISPRO software installation 
routine, at which time you will be prompted whether you want to install the VISPRO Communication Module 
or not. If Flight Simulator is installed on the same PC as VISPRO, install the VISPRO Communication Module 
during the VISPRO installation routine.

If necessary, you can run the VISPRO Communication Module Installer at any time from your Start 
Menu at: Start - All Programs | Flight1 Aviation Technologies | VISPRO Communication Module | VISPRO 

Communication Module Installer.exe.

The VISPRO Communication Module Installer will automatically detect which version of Flight Simulator you 
have installed and display the path to the respective program executable in the Path field.

DefAULT

If the path to the executable is incorrect, press the Select button, navigate to the executable for your Flight 
Simulator version, then left-click on it to highlight it and display the path in the Path field.

Installing the VISPRO Communication Module on the Remote PC:
VISPRO can support up to 16 active Flight Simulator sessions at one time. So that VISPRO can communicate 
with Flight Simulator, the VISPRO Communication Module must be installed on each PC that is running Flight 
Simulator.

1) Copy the Module sub-folder that was installed in your Local Disk | Flight1 Aviation Technologies | VISPRO 
Communication Module folder when VISPRO was originally installed on your Local PC.

The Port numbers displayed should not be changed unless you encounter a problem with use over your 
network. The default Port Numbers are 13300 for SimConnect and 13301 for VISPRO.

1) If not already checked, left-click the check box next to the Flight Simulator path that you want to install the 
VISPRO Communication Module to.

2) If desired, enter a Flight Simulator Session Name in the Session Name field. This name will appear next to 
the student's aircraft icon instead of the IP address of the PC running Flight Simulator, making it easier for 
you to differentiate and keep track of multiple Flight Simulator sessions at the same time.

3) After verifying the correct path(s) and entering a Flight Simulator Session Name (optional), press the Install 
Flight Simulator module(s) button to install the VISPRO Communication Module onto your PC, then press 
the OK button to close the VISPRO Communication Module Installer.

Press Install

Check Path



8

VISPRO VIRTUAL INSTRUCTOR STATION PRO USER'S GUIDE

The Port numbers displayed should not be changed unless you encounter a problem with use over your 
network. The default Port Numbers are 13300 for SimConnect and 13301 for VISPRO.

4) If not already checked, left-click the check box next to the Flight Simulator path that you want to install the 
VISPRO Communication Module to.

5) If desired, enter a Flight Simulator Session Name in the Session Name field. This name will appear next to 
the student's aircraft icon instead of the IP address of the PC running Flight Simulator, making it easier for 
you to differentiate and keep track of multiple Flight Simulator sessions at the same time.

6) After verifying the correct path(s) and entering a Flight Simulator Session Name (optional), press the Install 
Flight Simulator module(s) button to install the VISPRO Communication Module onto your PC, then press 
the OK button to close the VISPRO Communication Module Installer.

You will need to perform these steps to install the VISPRO Communication Module on each Remote PC 
that you want VISPRO to communicate with.

vispro communication module

Installing the VISPRO Communication Module on the Remote PC, Continued....
2) Paste the Module folder on the Remote PC (or Remote PCs) that are running Flight Simulator.

3) Open the Module folder, then double-click the Module.exe file to run the VISPRO Communication Module Installer.

The VISPRO Communication Module Installer will automatically detect which version of Flight Simulator you 
have installed and display the path to the respective program executable in the Path field.

If the path to the executable is incorrect, press the Select button, navigate to the executable for your Flight 
Simulator version, then left-click on it to highlight it and display the path in the Path field.

Uninstalling the VISPRO Communication Module:
If for any reason you need to uninstall the VISPRO Communication Module, follow the steps below.

1) Run the VISPRO Communication Module Installer as described in either of the previous two sections, 
depending on if you're uninstalling the module from the your Local PC or a Remote PC.

2) If not already checked, left-click the check box next to the Flight Simulator path that you want to remove the 
VISPRO Communication Module from. 

3) Click the Uninstall Flight Simulator Modules button to uninstall the VISPRO Communication Module for the 
selected Flight Simulator version (or versions), then press the OK button to close the VISPRO Communication 
Module Installer.

DefAULT

Press Install

Check Path
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Connecting to flight Simulator:
Each instance of Flight Simulator must be loaded and running in the Free Flight Mode prior to launching 
VISPRO. In addition, the VISPRO Communication Module must be installed on each PC running Flight 

Simulator. For more information, see the VISPRO Communication Module section on pages 7 and 8.

running vispro

Although VISPRO can be used on the same PC that Flight Simulator is installed on (for example, using multiple 
monitors), it's designed to be used remotely on a PC (or multiple PCs) separate from Flight Simulator. This 
allows the utmost in flexibility between student and instructor.

VISPRO supports up to 16 active Flight Simulator sessions at one time, giving the instructor full control over each 
individual student's flight. Functions, such as Fuel Loading, Aircraft Repositioning and Flight Data Recording 
are continuously updated for each student's Flight Simulator session and each student's aircraft position, Flight 
Track and Flight Data are displayed on the Moving Map at the same time.

The instructor is able to quickly and easily switch between different Flight Simulator sessions by right-clicking 
on the specific student's aircraft on the Moving Map and selecting it. In addition, each aircraft icon is labeled 
with the student's specific Flight Simulator PCs IP address (or Session Name if entered when installing the 
VISPRO Communication Module) to help the instructor keep track of each student's aircraft. This allows the 
instructor to monitor and have control over each student's Flight Simulator session from one single VISPRO 
training station.

2) When the Connect to Flight Simulator dialog box appears, enable the View All Active FS Sessions option. 
This will allow VISPRO to connect to all instances of Flight Simulator found on your network simultaneously. 

3) Press the Connect button. VISPRO will connect to each Flight Simulator IP address displayed in the LAN 
window (regardless of which IP address is highlighted). Once VISPRO connects to all instances of Flight 
Simulator, the Moving Map and Instructor Station will launch automatically.

1) After making sure that all instances of Flight Simulator on your network are loaded and running in the Free 
Flight Mode, run VISPRO by double-clicking on the VISPRO.exe shortcut on your desktop or run VISPRO 
from your Start Menu at: Start | All Programs | Flight1 Aviation Technologies | VISPRO | VISPRO.exe.

When you run Flight Simulator, you may be asked by Windows firewall or your own firewall solution to allow 
Flight Simulator to unblock the network connection for Flight Simulator. Please allow this.

Enable View All
Active FS Sessions

Press Connect



10

VISPRO VIRTUAL INSTRUCTOR STATION PRO USER'S GUIDE

1) After manually entering an IP address, enable the Do Not Ask Again option to save the IP address so you 
don't need to re-enter it each time you run VISPRO. Clearing the Do Not Ask Again option will require you 
to re-enter the IP address (only if VISPRO cannot find it on your network) each time you run VISPRO.

 If VISPRO is not able to automatically find the IP address for the Flight Simulator PC and if you're unable 
to connect to Flight Simulator by entering an IP address manually, press the Port Numbers button and 

check to ensure that the port numbers listed are the same as the port numbers listed when you installed the 
VISPRO Communication Module. You can view those port numbers by running the VISPRO Communication 
Module Installer and copying the port numbers from the respective Port Number fields. The default Port Numbers 
are 13300 for SimConnect and 13301 for VISPRO. For more information, see the VISPRO Communication 
Module section on pages 7 and 8. 

running vispro

Using the Do Not Ask Again Option:
The Do Not Ask Again option is used only when VISPRO cannot find an IP address on your network and you 
need to manually enter the IP address. If you've manually entered an IP address, selecting the Do Not Ask 
Again option will save that IP address so you don't need to re-enter it each time you run VISPRO.

entering an IP Address Manually:
1) If VISPRO is not able to automatically find the IP address for the Flight Simulator PC, left-click the Enter IP 

Manually option, enter the IP address of the PC running Flight Simulator, then press the Connect button.

Connecting to flight Simulator, Continued....

Click and Enter IP Address

Press Connect

Enable Do Not Ask Again Option
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If your PC supports multiple monitors, VISPRO and Flight Simulator can be run at the same time on the same 
PC using two or more monitors. Using VISPRO with multiple monitors allows full functionality and flexibility 
between student and instructor on the same PC. This is ideal if you don't have multiple PCs running on a 
network. 

1) Make sure that Flight Simulator is loaded and running in the Free Flight Mode, then run VISPRO by 
double-clicking on the VISPRO.exe shortcut on your desktop or run VISPRO from your Start Menu.

2) Connect to Flight Simulator as described in the Connecting to Flight Simulator section on pages 9 and 10. 
The Moving Map and the Instructor Station will open automatically.

3) If you're using two monitors, we recommend that you drag both the Moving Map and the Instructor Station 
to one monitor and leave Flight Simulator on the second monitor. If you're using three monitors, we recommend 
that you drag the Moving Map to one monitor, then drag the Instructor Station to the second monitor and 
leave Flight Simulator  on the third monitor.

Flight Simulator must be running in Windowed mode to enable the ability to drag and drop windows on 
separate monitors. 

multiple monitor support

When using more than one monitor on a single PC running both VISPRO and Flight Simulator at the same 
time, overall performance may be reduced, particularly if your PC is near the lower end of the recommended 
specifications. We recommend using three monitors only if you have a high-end PC (Intel Dual or Quad Core 
with high-end video card such as nVidia GeForce GTX or equivalent).

Running VISPRO Without Connecting to flight Simulator:
If desired, VISPRO can be run without connecting to Flight Simulator. This will allow you to become familiar 
with many aspects of VISPRO, from basic Moving Map options to the features of the Instructor Station, in addition 
to being able to review saved Flight Tracks, and more.

1) To run VISPRO without connecting to Flight Simulator, press the Run Without Connecting button. The 
Moving Map and Instructor Station will launch automatically.

Press Run
Without Connecting

running vispro



12

VISPRO VIRTUAL INSTRUCTOR STATION PRO USER'S GUIDE

Using VISPRO with a flight Plan:
In order for the student to follow a Flight Plan, that Flight Plan must be created and saved either from within 
Flight Simulator or through a 3rd-party flight planner. Once a Flight Plan is created and saved, the Flight Plan 
can be loaded into Flight Simulator and then displayed on the Moving Map using the Instructor Station Load 
Flight Plan function.

1) Run Flight Simulator, press the Flight Planner button, then create the Flight Plan by selecting the desired 
departure location, destination, Flight Plan type and routing.

2) Press the Find Route button to display and edit the Flight Plan, then press the Save button to save the Flight Plan.

3) Press the OK button, then press the Yes button when prompted to move the aircraft to the departure location.

4) Choose the desired aircraft, location, weather, time and season, etc., then press the FLY NOW! button. Flight 
Simulator will load the aircraft at the departure airport.

5) Launch VISPRO and connect to Flight Simulator. For more information, see the Connecting to Flight Simulator 
section on pages 9 and 10.

6) Using the Instructor Station Load Flight Plan function, load the saved Flight Plan to display it on the Moving 
Map. The Flight Plan will be displayed as a green line on the Moving Map and also be displayed on the 
student's GPS in Flight Simulator.

VISPRO can be used with or without a Flight Simulator Flight Plan. Flight plans can be created and saved from 
within Flight Simulator, or they can be created and saved in a Flight Simulator-compatible file format, using a 
3rd-party flight planner. If you prefer not to create a Flight Plan, the student's aircraft can simply be placed 
at the desired departure airport.

For information about creating, saving and loading Flight Plans, in addition to choosing an aircraft, 
setting up a flight, etc., refer to the Help System in Flight Simulator.

Using VISPRO without a flight Plan:
1) Run Flight Simulator, choose the desired aircraft, location, weather, time and season, etc., then press the 

FLY NOW! button. Flight Simulator will load the aircraft at the airport you chose.

2) Run VISPRO and connect to Flight Simulator. For more information, see the Connecting to Flight Simulator 
section on pages 9 and 10.

3) From within the Moving Map, press the  button to enable Aircraft Following, then press the  button 
to Zoom closer to the student's aircraft. The student is now ready to fly and the instructor is ready to use 
the Moving Map and Instructor Station. For information about using the Moving Map and the Instructor 
Station, see the VISPRO Moving Map section on pages 15 ~ 35 and the various Instructor Station sections 
on pages 36 ~ 69. 

flights and flight planning

7) From within the Moving Map, press the  button to enable Aircraft Following, then press the  button 
to Zoom closer to the student's aircraft. The student is now ready to fly and the instructor is ready to use 
the Moving Map and Instructor Station. For information about using the Moving Map and the Instructor 
Station, see the VISPRO Moving Map section on pages 15 ~ 35 and the various Instructor Station sections 
on pages 36 ~ 69. 

When you load a saved Flight Plan through the Instructor Station Flight Plan page, you may have the option of 
loading the Flight Plan from the Local PC or the Remote PC. For more information, see the Instructor Station 
Flight Plan Page section on pages 37 ~ 41.
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vispro moving map

The Moving Map is a powerful tool that the instructor uses to monitor the student's flight in real time. In addition to 
its scrolling and zoom options, the Moving Map is able to display a number of different items, from airports and 
VORs, to NDBs, airways, airspace, intersections, approach markers, Flight Simulator traffic and more. You are 
able to open and save Flight Tracks, display the current Flight Track, display the current Flight Plan, draw 
Plotted Segments to view lateral deviation and quickly and easily measure distances to and from specified 
points, and much more.

In addition to all of the above, the Moving Map is able display the student's Flight Profile and a cross-section of 
the Approach Profile to monitor the student's approach. Up to 16 different Flight Simulator sessions can be 
monitored on the Moving Map at any one time.

Map View - Displays all of the information relative to the student's flight, including, but not limited to, the Flight 
Plan, the current aircraft location and the aircraft Flight Track. A number of display options and functions can 
be turned ON and OFF using the Menu Bar or the Tool Bar.

Menu Bar - Provides a drop-down interface for all Moving Map functions and options.

Tool Bar - Provides an easy-to-use graphical interface for the most common Moving Map functions and options.

Profile View - When active, displays either the student's Approach Profile or the student's Flight Profile.

Status Bar - Displays information pertinent to the student's flight.

Menu Bar

Map View Status Bar

Profile ViewTool Bar

Moving Map Display:
The Moving Map consists of the five main sections described below:

Menu Bar functions and Options:
This section describes the different Moving Map functions and options that are available within the various 
Menu Bar drop-down categories.
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vispro moving map

file Category:
Clear flight Track - Select to clear the current Flight Track.

Open flight Track - Select to open a previously saved Flight Track and display it.

Save flight Track - Select to save the current Flight Track.

export as KML - Select to export the Flight Track (including the Flight Plan path and other information, such 
as navigation aids, airspace boundaries and more) into Google Earth.

Recent file - Displays a link to the most recently saved Flight Track.

exit - Select to exit VISPRO. This will shut down both the Moving Map and the Instructor Station.

• Holds
• Airspace Boundaries
• Special Use Airspace
• Virtual Traffic
• Flight Track

• Altitude (MSL)

Menu Bar functions and Options, Continued....

View Category:
	 Zoom In - Select to Zoom In the Moving Map.
	 Zoom Out - Select to Zoom Out the Moving Map.
	 Zoom to Track - Select to Zoom to the center of the Flight Track.
	 follow Aircraft - Select to enable or disable Aircraft Following.
	 Show Measuring Tool - Select to enable or disable the Measuring Tool function.
	 Show on Map - Choose from the following options to display or hide on the Moving Map:

Help Category:
 About Virtual Instructor Station - Select to display the version of VISPRO currently installed.

• Flight Plan
• Compass Overlay
• METAR

• Towered Airports
• Non-Towered Airports
• VORs
• NDBs
• Markers

events - Select to display or hide Flight Simulator Events along the Flight Track.

Tool Bar - Select to display or hide the Tool Bar buttons along the top of the Moving Map.

Status Bar - Select to display or hide the Status Bar along the bottom of the Moving Map.

• None

flight Profile - Select to display or hide the student's Flight Profile at the bottom of the Moving Map.

Approach Profile - Select to display or hide the student's Approach Profile at the bottom of the Moving Map.

flight Data - Select to display or hide the following options on the Flight Track:

• IAS

Tools Category:
 Course Plotter - Select to enable or disable the Course Plotter function. The Course Plotter allows you to 

create Plotted Segments so that you can view lateral deviation from any given course.

 Connect to Another fS - Select to connect to another instance of Flight Simulator without the need to 
restart VISPRO.

• ILS Feathers
• Intersections
• Terminal Intersections
• Victor Routes
• Jet Routes
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 - Press to switch to the Instructor Station.

 - Press to clear the current Flight Track.

 - Press to open a saved Flight Track and display it.

 - Press to save the current Flight Track.

 - Press to Zoom In the Moving Map.

 - Press to Zoom Out the Moving Map.

 - Press to enable or disable Aircraft Following.

 - Press to Zoom to the center of the Flight Track.

 - Press to display or hide Towered Airports.

 - Press to display or hide Non-Towered Airports.

 - Press to display or hide VORs.

 - Press to display or hide NDBs.

 - Press to display or hide Markers.

 - Press to display or hide ILS Feathers.

 - Press to display or hide Intersections.

 - Press to display or hide Terminal Intersections.

 - Press to display or hide Victor Routes.

 - Press to display or hide Jet Routes.

 - Press to display or hide Holds.

 - Press to display or hide Airspace Boundaries.

 - Press to display or hide Special Use Airspace Boundaries.

 - Press to display or hide Flight Simulator traffic.

 - Press to display or hide the Flight Plan.

 - Press to display or hide Flight Tracks.

 - Press to display or hide the aircraft's Approach Profile at the bottom of the Moving Map.

 - Press to display or hide the Compass with Heading Bug.

 - Press to pause or resume Flight Simulator.

 - Press to enable or disable the Course Plotter function.

 - Press to enable or disable the Measuring Tool function.

 - Press to display or hide the aircraft's Flight Profile at the bottom of the Moving Map.

vispro moving map

Tool Bar functions and Options:
This section describes the different Moving Map functions and options that are available via the Tool Bar.

 - Press to display or hide METAR stations.
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Moving Map Overview:
The Moving Map presents detailed information about the each student's flight and the surrounding area in 
general. This section shows some of the more common features that can be displayed.

Compass Overlay

Airspace Boundary

Towered Airport*

VOR*

Intersection*

Aircraft Icon

NDB/Marker*

Heading Bug Indicator

Flight Plan

ILS Feather*

Switching to the Instructor Station:
You can switch from the Moving Map to the Instructor Station by pressing the  button. This is faster and 
easier than minimizing the Moving Map, then maximizing the Instructor Station via the Windows Taskbar.

Pausing flight Simulator:
When Flight Simulator is running and connected to VISPRO, Flight Simulator can be paused by pressing the 

 button. To resume Flight Simulator, press the  button a second time.

To avoid confusion between instructor and student, we don't suggest the student pause and resume 
Flight Simulator from within Flight Simulator itself. We suggest that only the instructor pause and resume 

Flight Simulator from within the Moving Map or the Instructor Station. In addition, if the student pauses Flight 
Simulator, it can result in communication errors with VISPRO.

vispro moving map

Traffic
Non-Towered Airport*

Weather Station
NDB/Marker*

Controlling Multiple flight Simulator Sessions:
Up to 16 different Flight Simulator sessions can be monitored on the Moving Map at any one time. You are able 
to quickly switch between inactive and active Flight Simulator sessions by right-clicking on and selecting the 
desired student's aircraft icon or by selecting the desired student's Flight Simulator session using the Tools > 
Connect to Another FS Menu Bar option. In addition, each aircraft icon is labeled with the Flight Simulator 
PCs IP address (or name) to help the instructor keep track of each student's aircraft.

Because VISPRO can control up to 16 individual Flight Simulator sessions, it's important to keep in mind that 
many Moving Map functions, except display options are session-specific, therefore, you need to remember 
to switch to the desired Flight Simulator session to make that particular student's aircraft active before controlling 
features such as moving the student's aircraft, viewing Flight Data on the Flight Profile, etc. The instructor 
can control one student's Flight Simulator session at a time, even though VISPRO will record Flight Data and 
display aircraft icons and Flight Tracks for all connected Flight Simulator sessions simultaneously. For more 
information, see the Controlling Multiple Flight Simulator Sessions section below. 
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vispro moving map

There are several different ways you can switch between connected Flight Simulator sessions.

1) When the aircraft icon you want to switch to is visible on the Moving Map, right-click the aircraft icon, then 
left-click the dialog box that appears next to the aircraft icon. The aircraft icon and Flight Track will change 
to green, indicating you have control over that student's Flight Simulator session.

Each student's Flight Simulator session will be displayed on the Moving Map with an aircraft icon. The active 
Flight Simulator session that the instructor has control of will be displayed with a green aircraft icon. All 
other Flight Simulator sessions will be displayed with a red aircraft icon.

Right-Click Aircraft Icon....

....Left-Click Dialog Box

Controlling Multiple flight Simulator Sessions, Continued....
When the View All Active FS Sessions option is selected in the Connect to Flight Simulator dialog box, VISPRO 
will connect to all instances of Flight Simulator on your network. 

Active Session - Green

Other Session - Red
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2A)  Left-click the Tools > Connect to Another FS Menu Bar option to open the Connect to Flight Simulator 
dialog box.  

2B) Left-click to highlight the IP address of the Flight Simulator session you would like to switch to, then press 
the Connect button. The aircraft icon and Flight Track will change to green, indicating you have control 
over that student's Flight Simulator session.

If the Moving Map doesn't automatically snap to the aircraft icon of the IP address you selected, press 
the  button to enable Aircraft Following.

vispro moving map

Controlling Multiple flight Simulator Sessions, Continued....
2) When the aircraft icon you want to switch to is not visible on the Moving Map, for example, if the aircraft is 

out of visible range, you can either click and drag the Moving Map to locate the aircraft icon or you can use 
the Tools > Connect to Another FS Menu Bar option described below:

Highlight Desired IP Address....

....Press the Connect Button

Renaming Aircraft Icon Labels:
In the default configuration, each aircraft icon is labeled with the Flight Simulator PCs IP address. To make it 
easier for you to keep track of each student's Flight Simulator session, the aircraft icon labels can be renamed. 
For example, you might want to rename each student's aircraft icon with the student's name.

The steps in this section need to be completed on each Flight Simulator PC you want to change the aircraft 
icon label for. It only needs to be done once, unless you want to change the aircraft icon label again.

1) Run the VISPRO Communication Module Installer on each Flight Simulator PC you want to change the 
aircraft icon label for. For more information, see the VISPRO Communication Module section on pages 7 and 8.

Choose Connect
to Another FS...

Press Install

Enter Name
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vispro moving map

Using the Zoom functions, Moving Map Scrolling and Aircraft following:
The Zoom Level of the Moving Map can be changed to suit the desired view. A Zoom Level Scale is provided 
in the lower right corner that indicates the current Zoom Level. In addition, you are able to zoom to the current Flight 
Track and zoom directly to the student's aircraft by enabling the Aircraft Following function. Alternately, when 
Aircraft Following is disabled, you are able to click and drag the Moving Map to any desired position.

Renaming Aircraft Icon Labels, Continued....
2) Type in the name you want to show on the aircraft icon for that Flight Simulator PC in the Flight Simulator 

Session Name field.

3) Press the Install Flight Simulator Module(s) button to reinstall the VISPRO Communication Module.

In the default configuration, aircraft labels are enabled, however, if desired, aircraft labels can be disabled. 
For more information, see the Instructor Station Options Page - Changing Miscellaneous Options section 

on pages 57 and 58.

Adjusting the Moving Map Zoom Level:
1) To zoom the Moving Map in and out, press the  button (Zoom In) or the  button (Zoom Out). The 

Zoom Level Scale in the lower right corner displays the current Zoom Level in Nautical Miles. The Zoom 
Level Scale will change based on the specific Zoom Level.

When you run VISPRO, the Zoom Level will default to the last Zoom Level used when VISPRO was closed.

Zoom Level Scale

The Zoom Level can also be changed using your mouse's scroll wheel or your keyboard.

2) To change the Zoom Level using your mouse, move the scroll wheel forward to Zoom In and move the 
scroll wheel backward to Zoom Out.

Zooming In or Out using your mouse's scroll wheel allows for more precise Zoom Level changes.

3) To change the Zoom Level using your keyboard, hold down the CTRL key and press the + key to Zoom In 
and hold the CTRL key and press the - key to Zoom Out.
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1) To zoom to the active Flight Track, press the  button. The Moving Map will snap to the center of the 
active Flight Track and automatically zoom to a level that displays the entire Flight Track on the screen.

In this mode, the student's aircraft will eventually fly out of display range. If this occurs, press the  button 
to enable Aircraft Following or press the  button to zoom to the active Flight Track again.

When you zoom to the active Flight Track, the Compass Overlay and Heading Bug will not line up with the 
aircraft icon. This is normal since the Compass Overlay is fixed in the center of the Moving Map.

Zoom to the Active flight Track:
In addition to changing the Zoom Level, you are also able to zoom directly to the active Flight Track. The 
active Flight Track is displayed as a magenta line on the Moving Map.

If the Flight Track is not visible on the Moving Map, press the  button to display the Flight Track. For 
more information, see the Working with Flight Plans and Flight Tracks section on pages 21 ~ 25.

Flight Track

vispro moving map

Using the Zoom functions, Moving Map Scrolling and Aircraft following, Continued....

Flight Plan

Aircraft Icon

Zoom to the Aircraft/Aircraft following function:
The Aircraft Following function allows you to zoom to the student's aircraft from anywhere on the Moving Map 
and place the Moving Map in Aircraft Following mode. This feature is used to zoom to the aircraft's new 
location when you reposition the student's aircraft or to keep track of the student's entire flight without needing 
manually scroll the Moving Map to keep up with the aircraft.

1) To zoom directly to the student's aircraft and enable Aircraft Following, press the  button. The Moving 
Map will snap to the aircraft icon and automatically scroll to follow the student's aircraft.

If you disable Aircraft Following, the Moving Map will not automatically scroll to follow the student's aircraft 
and the aircraft will eventually fly out of display range. In this case you would need to press the   

button to zoom to the student's aircraft and enable Aircraft Following again.

If you press the  button to zoom to the Flight Track as described in the Zoom to Flight Track section above, 
Aircraft Following will automatically be disabled. To enable Aircraft Following again, press the  button.
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1) Press the  button to display or hide the Flight Plan on the Moving Map.

Only one Flight Plan can be loaded at any one time and it must be loaded into VISPRO from within the 
Instructor Station Flight Plan page before it can be displayed on the Moving Map. For more information, 

see the Instructor Station Flight Plan Page section on pages 37 ~ 41. 

vispro moving map

Dragging the Moving Map:
When the Aircraft Following function is disabled, the Moving Map can be moved in any direction by simply 
clicking and dragging it. This is useful to see locations or other aircraft that may currently not be in view.

1) To drag the Moving Map, left-click and HOLD on an empty area of the Moving Map. The mouse pointer 
will turn into a cross. While holding the left mouse button down, move the mouse in the direction you want 
to drag the Moving Map. Alternately, you can press and HOLD down any of the four arrow keys on your 
keyboard to scroll the Moving Map up, down, right and left.

When you drag the Moving Map, the Compass Overlay and Heading Bug will not line up with the aircraft 
icon. This is normal since the Compass Overlay is fixed in the center of the Moving Map.

Using the Zoom functions, Moving Map Scrolling and Aircraft following, Continued....

Cross Cursor

If Aircraft Following is enabled, the Moving Map will automatically snap back to the aircraft icon if you 
attempt to drag the Moving Map. To be able to drag the Moving Map, Aircraft Following must be disabled.

Working with flight Plans and flight Tracks:
It's important to distinguish between Flight Plans and Flight Tracks. The Flight Plan is displayed as a green line 
and shows the Flight Plan that is currently loaded via the Instructor Station Flight Plan page. The Flight Track is 
displayed as a magenta line and shows the actual path that the student's aircraft has flown.

Displaying and Hiding the flight Plan:

Flight Plan

Left-Click and HOLD, Then Drag
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1) Press the  button to display or hide Flight Tracks on the Moving Map. The active Flight Track will be 
displayed in magenta and all other Flight Tracks will be displayed in red.

vispro moving map

Working with flight Plans and flight Tracks, Continued....
Displaying and Hiding flight Tracks:
Since VISPRO can connect with up to 16 different Flight Simulator Sessions at one time, up to 16 different 
Flight Tracks can be displayed on the Moving Map at once. Flight Tracks can be hidden or displayed as 
desired, to make it easier to keep track of different student's flights.

If VISPRO is connected to more than one Flight Simulator session, you are able to display or hide specific 
Flight Tracks. 

2) Click on the drop-down arrow next to the  button, then highlight and left-click the desired Flight Simulator 
session name to display or hide that specific Flight Track. The Flight Track of session names with a check 
mark next to them will be displayed and the Flight Track of session names without a check mark next to 
them won't be displayed.

Active Flight Track

Other Flight Track

Aircraft with Hidden 
Flight Track

Active Flight Track

Active Aircraft

Display/Hide Flight Tracks

Flight Plan

Flight Plan



VISPRO VIRTUAL INSTRUCTOR STATION PRO USER'S GUIDE

23

1) To display Flight Data on the Flight Track, select the parameter you would like to be displayed using the 
View > Flight Data Menu Bar option. Choose from either IAS or Altitude MSL.

2) To display Aircraft Events on the Flight Track, such as malfunctions, select the View > Events Menu Bar 
option.

Flight Track

Flight Data (ALT)

Clearing, Saving and Loading flight Tracks:
The active Flight Track can be cleared or saved, or a previously saved Flight Track can be loaded and 
displayed on the Moving Map. In addition, when you load a previously saved Flight Track, you are given the 
option to reposition the student's aircraft at any point along that Flight Track and allow the student to re-fly 
from that point. For more information, see the Re-Flying in Flight Simulator section on page 49.

1) To clear the active Flight Track, choose the File > Clear Flight Track Menu Bar option or press the  button.

Clearing the active Flight Track actually erases it, which is different than hiding Flight Tracks as described 
in the Displaying and Hiding Flight Tracks section on the previous page.

2) To save the active Flight Track for later viewing and analysis, choose the File > Save Flight Track Menu Bar 
option or press the  button. Select the folder you want to save the Flight Track in, then name the Flight 
Track and press the Save button to save the Flight Track.

Only the active Flight Track is saved. If you are connected to multiple Flight Simulator sessions and 
want to save multiple Flight Tracks, you will need to first switch to the desired Flight Simulator session 

to make that Flight Track active, then save it separately.

3) To open and display a saved Flight Track, choose the File > Open Flight Track Menu Bar option or press 
the  button. Navigate to the folder where your Flight Tracks are saved, then highlight the desired 
Flight Track and press the Open button to open the Flight Track.

vispro moving map

Working with flight Plans and flight Tracks, Continued....
Displaying flight Data and Aircraft events on flight Tracks:
Flight Data and Aircraft Events can be displayed in real-time on the Flight Tracks. This allows you to see when 
events (such as malfunctions) occur and at what speed or altitude the student's aircraft has been. Flight Data 
and Aircraft Events will be shown on all displayed Flight Tracks, even inactive Flight Tracks.

Event Occurrence

If you clear the current Flight Track while the aircraft is flying, a new Flight Track will automatically begin to 
display from the aircraft's current position. We suggest that you save the current Flight Track before clearing it.

Flight Plan

Inactive
Flight Track
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vispro moving map

Working with flight Plans and flight Tracks, Continued....
exporting the flight Track into Google earth:
Exporting the Flight Track (including the Flight Plan path and other information, such as NAVaids, Airspace 
Boundaries and more) into Google Earth gives you the ability to debrief and study the Flight Track in a much 
more realistic manner, using Google Earth's satellite imagery and viewing tools.

The free Google Earth application must be installed on your PC to use this feature. For more information 
about downloading, installing and using Google Earth, visit www.earth.google.com

exporting the Active flight Track into Google earth:
1) With an active Flight Track displayed, choose the File > Export as KML Menu Bar option. The Save As 

dialog box will open.

2) Select the folder you want to export the Flight Track to, then name the Flight Track and press the Save 
button to export the Flight Track.

Only the active Flight Track is exported. If you are connected to multiple Flight Simulator sessions 
and want to export multiple Flight Tracks, you will need to first switch to the desired Flight Simulator 

session to make that Flight Track active, then export it separately.

3) Run the Google Earth application, then choose the File > Open option. From within the Open dialog box, 
choose the Flight Track that you exported previously, then press the Open button. Google Earth will 
automatically zoom to the Flight Track you just opened. You can now use the tools within Google Earth 
to view and analyze the Flight Track.

Choose Export as KML

Press SaveName File
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Heading Bug

Compass Overlay

enabling the Compass Overlay with Heading Bug:
The Compass Overlay features a Heading Bug that is tied to the HDG knob in the student's aircraft. This allows 
you to not only quickly determine the aircraft's orientation, but also allows you determine the aircraft's current 
heading bug setting.

vispro moving map

1) Press the  button to display or hide the Compass Overlay on the Moving Map. When the student rotates 
the HDG knob on their Heading Indicator, the Heading Bug on the Compass Overlay will also rotate to the 
same heading. A dashed line links the Heading Bug to the nose of the aircraft to help you visualize the 
heading vector.

If desired, the Compass Overlay can be changed to show the Magnetic Heading or the True Heading. For 
more information, see the Changing Compass Overlay Options section on page 58.

The dashed line will link to the student's aircraft only when the Aircraft Following function (  ) is enabled, 
otherwise, the Compass Overlay with Heading Bug will always stay centered on the Moving Map, regardless 
of aircraft position.

Working with flight Plans and flight Tracks, Continued....
exporting a Previously Saved flight Track into Google earth:
1) Choose the File > Open Flight Track Menu Bar option or press the  button to open the saved Flight 

Track. Navigate to the folder where your Flight Tracks are saved, then highlight the desired Flight Track 
and press the Open button to open the Flight Track and display it on the Moving Map.

2) Choose the File > Export as KML Menu Bar option.

3) Select the folder you want to export the Flight Track to, then name the Flight Track and press the Save 
button to export the Flight Track.

4) Run the Google Earth application, then choose the File > Open option. From within the Open dialog box, 
choose the Flight Track that you exported previously, then press the Open button. Google Earth will 
automatically zoom to the Flight Track you just opened. You can now use the tools within Google Earth 
to view and analyze the Flight Track.

Aircraft Icon
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1) Press the  button to enable the Measuring Tool function. A Measuring Tool icon will be displayed next 
to the cursor on the Moving Map.

2) Move the cursor to the desired starting point, such as the student's aircraft.

3) Press and HOLD the left mouse button on your starting point, then drag the cursor to the desired termination 
point. A measuring line will be temporarily drawn between the two points and a dialog box will appear 
displaying the distance, heading and other pertinent information between the two points.

4) Release the left mouse button to clear the measuring line and information box, then press the  button 
again to disable the Measuring Tool function.

Using the Measuring Tool function:
The Measuring Tool is displayed as a line between a starting point and a termination point. It's used to determine 
the distance and heading between any two points on the Moving Map, such as distance and heading To or From 
the student's aircraft to any point on the Moving Map, whether it be a NAVaid or an airport. Additional information, 
such as wind speed/direction, airspeed, wind correction angle, ground speed and ETA are also displayed.

vispro moving map

Information Box

Starting Point

Measuring Line

Termination Point

Displaying MeTAR Information:
When METAR stations are displayed on the Moving Map, detailed METAR information can be viewed.

1) Press the  button to display METAR stations on the Moving Map.

2) Hover the mouse pointer over the desired METAR station icon. That particular icon will become highlighted, 
indicating it's been selected.

3) Click and HOLD the left mouse button to display the METAR information for the selected METAR station.

METAR Information
METAR Station
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Information Box

Displaying Navigation Aid and Airport Information:
When NAVaids and airports are displayed on the Moving Map, detailed NAVaid and airport information can be 
easily viewed.

vispro moving map

Airport
(or NAVaid)

1) Press the , , , ,  and   buttons to display VORs, NDBs, intersections and towered and 
non-towered airports on the Moving Map. 

2) Hover the mouse pointer over the desired NAVaid icon or airport. When you hover your mouse pointer over 
a VOR, NDB or intersection, that particular icon will become highlighted, indicating it's been selected.

When you hover your mouse pointer over an airport, a red or blue circle will be displayed. A red circle 
indicates a non-towered airport and a blue circle indicates a towered airport.

3) Click and HOLD the left mouse button to display detailed information about the selected NAVaid or airport.

Controlling Microbursts and Downdrafts:
Microbursts and Downdrafts can be created anywhere and at anytime on the Moving Map to give the student 
practice when encountering these weather phenomena. When you create Microbursts and Downdrafts on the 
Moving Map, the resulting Microbursts and Downdrafts are recreated within the active Flight Simulator session 
at the same location.

The size and base altitude of Microbursts and Downdrafts depicted on the Moving Map are relative to the 
Microburst and Downdraft properties chosen in the Instructor Station Advanced Weather Wind page. If desired, 
the Microburst and Downdraft radius, force and altitude properties can be changed to suit. For example, you 
can create a large Microburst at ground level test the student during an approach, or you can create a Downdraft 
along the student's flight path at altitude. You can also increase or decrease the force of Microbursts and 
Downdrafts. For for information, see the Changing Microburst and Downdraft Properties section on pages 64 and 65.

When you create Microbursts and Downdrafts, they're displayed in green on the Moving Map. The color of 
the icons will change depending on if the student is inside the Microburst or Downdraft, or if they've flown 
through the Microburst or Downdraft.

Microbursts and Downdrafts are completely separate from Flight Simulator weather, so they are not reliant 
on any specific type of weather. They can be created regardless of the type of weather chosen in the Instructor 
Station Advanced Weather page.
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vispro moving map

Microburst

Downdraft

Right-Click
and Select

1) Position the cursor on the Moving Map where you want to create a Microburst or a Downdraft, then press 
the HOLD the right mouse button. A dialog box will appear. While holding the right mouse button down, 
highlight the desired selection, either Microburst or Downdraft, then release the right mouse button.

Creating Microbursts and Downdrafts:
Although all Microbursts and Downdrafts you create are displayed on the Moving Map at the same 
time, Microbursts and Downdrafts are session-specific. If VISPRO is connected to multiple Flight 

Simulator sessions, make sure to first switch to the Flight Simulator session you want to create Microbursts 
and Downdrafts for, prior to creating them.

Controlling Microbursts and Downdrafts, Continued....

Deleting Microbursts and Downdrafts:
Microbursts and Downdrafts are deleted through the Instructor Station Advanced Weather Wind page. For 
more detailed information, see the Deleting Microbursts and Downdrafts section on pages 65 and 66.

2) A pulsating green ring will be drawn on the Moving Map, indicating the location and relative size of the 
Microburst or Downdraft. When the student flies into a Microburst or Downdraft, the respective Microburst 
or Downdraft icon's color will change to red. Once the student has flown through the Microburst or 
Downdraft, the respective Microburst or Downdraft icon's color will change to gray and stop pulsating.

Gray Indicates Flown Through

Red Indicates Flown Inside

Green Indicates
Not Yet Encountered
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Moving the Student's Aircraft:
The student's aircraft can be moved to any location on the Moving Map and that new location reflected in 
Flight Simulator. For example, if you want to move the student's aircraft further along the Flight Plan or to a new 
training location, you can simply move the student's aircraft to the new location. In addition, you also have the 
option of making changes to the aircraft's Latitude, Longitude, Altitude, Heading and Airspeed.

1) Hover the cursor over the desired student's aircraft icon. The cursor will turn into a hand.

2) Press and HOLD the left mouse button, then drag the aircraft icon to the desired location on the Moving Map.

3) Release the left mouse button and the Move User Aircraft dialog box will open. If desired, enter new 
Latitude, Longitude, Altitude, Heading and Airspeed values, then press the OK button to move the student's 
aircraft to the new location. Flight Simulator will re-load with the student's aircraft in the new location. If you 
decide you don't want to move the student's aircraft to the new location, press the Cancel button.

When you move the student's aircraft to the new location, you will be asked whether you would like to save 
the current Flight Track or not. If you would like to save the current Flight Track, press the Yes button. If you 

don't want to save the current Flight Track, press the No button. In either case, when the aircraft is moved to its 
new location, the current Flight Track will be erased and a new Flight Track will begin when the student begins 
flying from the new location.

Move User Aircraft
Dialog Box

Using the Course Plotter function:
The Course Plotter allows you to create Plotted Segments between points on the Moving Map for the purpose 
of viewing lateral deviation of the student's aircraft. For example, you can create Plotted Segments between 
approach waypoints so that you can view lateral deviation from the Approach Path. In addition, the Approach 
Profile function can be used at the same time to view vertical deviation from the Approach Path. Alternately, 
Plotted Segments can be used to view lateral deviation between VOR radials.

Plotted Segments can be created by selecting waypoints manually or by left-clicking directly on the Moving 
Map with your mouse.

vispro moving map

Press the  button to pause Flight Simulator prior to moving the student's aircraft. Once the aircraft has 
been moved and the student is ready to begin flying again, press the  button to resume Flight Simulator.

Click and Drag
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Creating Plotted Segments Using the Course Plotter Dialog Box:
The Course Plotter dialog box allows you to create Plotted Segments using specified waypoints and airport 
runways that are contained in the Course Plotter Waypoint Database. This allows you to create very accurate 
Plotted Segments. However, in some cases, you may want to create Plotted Segments that don't originate or 
terminate at a specific waypoint or airport runway. In this case, use the Plot with Mouse function. For more 
information, see the Creating Plotted Segments Using the Plot with Mouse Function on page 31.

When the Course Plotter dialog box is opened, there will be a slight delay while the waypoint database 
loads. This is normal.

Plotted Segments

Using the Course Plotter function, Continued....
vispro moving map

1) Press the  button to enable the Course Plotter function and open the Course Plotter dialog box.

2) Select the first waypoint in your Plotted Segment by either typing the name of the waypoint in the Add 
New Waypoint field or by scrolling through the list of waypoints and highlighting the desired waypoint. In 
addition to being able to add typical waypoints, you are also able to add airport runways as a waypoint. 
For example, you can type in or choose KOXR 25. This allows you to create a Plotted Segment down the 
selected runway heading.

3) Press the Add button. The selected waypoint will be listed in the Plotted Segments field.

4) Repeat steps 2 and 3 to select the second waypoint in your Plotted Segment. A magenta line will be drawn 
on the Moving Map between the two waypoints and the Plotted Segment will be listed in the Plotted 
Segments field.

5) If desired, repeat steps 2 and 3 to select and plot any remaining waypoints, then press the Close button to 
close the Course Plotter dialog box and disable the Course Plotter function.

Course Plotter
Dialog Box

When using the Course Plotter dialog box to create Plotted Segments, it's not possible to create separate 
Plotted Segments that originate from different waypoints. If you need to create separate Plotted Segments 
originating from different waypoints, use the Plot with Mouse function. For more information, see the Creating 
Plotted Segments Using the Plot with Mouse Function section on page 31.
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3) Move the cursor to where you want the Plotted Segment to originate from, then press and HOLD the left 
mouse button and drag the cursor to where you want the Plotted Segment to terminate at. A magenta line 
will be drawn on the Moving Map between the two points.

4) Repeat step 3 to draw any remaining desired Plotted Segments.

5) Press the  button to disable the Course Plotter function and regain control of the mouse cursor.

Creating Plotted Segments Using the Plot with Mouse function:
When using the Plot with Mouse function, Plotted Segments can be created anywhere on the Moving Map, 
using your mouse. This allows you to create separate Plotted Segments that originate from different waypoints 
and Plotted Segments that don't actually require the use of waypoints. 

Using the Course Plotter function, Continued....
vispro moving map

Press Plot with Mouse

Course Plotter
Dialog Box

1) Press the  button to enable the Course Plotter function and open the Course Plotter dialog box.

When the Course Plotter dialog box is opened, there will be a slight delay while the waypoint database 
loads. This is normal.

2) Press the Plot with Mouse button. The Course Plotter dialog box will close and your mouse cursor will turn 
into a cross with a Course Plotter icon.

Plotted Segment

Plotted Segment
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Right-Click
Plotted Segment

Left-Click Name
to Delete

Deleting Plotted Segments Within the Moving Map:

Deleting Plotted Segments:
Plotted Segments can be deleted directly within the Moving Map or through the Course Plotter dialog box.

Using the Course Plotter function, Continued....
vispro moving map

1) Press the  button to enable the Course Plotter function and open the Course Plotter dialog box.

When the Course Plotter dialog box is opened, there will be a slight delay while the waypoint database 
loads. This is normal.

2) Left-click to highlight the Plotted Segment listed in the Plotted Segments field you want to delete, then 
press the Delete button. If you want to delete all of the Plotted Segments, press the Delete All button.

3) Press the Close button to close the Course Plotter dialog box and disable the Course Plotter function.

1) Right-click on the Plotted Segment you would like to delete. The name of the Plotted Segment will be 
displayed in a dialog box.

2) Highlight the Plotted Segment's name, then press the left mouse button to delete that Plotted Segment. 

Deleting Plotted Segments Using the Course Plotter Dialog Box:

Press Delete
or Delete All

Course Plotter
Dialog Box
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Runway Heading

Runway
Distance to Runway

Approach Path

Current Aircraft Position

Altitude
Approach Angle

Moving the Active Student's Aircraft and Re-flying the Approach:
When Flight Simulator is paused, you can drag the red vertical line that indicates the aircraft's current position 
back and forth along the Flight Track, and if desired, allow the student re-fly the approach from any selected 
position along the Flight Track.

1) Press the  button to pause Flight Simulator.

2) Press and HOLD the left mouse button on the red vertical line that indicates the aircraft's current position, 
then drag the vertical line to move the aircraft icon to the desired location on the Flight Track.

3) Press the Re-fly in FS button in the Instructor Station. Flight Simulator will re-load with the student's aircraft 
in the new location. For more information about using the Re-Fly in FS function, see the Instructor Station 
Record-Playback Page section on pages 43 ~ 50.

4) When the student is ready, press the  button to allow the student to resume flying.

1) Press the  button to display the Approach Profile at the bottom of the Moving Map. The student's current 
Approach Path is displayed as a green line and the Optimum Approach Path is displayed as a white line. 
Altitude and Distance to Runway information are displayed along the left side and bottom of the Approach 
Profile, respectively, and the aircraft's current position is indicated by a red vertical line with a green aircraft 
icon at the top of it. In addition, the localizer course is superimposed on the Moving Map with a white line 
showing the runway heading. 

Using the Approach Profile function:
The student's Approach Profile can be displayed at the bottom of the Moving Map and provides you with a 
visual cross-reference of the student's landing approach. This allows you to view vertical deviation from the 
Optimum Approach Path. In addition, the localizer course is superimposed on the Moving Map, which allows 
you to view lateral deviation from the runway heading. You also have the option of allowing the student to re-fly 
the approach from any selected position along the Flight Track if extra practice is required at a specific location.

vispro moving map

Approach Profile parameters can be customized in the Instructor Station. For more information, see the 
Instructor Station Options Page - Changing Approach Parameters section on page 56.

Flight Track
Aircraft Icon
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Using the flight Profile function:
The student's Flight Profile can be displayed at the bottom of the Moving Map and allows you to monitor Flight 
Data (Plot Values) on the Moving Map during the student's flight. You are able to choose from a number of 
different Plot Values and either one or two different Plot Values can displayed at one time. In addition, you can 
change the scale of the display to increase or decrease the resolution of the Data Tracks on the scrolling graph.

The current position of the student's aircraft is shown on the Flight Profile as a vertical line. When Flight Simulator is 
paused, you are able to drag the vertical line back and forth to display the corresponding position of the aircraft 
on the Flight Track, and if desired, allow the student re-fly the flight from that selected position.

vispro moving map

1) Press the  button to display the Flight Profile at the bottom of the Moving Map. Plot Values are displayed 
on the left side and Data Tracks that provide a graphical representation of the selected Plot Values are 
drawn on the scrolling graph as the aircraft is flying. The aircraft's current position is indicated by a black 
vertical line.

Distance Scale

Data TracksPlot Values Current
Aircraft Position

Choosing Plot Values:
When the Flight Profile is displayed, up to two different Plot Values can be chosen that will be drawn as Data 
Tracks during the student's flight.

1) Left-click the desired Plot Value selection box, then highlight and left-click to select the Plot Value you 
would like to be displayed. Up to two different Plot Values can be selected and displayed at one time.

Click and Highlight

Data Tracks
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1) To change the resolution of the Distance Scale, press the Scale buttons. Pressing the '+' button increases 
the Scale Resolution and pressing the '-' button decreases the Scale Resolution.

2) To change how Plot Values are displayed on the scrolling graph, press the Type button. When '1' is selected, 
both Plot Values are displayed on a single scrolling graph. When '2' is selected, each of the two Plot Values 
will be displayed separately and a green line will be displayed between the two scrolling graphs to 
separate them.

Green Line

Scale Buttons
Type Button

Changing the flight Profile Type and Scale Resolution:
The Flight Profile can be changed to display either two Plot Values on the same scrolling graph or to split the 
two Plot Values so that they're displayed separately. Some users may find it easier to read the Data Tracks 
using this configuration. In addition, the Scale Resolution can be changed to increase or decrease the resolution 
of the Data Tracks. Increasing the resolution allows you to see greater detail among the Data Points and 
decreasing the resolution decreases the detail among the Data Points, but more Data Points are visible.

Using the flight Profile function, Continued....
vispro moving map

Moving the Active Student's Aircraft and Re-flying in flight Simulator:
When Flight Simulator is paused, you are able to drag the black vertical line that indicates the aircraft's current 
position back and forth along the Flight Track, and if desired, allow the student re-fly from any selected position 
along the Flight Track.

1) Press the  button to pause Flight Simulator.

2) Press and HOLD the left mouse button on the black vertical line that indicates the aircraft's current position, 
then drag the vertical line to move the aircraft icon to the desired corresponding position on the Flight Track.

3) Press the Re-fly in FS button in the Instructor Station. Flight Simulator will re-load with the student's aircraft 
in the new location. For more information about using the Re-Fly in FS function, see the Instructor Station 
Record-Playback Page section on pages 43 ~ 50.

4) When the student is ready, press the  button to allow the student to resume flying.

Click and Drag

Flight Track

Data Tracks
Current Aircraft Position

Aircraft Icon

Flight Plan
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instructor station overview

Instructor Station Display:
The Instructor Station consists of the three main sections described below:

Display ViewPage Control Interface Tool Bar

Page Control Interface - Features shortcut buttons to the different pages that the instructor uses to control 
many aspects of the student's flight. Pages include Flight Plan, Malfunctions, Record-Playback, Reposition, 
Fuel-Loading, Options and Advanced Weather. To open these pages, press the desired button.

Tool Bar - Provides a graphical interface for controlling the Instructor Station. Press the  button to switch to 
the Moving Map and press the  button to pause or resume Flight Simulator.

Display View - Shows all of the parameters, options, etc. for the chosen page selection.

The Instructor Station allows you to control many aspects of the student's flight and gives you total control over 
many of the most important aspects of Flight Simulator. Changes occur nearly instantaneously and all without 
the student knowing. Load preset weather conditions, create custom weather or use real-world weather created 
from METARs. Even change Microburst and Downdraft properties for the ultimate test! Create (and reset) 
malfunctions and quickly reposition the student's aircraft to various positions on and around any runway, at 
any airport in Flight Simulator for practice flying approaches, plus much more! The heart of the Instructor 
Station is a powerful Flight Data Recorder that continuously records the aircraft position and flight parameters 
of all connected Flight Simulator sessions. You can track and display multiple parameters simultaneously on 
a scrolling graph, both in real-time and during playback of saved Flight Tracks. You can even export selected 
data in tab-delineated format for analysis in a spreadsheet program. In addition, you are able to review current 
and saved Flight Tracks and even have the student re-fly a flight from any position in a recording.

Because VISPRO can control up to 16 individual Flight Simulator sessions, it's important to keep in mind that 
all Instructor Station functions are session-specific, unless otherwise noted. Therefore, you need to remember 
to switch to the desired Flight Simulator session to make that particular student's aircraft active before 
controlling features such as loading Flight Plans, creating malfunctions, repositioning the aircraft, etc. For 
more information, see the Controlling Multiple Flight Simulator Sessions section on pages 16 ~ 18.
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Loading a flight Plan from the Local PC:
This section details loading a Flight Plan when both VISPRO and Flight Simulator are running on the same PC 
(Local PC) or when multiple Flight Simulator sessions are connected to VISPRO, but the active Flight Simulator 
session is running on the Local PC. To load a Flight Plan from the Remote PC when VISPRO is connected to a 
remote Flight Simulator session, see the Loading a Flight Plan From the Remote PC section on pages 39 ~ 41.

1) Verify that Flight Simulator is running in the Free Flight mode and that VISPRO is connected to Flight Simulator. 
For more information, see the Running VISPRO section on pages 9 ~ 11.

The Flight Plan page allows you to load a saved Flight Plan into VISPRO to be displayed on both the Moving 
Map and the student's GPS in Flight Simulator, so that the student can follow the Flight Plan during flight. 
Alternately, a saved Flight Plan can be loaded only for display on the Moving Map when reviewing a previously 
saved Flight Track. Saved Flight Plans can be loaded from the Local PC or the Remote PC. In addition, you are 
able to choose the desired departure runway and move the student's aircraft to the chosen runway when you 
load the Flight Plan.

Before a Flight Plan can be loaded through the Flight Plan page, the Flight Plan must first be created and 
saved either from within Flight Simulator or through a 3rd-party flight planner. For more information, see 

the Flights and Flight Planning section on page 12.

instructor station flight plan page

Press Load

Select Flight Plan

Press Open

Flight Plans can be loaded for display on the Moving Map from either the Local PC or the Remote PC (if VISPRO 
is connected to multiple Flight Simulator sessions), however, if you need to also display the Flight Plan on the 
student's GPS and/or have control over positioning the student's aircraft on a specific runway when loading 
a Flight Plan, the Flight Plan must be saved on each PC that is running Flight Simulator. For example, it's not 
possible load a Flight Plan from the Local PC to control a Flight Simulator session on a Remote PC. 

Flight Plans are session-specific and only one Flight Plan can be loaded and displayed on the Moving Map at 
any one time. If VISPRO is connected to multiple Flight Simulator sessions and you want each student to fly 
the same Flight Plan and have that same Flight Plan displayed on each student's GPS, you will need to either 
create and load the Flight Plan through each instance of Flight Simulator separately or save the same Flight 
Plan on each Flight Simulator PC, then load the Flight Plan through the Instructor Station for each active Flight 
Simulator session separately. For example, load the Flight Plan for the first active Flight Simulator session, 
switch to another Flight Simulator session to make it active, then load the same Flight Plan for that session.
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4) Press the Yes button to reposition the aircraft at the departure airport of the Flight Plan or press the No button 
if you don't want to reposition the aircraft or if you're loading the Flight Plan to only display it on the Moving 
Map. For example, when reviewing a previously saved Flight Track.

instructor station flight plan page

Press Yes

Loading a flight Plan from the Local PC, Continued....
If VISPRO is connected to multiple Flight Simulator sessions, make sure that the Flight Simulator session 
running on the Local PC is active. For more information, see the Controlling Multiple Flight Simulator 

Sessions section on pages 16 ~ 18.

2) Press the Load button, then navigate to the folder where your Flight Plans are saved.

3) Left-click to highlight the desired Flight Plan, then press the Open button. The waypoints of the Flight Plan 
will be listed in the FS Flight Plan field.

5) After choosing to reposition the aircraft at the departure airport of the Flight Plan, left-click to highlight the 
runway you would like the aircraft placed on, then press the OK button.

Press OK

Select Runway
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instructor station flight plan page

Loading a flight Plan from the Local PC, Continued....
6) When prompted, press the Yes button to save the current Flight Track or press the No button to erase the 

current Flight Track and start a new Flight Track. Flight Simulator will re-load with the student's aircraft 
placed on the selected runway at the selected departure airport.

Active Aircraft

Flight Plan

Loading a flight Plan from the Remote PC:
This section details loading a Flight Plan when VISPRO is running on one PC and Flight Simulator is running 
on a separate PC (Remote PC). Load a Flight Plan for the student to follow during flight or to simply display the 
Flight Plan on the Moving Map when reviewing a previously saved Flight Track.

Flight Plans are session-specific and only one Flight Plan can be loaded and displayed on the Moving 
Map at any one time. If VISPRO is connected to multiple Flight Simulator sessions and you want each 

student to fly the same Flight Plan and have that same Flight Plan displayed on each student's GPS, you will 
need to either create and load the Flight Plan through each instance of Flight Simulator separately or save the 
same Flight Plan on each Flight Simulator PC, then load the Flight Plan through the Instructor Station for each 
active Flight Simulator session separately. For example, load the Flight Plan for the first active Flight Simulator 
session, switch to another Flight Simulator session to make it active, then load the same Flight Plan for that session.

Press Remote

Press Load

1) Verify that Flight Simulator is running in the Free Flight mode and that VISPRO is connected to Flight 
Simulator. For more information, see the Running VISPRO section on pages 9 ~ 11.

7) The Flight Plan will be displayed both on the Moving Map and on the student's GPS in Flight Simulator, unless 
you chose not to reposition the student's aircraft. If you don't see the student's aircraft on the Moving Map, 
press the  button to zoom to the student's aircraft and enable Aircraft Following. If you don't see the Flight 
Plan on the Moving Map, press the  button to display the Flight Plan.
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3) Left-click to highlight the desired Flight Plan, then press the OK button. The waypoints of the Flight Plan will 
be listed in the FS Flight Plan field.

instructor station flight plan page

Loading a flight Plan from the Remote PC, Continued....
2) Press the Load button, then press the Remote button to open the Flight Plan Selection dialog box.

The Remote PC option will only be available when VISPRO is connected to one or more remote Flight 
Simulator sessions AND when one of those remote Flight Simulator sessions is active.

Select Flight Plan

Press OK

Press Yes

The Local option is used when you want to load a Flight Plan from the Local PC when reviewing a previously 
saved Flight Track with a student connected to a remote Flight Simulator session. For more information, see 
the Reviewing Flight Tracks Using the Replay Function section on pages 47 and 48.

4) Press the Yes button to reposition the aircraft at the departure airport of the Flight Plan or press the No button 
if you don't want to reposition the aircraft or if you're loading the Flight Plan to only display it on the Moving 
Map. For example, when reviewing a previously saved Flight Track.



VISPRO VIRTUAL INSTRUCTOR STATION PRO USER'S GUIDE

41

instructor station flight plan page

Loading a flight Plan from the Remote PC, Continued....

Press OK

Select Runway

Active Aircraft

Flight Plan

Clearing a Loaded flight Plan:
1) Press the Clear button to clear the currently loaded Flight Plan. The Flight Plan will be cleared from both the 

FS Flight Plan field and the Moving Map.
Clearing a Flight Plan will clear the Flight Plan from both the FS Flight Plan field on the Instructor Station 
Flight Plan page and the Moving Map. It will not clear the Flight Plan from the student's GPS in Flight 

Simulator.

5) After choosing to reposition the aircraft at the departure airport of the Flight Plan, left-click to highlight the 
specific runway you would like the aircraft placed on, then press the OK button.

6) When prompted, press the Yes button to save the current Flight Track or press the No button to erase the 
current Flight Track and start a new Flight Track. Flight Simulator will re-load with the student's aircraft 
placed on the selected runway at the selected departure airport.

7) The Flight Plan will be displayed both on the Moving Map and on the student's GPS in Flight Simulator, unless 
you chose not to reposition the student's aircraft. If you don't see the student's aircraft on the Moving Map, 
press the  button to zoom to the student's aircraft and enable Aircraft Following. If you don't see the Flight 
Plan on the Moving Map, press the  button to display the Flight Plan.
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Creating Malfunctions:
To make them easier to control and keep track of, malfunctions are organized into the following groups: 
Instruments, Systems, Receivers, Engine, Flaps and Landing Gear. A separate Control group is used to reset all 
malfunctions at the same time and restart the aircraft's engine (or engines).

The Malfunctions page allows you to create various malfunctions to the student's aircraft at any time during the 
student's flight. A single malfunction or multiple malfunctions can be created to test the student. In addition, the 
point that malfunctions are created (and reset) can be displayed along the Flight Track.

instructor station malfunctions page

In order to create a malfunction for a selected instrument, receiver, etc., that particular instrument, receiver, 
etc. must be modeled in the Flight Simulator aircraft that the student is flying. For example, if the student's 
aircraft does not feature an ADF receiver, triggering the ADF malfunction will have no effect on that student's 
aircraft. If a failure button is grayed out, that failure is not supported by the current aircraft.

1) To create a malfunction, press the desired malfunction button. The malfunction button will turn red, 
indicating that the selected malfunction has occurred to the student's aircraft.

When creating engine malfunctions, first press the button for the specific engine (#1, #2, #3 and/or # 4) you 
want to control engine malfunctions for. The button will turn green, indicating which engine (or engines) 

the malfunctions will affect. You can now choose a failure for that specific engine (or engines) by pressing the 
desired engine failure button(s).

Displaying Malfunctions on the flight Track:
The point that malfunctions are created (and reset) can be displayed along the Flight Track.

1) To display malfunctions on the Flight Track, select the View > Events Menu Bar option in the Moving 
Map. For more information, see the Displaying Flight Data and Aircraft Events on Flight Tracks section 
on page 23.

Malfunctions are session-specific. If VISPRO is connected to multiple Flight Simulator sessions, make 
sure to first switch to the Flight Simulator session you want to create or reset malfunctions for, prior to 

creating or resetting a malfunction.
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Resetting Malfunctions:
Malfunctions can be reset at any time during the student's flight to return the student's aircraft to normal 
operation.

1) To reset a malfunction, press the red malfunction button. The red malfunction button will extinguish. 
Alternately, if you want to reset all malfunctions at the same time, press the Reset Failures button in the 
Control group.

When you reset a flap malfunction, the flaps will stay in the failed position. The student will be required to 
move the flaps back to the original position from within Flight Simulator.

instructor station malfunctions page

Pausing flight Simulator:
When Flight Simulator is running and connected to VISPRO, Flight Simulator can be paused by pressing the 

 button. To resume Flight Simulator, press the  button a second time. With Flight Simulator paused you 
can review the Flight Track, review Flight Data and position the student's aircraft to any location along the Flight 
Track or within the Flight Data recording.

To avoid confusion between instructor and student, we don't suggest the student pause and resume 
Flight Simulator from within Flight Simulator itself. We suggest that only the instructor pause and resume 

Flight Simulator from the Moving Map or the Instructor Station. In addition, if the student pauses Flight Simulator, 
it can result in communication errors with VISPRO.

If the Vacuum and Pitot-Static malfunctions are failed from within Flight Simulator and not from the 
Instructor Station (e.g., the student initiates the malfunction using Flight Simulator's Failure option or a 

flight is loaded with a failure active), their status will not be updated in VISPRO and the buttons for them in the 
Malfunctions page will not work correctly. To correct the problem, restart VISPRO.

After resetting an engine shutdown or an engine fire malfunction, you have the option of restarting the engine 
(or engines) for the student by pressing the Restart Selected Engines button or the Restart All Engines button 
in the Control group. Alternately, the student can restart the engine (or engines) from within Flight Simulator.

instructor station record-playback page

The Record-Playback page features a powerful Flight Data Recorder that continuously records the aircraft 
position and flight and environment parameters of all connected Flight Simulator sessions at the same time. 
You can track and display multiple parameters simultaneously on a scrolling graph, both in real-time and during 
the playback of a previously saved Flight Track.

In addition, you have the option to export selected Flight Data in tab-delineated format for analysis in a 
spreadsheet program and you are able to review current and saved flight tracks and even have the student 
re-fly a flight from any position in a recording.

The Flight Data Recorder will continuously record Flight Data for all connected Flight Simulator sessions 
at the same time, however, only Flight Data for the currently active Flight Simulator session can be viewed 

on the Record-Playback page. Make sure to first switch to the Flight Simulator session you want to view or 
export Flight Data for.

Selecting Plot Values to View and Record:
Plot values (flight and environment parameters) are color-coded and are displayed in the same order and in 
the same color on the scrolling graph as they are displayed in the list below the scroll bar. This allows you to 
keep track of the different plot values more easily. Displayed on the left side of the scrolling graph are the 
increments for each plot value, which are also color-coded to match the selected plot values.
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Data TracksPlot Value
Increments

Plot Value Color Code List

instructor station record-playback page

1) Left-click one or more plot values for the Flight Data Recorder to record. When Flight Simulator is running, 
the Flight Data Recorder will record the selected plot values and display them as data tracks on the scrolling 
graph. Only plot values with a checkmark will be recorded. Plot values can be added or removed at any 
time, even while Flight Simulator is paused. 

Remember, although Flight Data is recorded for all Flight Simulator sessions at the same time, only Flight 
Data for the active Flight Simulator session is displayed on the scrolling graph. To view the Flight Data of 

another Flight Simulator session, switch to that session to make it active. Selected plot values will be the same 
for all connected Flight Simulator sessions, although the Flight Data will differ.

Click to Select
Plot Values

Selecting Plot Values to View and Record, Continued....

Changing the Scale Type and Scale Resolution:
You are able to change the scale type between time and distance and increase and decrease the scale 
resolution of the scrolling graph to suit your preference.

1) To change the scale type, left-click the Scale drop-down box, then highlight and choose either the Distance 
option or the Time option.

Scrolling Graph

Scale Option

Scale
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Moving Within the Scrolling Graph:

2) To change the scale resolution, press the '+' button to increase the scale resolution or press the '-' button 
to decrease the scale resolution. Increasing the scale resolution allows you to see greater detail among 
the data points on the scrolling graph and decreasing the resolution decreases the detail among the data 
points on the scrolling graph, but more data points are visible.

instructor station record-playback page

Changing the Scale Type and Scale Resolution, Continued....

Increase/Decrease Scale

Working with flight Tracks and Using the flight Data Replay function:
The Flight Data Replay function allows you to review or replay the student's current flight or a previously saved 
flight, either within VISPRO on the Moving Map or within Flight Simulator itself. You have the ability to move the 
student's aircraft to any position along the Flight Track and allow the student re-fly from that position. In addition, 
you can review saved Flight Tracks on the Moving Map or within Flight Simulator.

Moving to a specific time or distance position along the scrolling graph can be done with Flight Simulator 
paused or running. If you scroll to the left while Flight Simulator is running, the scrolling graph will display the 
previous Flight Data as if the Flight Data Recorder is paused. If you scroll all the way to the right, the graph will 
continued scrolling, displaying the latest Flight Data being recorded.

1) To move to a specific time or distance position along the scrolling graph, left-click the scroll bar and drag it 
right or left. When you scroll all the way to the right, the graph will automatically scroll further as new Flight 
Data is recorded so that you always see the latest plot values.

Left-Click and Drag

Scroll Bar
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1) To save the active Flight Track for later viewing and analysis, press the Save Track button. Select the folder 
you want to save the Flight Track in, then name the Flight Track and press the Save button to save the 
Flight Track.

Only the active Flight Track is saved. If you are connected to multiple Flight Simulator sessions and 
want to save multiple Flight Tracks, you will need to first switch to the desired inactive aircraft to make 

that Flight Track active, then save it separately.

2) To load a saved Flight Track for viewing and analysis, press the Load Track button. Navigate to the folder 
where your Flight Tracks are saved, then highlight the desired Flight Track and press the Open button to 
open the Flight Track.

When you load a saved Flight Track, recording of new Flight Data will be disabled because the current 
aircraft position is no longer connected to the Flight Track. To re-enable recording, either clear the Flight 

Track or press the Re-Fly in FS button. For more information, see the Re-Flying in Flight Simulator section on 
page 49.

3) To clear the active Flight Track, press the Clear Track button. Any Flight Data displayed on the scrolling 
graph, in addition to the Flight Track displayed on the Moving Map, will be erased.

Saving, Loading and Clearing flight Tracks:
Flight Tracks are not only displayed on the Moving Map to show the student's flight path, but they also 
contain all of the Flight Data that the Flight Data Recorder records on the scrolling graph. The active Flight 
Track can be cleared or saved, or a previously saved Flight Track can be loaded for use with the Flight 
Data Replay function.

instructor station record-playback page

Working with flight Tracks and Using the flight Data Replay function, Continued....

Save, Load and Clear Track Buttons

Reviewing flight Simulator Session flight Data:
Flight data at specific points along the Flight Track can be reviewed at any time on the scrolling graph without 
interfering with Flight Simulator. This allows you to review Flight Data at any time during the student's flight, 
whether Flight Simulator is paused or running. In addition, the aircraft icon on the Moving Map will move to 
the actual position on the Flight Track that matches the point you're viewing the Flight Data on the scrolling 
graph at. This allows you to see exactly where the student's aircraft was at any given time during the flight. 
For example, if you notice unexpected Flight Data on the scrolling graph, you can select that position on the 
scrolling graph and the aircraft icon on the Moving Map will move to that position on the Flight Track so you 
can see where the aircraft was at the time.
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Reviewing flight Simulator Session flight Data, Continued....
Flight data from the active Flight Simulator session can be reviewed at any time during the students flight. You 
have the option of either pausing Flight Simulator first or allowing Flight Simulator to continue running.

instructor station record-playback page

Working with flight Tracks and Using the flight Data Replay function, Continued....

Flight Track

Aircraft Icon

Click and Drag

Vertical Line

Reviewing flight Tracks Using the Replay function:
Using the Replay function, you are able to review the current Flight Track or a previously saved Flight Track on 
the Moving Map and, if desired, use the Show in FS option to review the Flight Track from the student's 
perspective from within Flight Simulator. The Replay function allows you to review the student's entire flight 
from beginning to end or only selected portions of the flight. In addition, you will be able to review the 
recorded Flight Data on the scrolling graph as the flight is replayed.

The current Flight Track can be reviewed or a previously saved Flight Track can be reviewed. If you want 
to review a previously saved Flight Track, that Flight Track must first be loaded into VISPRO. For more 
information, see the Saving, Loading and Clearing Flight Tracks section on page 46.

Whether you're reviewing the current Flight Track or a previously saved Flight Track that you've loaded 
into VISPRO, the steps in the section will be the same.

With flight Simulator Paused:
1) Press the  button to pause Flight Simulator. Left-click on the scrolling graph. A black vertical line will 

be displayed.

2) Left-click and drag the vertical line to the position along the scrolling graph you want to review the Flight 
Data at. The aircraft icon will move to that same position along the Flight Track on the Moving Map.

3) After reviewing the Flight Data, press the  button to resume Flight Simulator. The aircraft icon will 
snap to the end of the Flight Track and the Flight Data Recorder will resume recording.

With flight Simulator Running:
1) If Flight Simulator is running, you can still review Flight Data without interfering with the student's flight. 

Left-click on the scrolling graph and hold the left mouse button down to display a black vertical line.

2) While holding the left mouse button down, drag the vertical line to the desired position you want to re-
view the Flight Data at. The aircraft icon will move to that same position along the Flight Track on the 
Moving Map.

3) Release the left mouse button and the aircraft icon will snap to the end of the Flight Track.
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1) Press the  button to pause Flight Simulator. Flight Simulator must be paused to use this function.

2) If you want to review the Flight Track from within Flight Simulator, left-click the Show in FS option. With this 
option selected, when you play back the Flight Track for review, not only will the Flight Track be replayed 
on the Moving Map, but it will also be replayed within Flight Simulator.

3) Left-click on the scrolling graph. A black vertical line will be displayed.

4) Left-click and drag the vertical line to the position along the scrolling graph you want to begin reviewing the 
Flight Track at. The aircraft icon will move to that same position along the Flight Track on the Moving Map.

5) Press the  button start the Playback function and begin reviewing the Flight Track. The aircraft icon will 
begin to move along the Flight Track on the Moving Map and the recorded Flight Data will begin scrolling. 
If the Show in FS option is enabled, the flight will be played back in Flight Simulator, too.

Reviewing flight Tracks Using the Replay function, Continued....

instructor station record-playback page

Working with flight Tracks and Using the flight Data Replay function, Continued....

Click and Drag

Vertical Line

Show in FS Replay Buttons

Flight Tracks can be reviewed when VISPRO is not connected to Flight Simulator, however, the Show in FS 
function will not work. Simply load the saved Flight Track you want to review, then follow step 1 and steps 
3 through 6 above. Even though Flight Simulator is not running, you will still need to press the  button to 
use the Playback function. A dialog box saying "Unable to communicate with FS" will be displayed. Press 
OK to close the dialog box, then review the Flight Track as described in the steps above.

At any time while you're reviewing the Flight Track, you can click and drag the vertical line in the scrolling 
graph to move the aircraft to a different position along the Flight Track, however, you must first press the  
button to stop the Playback function, click and drag the vertical line to the desired position, then press 
the  button to resume the Playback function.

6) When you're finished reviewing the Flight Track, press the  button to stop the Playback function.

If you're reviewing an active Flight Track, the student's aircraft will be moved to the end of the Flight 
Track when Flight Simulator is resumed.
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Press Re-fly in FS

Remaining Flight
Data Erased

Once the student begins flying from the new position, the remainder of the Flight Track and recorded 
Flight Data will be erased. A new Flight Track and Flight Data will begin recording from the new starting 

position. Before re-flying in Flight Simulator, we recommend that you save the current Flight Track so that you 
can review it at a later time if desired.

Re-flying in flight Simulator:
The student's aircraft can be placed at any position along the Flight Track to allow the student to begin flying 
again from that position. This allows the student to re-fly the entire flight or a specific portion of the flight to 
gain practice in areas deemed necessary after review.

instructor station record-playback page

Working with flight Tracks and Using the flight Data Replay function, Continued....

The student is able to re-fly from any position along the current Flight Track or from a previously saved 
Flight Track. If you want the student to re-fly from a previously saved Flight Track, that Flight Track must first 
be loaded into VISPRO. For more information, see the Saving, Loading and Clearing Flight Tracks section 
on page 46.

1) Press the  button to pause Flight Simulator. Flight Simulator must be paused to use this function.

2) Left-click the Show in FS option, then left-click on the scrolling graph. A black vertical line will be displayed.

3) Left-click and drag the vertical line to the position along the scrolling graph you want the student to begin 
re-flying in Flight Simulator at. The aircraft icon will move to that same position along the Flight Track on 
the Moving Map.

4) Press the Re-Fly in FS button, then press the OK button when asked if it's okay that the remainder of the 
Flight Track will be erased. The student's aircraft will be placed at the selected position on the Flight Track 
and that position will be reflected in Flight Simulator.

 After pressing the OK button, the Show in FS option will automatically be cleared. This is normal.

5) Press the OK button to close the dialog box, then press the  button to resume Flight Simulator. The 
Student can now begin re-flying from the selected position in Flight Simulator.
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Displaying the flight Plan with a Saved flight Track:
When you open a saved Flight Track for review, the Flight Track will be displayed on the Moving Map, however, 
the Flight Plan will not be displayed. If you want to display the Flight Plan along with the Flight Track on 
the Moving Map (for example, to review course deviations), you will need to load the Flight Plan separately 
via the Instructor Station Flight Plan page. For more information, see the Instructor Station Flight Plan Page 
section on pages 37 ~ 41.

1) Open the saved Flight Track, then load the saved Flight Plan via the Instructor Station Flight Plan page. 
When you load the saved Flight Plan, press the NO button when asked if you would like the aircraft 
Repositioned at the departure airport. This ensures the student's aircraft will remain in the selected position 
along the Flight Track.

2) Press the  button to zoom to the student's aircraft on the Moving Map and enable Aircraft Following.

instructor station record-playback page

Working with flight Tracks and Using the flight Data Replay function, Continued....

exporting flight Tracks:
Flight Tracks can be exported into a tab-delineated format for analysis in a spreadsheet program.

2) Open the exported file using the spreadsheet program of your choice. When viewing the file, the first row 
contains a header describing each of the selected Plot Values at the time you exported the Flight Track. 
Subsequent rows beneath each column represent the actual values for each Plot Value. One row represents 
one Data Point.

1) To export the Flight Data of the current Flight Track, press the Export Selected Values button. Navigate to 
the folder you would like to save the file in, type a name for the file, then press the Save button. 

Press to Export
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1) Press the  button to pause Flight Simulator, then press the Airport Directory button to open the Airport 
Directory dialog box. Type the desired airport name into the Airport Name field or type the desired airport 
ID into the Airport ID field. The selected airport will be highlighted gray in the Airport field. Alternately, you 
can scroll through the Airport field and left-click the desired airport to select it.

2)  Left-click the desired runway in the Reference Runway field to highlight it, then left-click the Reposition for 
Takeoff option.

3) Press the OK button. You will be asked to save the current Flight Track or not. If you want to save the current 
Flight Track, press the Yes button. If you don't want to save the current Flight Track, press the No button. The 
selected airport and runway will be displayed in the Reference Airport/Runway field and Flight Simulator will 
load with the student's aircraft positioned at the end of the selected runway, in the ready for takeoff position.

4) When the student is ready to begin flying, press the  button to resume Flight Simulator.

After repositioning the student's aircraft, press the  button to zoom to the student's aircraft on the 
Moving Map and enable Aircraft Following.

instructor station reposition page

The Reposition page allows you to have complete control over the position of the student's aircraft in and 
around the airport runway. You are able to place the student's aircraft at any airport or on any runway in Flight 
Simulator and position it at the end of the runway, in the ready for takeoff position or position it at specific 
positions around the selected runway. The Airport Directory contains the complete list of airports in Flight 
Simulator and allows you to search for an airport either by name or airport ID. You can also choose a different 
aircraft type for the student to fly, using the Select Aircraft function, and load saved Flight Simulator flights, 
using the Select Flight function.

Aircraft repositioning, selecting aircraft and loading saved flights are session-specific. If VISPRO is connected 
to multiple Flight Simulator sessions, make sure to first switch to the Flight Simulator session you want to 

control, prior to repositioning the student's aircraft, selecting a different aircraft or loading a saved flight.

Press to Open
Airport Directory

Choose Airport

Choose Runway
Select Reposition 

for Takeoff

Press OK

Selected Airport and Runway

Repositioning the Student's Aircraft for Takeoff:
This section details selecting the desired airport and runway, and positioning the student's aircraft at the end 
of the selected runway, in the ready for takeoff position.
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Repositioning the Student's Aircraft at a Specific Position:
This section details selecting the desired airport and runway, and positioning the student's aircraft at any one 
of the number of available positions on or around the runway.

instructor station reposition page

1) Press the  button to pause Flight Simulator, then press the Airport Directory button to open the Airport 
Directory dialog box. Type the desired airport name into the Airport Name field or type the desired airport 
ID into the Airport ID field. The selected airport will be highlighted gray in the Airport field. Alternately, you 
can scroll through the Airport field and left-click the desired airport to select it.

2)  Left-click the desired runway in the Reference Runway field to highlight it. Make sure that the Reposition 
for Takeoff option is NOT selected, then press the OK button. The Airport Directory dialog box will close 
and the selected airport and runway will be displayed in the Reference Airport/Runway field.

3) If the runway features an ILS approach and you would like the aircraft's NAV1 receiver to automatically tune 
to the ILS frequency upon loading, left-click the Tune to the ILS Frequency option to select it.

If the runway you chose does not feature an ILS approach, the Tune to ILS Frequency option will be 
grayed out whether the checkbox is selected or not.

Press to Open
Airport Directory

Choose Airport

Choose Runway

Press OK

Selected Airport and Runway

Selected Airport and Runway

Press to Reposition Aircraft

Select to Enable ILS Auto-Tune
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Repositioning the Student's Aircraft at Specific Position, Continued....
4) Press the desired button you want to position the student's aircraft at, then press the OK button. You will be 

asked to save the current Flight Track or not. If you want to save the current Flight Track, press the Yes 
button. If you don't want to save the current Flight Track, press the No button. Flight Simulator will load with 
the student's aircraft positioned at the location you selected.

5) When the student is ready to begin flying, press the  button to resume Flight Simulator.

After repositioning the student's aircraft, press the  button to zoom to the student's aircraft on the 
Moving Map and enable Aircraft Following.

instructor station reposition page

Selecting and Loading a Different Aircraft:
The Select Aircraft function allows you to select a specific aircraft type and livery for the student to fly. Choose 
from any aircraft type and livery available in the active Flight Simulator session.

1) Press the  button to pause Flight Simulator, then press the Select Aircraft button to open the Aircraft 
Selection dialog box.

2) Left-click on the desired aircraft to select it, then left-click on the desired livery.

3) Press the OK button to load the selected aircraft into Flight Simulator. You will be asked to save the current 
Flight Track or not. If you want to save the current Flight Track, press the Yes button. If you don't want to save 
the current Flight Track, press the No button. Flight Simulator will re-load with the aircraft type and livery you 
selected.

4) When the student is ready to begin flying, press the  button to resume Flight Simulator.

Selecting and Loading a Saved flight:
The Select Flight function allows you to load a saved flight from the active Flight Simulator session's PC into 
Flight Simulator. This is useful when the student saves his or her flight on their Flight Simulator PC and you 
need to resume the flight at a later time to continue training. Saved flights can be loaded from the Local PC 
or Remote PC. 

Press to Open
Select Aircraft

Choose Livery

Choose Aircraft

Press OK
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1) Press the  button to pause Flight Simulator. 

2) Press the Select Flight button to open the Flight Selection dialog box. A list of saved flights on the currently 
active Flight Simulator session's PC will be displayed in the Flight Selection dialog box.

Selecting and Loading a Saved flight, Continued....

instructor station reposition page

Press to Open
Select Aircraft

Choose Flight

Press OK

instructor station fuel-loading page

The Fuel-Loading page allows you to change the fuel, passenger and baggage loading of the student's aircraft 
both prior to takeoff and after takeoff. For example, you could change the fuel quantity in one fuel tank during 
flight to simulate a fuel imbalance caused by incorrect use of the aircraft's fuel selector. Changes in fuel quan-
tity are even displayed on the aircraft's fuel gauges.

The Fuel-Loading page also displays the currently selected aircraft's empty weight, total fuel weight, total 
payload weight, total weight and its maximum allowable weight.

Changing the aircraft's fuel and weight parameters is session-specific. If VISPRO is connected to multiple 
Flight Simulator sessions, make sure to first switch to the Flight Simulator session you want to control, 

prior to changing the aircraft's fuel and weight.

3) Left-click on the desired flight to highlight it, then press the OK button to load the saved flight into Flight Simulator. 
You will be asked to save the current Flight Track or not. If you want to save the current Flight Track, press 
the Yes button. If you don't want to save the current Flight Track, press the No button. Flight Simulator will 
load the saved flight.

4) When the student is ready to begin flying, press the  button to resume Flight Simulator.

After loading the saved flight, press the  button to zoom to the student's aircraft on the Moving Map 
and enable Aircraft Following.

Only flights saved in the My Documents\Flight Simulator X Files folder (if using Microsoft® Flight Simulator X) 
or the My Documents\Prepar3D Files folder (if using Lockheed Martin® Prepar3D™) will be displayed in the 
Flight Selection dialog box.
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Changing fuel-Loading Values:

instructor station fuel-loading page

1) To change the fuel and/or payload weight of the student's aircraft, left-click the desired field to highlight 
the current value, then enter a new value. When values are changed, the respective total weights will be 
updated and displayed. Press the Top Tanks button to top off the fuel tanks.

2) Press the Apply button to apply the changes to the student's aircraft in Flight Simulator. 

If you attempt to enter a fuel quantity or weight value that exceeds the maximum allowed for the student's 
aircraft, VISPRO will display an error message.

Adjust Fuel
Quantity

Adjust Pilot, Passenger 
and Baggage Quantities

Press Apply

Resetting fuel-Loading Values:
Resetting the fuel and payload values allows you to undo any changes you make and reset the values to what 
they were prior to the last time you pressed the Apply button.

1) Press the Reset button to undo any changes you've made to the fuel and payload values. Fuel and payload 
values will be reset to what they were prior to the last time you pressed the Apply button.

Applying fuel-Loading Values:
1) When you are satisfied with fuel and payload values, press the Apply button to apply those changes to the 

student's aircraft.

If for some reason the student changes the amount of fuel, number or weight of passengers, or payload from 
within Flight Simulator, those changes will not be displayed on the Fuel-Loading page until you press the 
Reset button.

Fields that are grayed out display aircraft weight values only. These cannot be changed.

Flight simulator tends to overly exaggerate the left and right banking of the aircraft when the fuel and/or 
passenger weights are not equal. If the aircraft is too far out of balance laterally, it can make the aircraft 
abnormally difficult to control.
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instructor station options page

The Options page allows you to customize specific VISPRO features and functions to suit your specific 
requirements. Change approach parameters, disable hardware acceleration, change if and when VISPRO 
automatically checks for updates and more.

Change Options

Press Apply

Changing Approach Parameters:
Approach parameters can be changed to customize the Approach Profile on the Moving Map and the approach 
pattern settings on the Reposition page. The following parameters can be changed:

 Approach Speed - Changes the default speed at which the aircraft starts at when you reposition the 
student's aircraft on any one of the approach or downwind positions using the Reposition page. The default 
setting is 70 Knots.

 Default Approach Angle - Changes the default approach angle displayed on the Approach Profile on 
the Moving Map and the position that the aircraft is placed at vertically in relation to the runway when you 
reposition the student's aircraft on one of the three Final positions using the Reposition page. The default 
approach angle is 3 degrees.

 This option ONLY affects approaches that DO NOT have an ILS glideslope. If the approach features 
an ILS glideslope, the ILS glideslope is always used.

 Pattern Width - Changes the distance that the aircraft is placed at from the runway to the downwind leg 
when you reposition the student's aircraft on one of the Downwind positions using the Reposition page. The 
default setting is 0.5 Nautical Miles.

 Downwind AGL - Changes the altitude that the aircraft is placed at when you reposition the student's 
aircraft on one of the two Downwind positions using the Reposition page. The default setting is 1500 Feet.

1) To change an approach parameter, left-click and highlight the specific approach parameter field that you 
would like to change, then enter a new value and press the Apply button to apply the changes to VISPRO. 
The next time you press one of the Reposition page buttons, the changes will be reflected in Flight Simulator.

The text on the actual buttons in the Reposition page will not change, however, any approach parameter 
changes will still be reflected in Flight Simulator.
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instructor station options page

Disabling Hardware Acceleration:
If you are experiencing an incompatibility with the Moving Map and the 3-D graphics card and/or display 
drivers on the PC running VISPRO (e.g. the Moving Map doesn't render properly), you can use the Disable 
Hardware Acceleration option to fix it. When the Disable Hardware Acceleration option is enabled, the Moving 
Map is rendered using software-based graphic acceleration. When the Disable Hardware Acceleration option 
is disabled, the Moving Map is rendered using your PCs 3D graphics card and display drivers.

1) To disable 3-D hardware acceleration, left-click the Disable Hardware Acceleration option (checked). The 
default setting is disabled (cleared). 

We suggest enabling the Disable Hardware Acceleration option only if you're experiencing display 
problems with the Moving Map that cannot be fixed by upgrading your PCs 3-D graphics card and/or 

display drivers. Due to the nature of software-based graphics acceleration, slower performance of the Moving 
Map may occur on some systems.

2) Press the Apply button to apply the changes to VISPRO. You will need to close VISPRO, then restart it for the 
changes to take effect.

Only if Necessary, Click to
Disable Hardware Acceleration

Press Apply

Changing Miscellaneous Options:
Several miscellaneous options can be changed to customize VISPRO to suit your particular needs. The following 
options can be changed:

 Ask About Saving the flight Track - Selecting this option will cause VISPRO to prompt you to save the 
Flight Track when moving or relocating the student's aircraft. Clearing this option will disable the prompt to 
save the Flight Track when moving or relocating the student's aircraft. The default setting is enabled.

 Allow the Weather engine to Cycle When Changing Weather Settings - Selecting this option will cycle 
and refresh the weather dialog engine/screen when changing weather parameters. Flight Simulator 
contains a bug that will not always allow temperature and layers to update properly. Selecting this option 
will correct this but will momentarily cycle the default weather engine screens. Clearing this option will not 
recycle the weather engine and will provide instantaneous weather changes, but may not update temperature 
and layers parameters. The default setting is enabled.



58

VISPRO VIRTUAL INSTRUCTOR STATION PRO USER'S GUIDE

instructor station options page

Changing Miscellaneous Options, Continued....
 Show Label Next to the Student Aircraft - To help you keep track of each student's aircraft on the Moving 

Map, each aircraft icon is labeled. When multiple Flight Simulator sessions are connected to VISPRO, this 
makes it easier for you to keep track of each student's aircraft. Selecting this option enables student aircraft 
labels and clearing this option disables student aircraft labels. The default setting is enabled.

 Display On-Screen Keyboard When You Touch an edit Box - If you are using VISPRO with touchscreen 
monitors, this option enables an on-screen keyboard that allows you to input data when you touch a field. 
For example, touching the Airport Name field in the Reposition page Airport Directory dialog box will enable 
an on-screen keyboard to type in the airport name. Selecting this option enables the on-screen keyboard 
function and clearing this option disables the on-screen keyboard. The default setting is disabled.

Changing Compass Overlay Options:
This option allows you to choose two different orientation types for the Compass Overlay displayed on the 
Moving Map. Choose the Show True Heading option to orientate the compass to point toward True North or 
choose the Show Magnetic Heading option to orientate the compass to point toward Magnetic North.

1) Left-click the Compass Overlay options drop-down menu, highlight and left-click the desired option to select 
it, then press the Apply button to apply the changes to VISPRO.

 This function is compatible only when used with touch-screen monitors.

Change Options

Press Apply

1) To change one of the options described previously, left-click the option to either enable the option (checked) 
or disable the option (cleared), then press the Apply button to apply the changes to VISPRO.

Saving Window Positions:
This option allows you to save the current size and position of the Moving Map and  Instructor Station windows.

1) After adjusting the size and orientation of each window, press the Save Window Positions button, then press 
the OK button to verify your choice. When you run VISPRO from now on, the Moving Map and the Instructor 
Station windows will open to the sizes and in the same positions they were saved in.
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1) Choose how you want Update Check to check for VISPRO updates. The following options are available:

 Check for Updates - Enable this option (checked) if you want VISPRO to automatically check for updates. 
Disable this option (cleared) if you want to turn OFF Automatic Update Check.

 When the Check for Updates option is enabled, you can choose how often you want VISPRO to automatically 
check for updates. For example, if you want VISPRO to check for updates on a monthly basis, select the 
Every radio button, then enter 30 days. If you would like VISPRO to automatically check for updates each 
time VISPRO is started, select the Every Time the Program is Started radio button. The default setting is 
Check for Updates Every 1 Days.

 Check Now - You can manually check for VISPRO updates at any time by pressing the Check Now! button. 
Use this option if you've disabled Automatic Update Check.

2) Press the Apply button to apply the changes to VISPRO.

instructor station options page

Checking for Product Updates:
VISPRO features an Update Check function which makes it easy to keep your software up to date. The Update 
Check function can be configured to automatically check for updates, either every time VISPRO is started or at 
user-defined intervals. In addition, automatic updates can be turned OFF, allowing you to manually check for 
updates only when desired.

Change Options

Press Apply

When VISPRO checks for updates, your Internet browser will open the Flight1 Aviation Technologies Software 
Update web page. The software version you're using and the current software version will be displayed. If an 
update is available, instructions will be provided to download and install the update.

Resetting Option Page Values:
Resetting the Option page values allows you to undo any changes you make and reset the values to what they 
were prior to the last time you pressed the Apply button.

1) Press the Reset button to undo any changes you've made to the Option page values. Values will be reset to 
what they were prior to the last time you pressed the Apply button.
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instructor station advanced weather page

The Advanced Weather page allows you to control the weather in Flight Simulator to test the student's flying 
skills in ever-changing environmental conditions. Choose to create and save user-defined weather profiles, 
load saved weather profiles or apply real world weather METARs for the ultimate in realism. Change individual 
weather option values for clouds, winds, temperature, pressure and visibility. Adjust Microburst and Downdraft 
properties, and even control the season and time of day.

Any changes made through the Advanced Weather page, except for the Dispatch METAR Weather 
function, deleting Microbursts and Downdrafts, and changing the season and the time of day, which are 

all session-specific, affect all connected Flight Simulator sessions on a global basis. For example, if you create 
a User-Defined Weather Profile and apply that weather to Flight Simulator, or if you apply Real World METAR 
Weather to Flight Simulator, that same weather will be applied to all connected Flight Simulator sessions. 

Creating User-Defined Weather Profiles:
User-defined weather profiles can be created by making changes to the various weather option values in the 
Clouds, Wind, Temperature and Pressure, and Visibility pages. After making the desired changes, your weather 
profile can be applied to all connected Flight Simulator sessions and even be saved for later use. 

Adding, Selecting and Deleting Layers:
Cloud, wind, temperature and visibility layers can be added, selected and deleted using the layers graph on 
the right side of the Clouds, Wind, Temperature and Pressure, and Visibility pages. This allows you to create 
separate weather layers with different weather option values. For example, you can create multiple cloud 
layers, separate visibility layers and different wind layers, etc. 

1) In the default configuration, each weather option page contains one layer that features its own specific 
weather option values. To add a new layer, press the Layer "+" button. The currently selected layer will be 
displayed in blue and any other layers will be displayed in white.

2) If desired, the scale of the layers graph can be increased or decreased by pressing the Scale "+" button 
or the Scale "-" button, respectively. In addition, you are able to scroll the layers graph up and down using 
the layers graph slider if you need to view layers that you can't otherwise see.  

3) To delete a layer, left-click on the desired layer in the layers graph to select it or select the desired layer in 
the Layer drop-down menu, then press the Layer "-" button.

Layers Graph

Selected Layer (Blue)

Other Layer (White)

Left-Click to Choose

Scroll Up or Down

Change Scale

Choose Layer

Add (+) / Delete (-) Layers
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1) Left-click the desired weather option page you want to make changes to.

2) Left-click on the desired layer in the layers graph to select it. The selected layer will turn blue, indicating 
you can make weather option value changes to it. Alternately, you can select the desired layer in the Layer 
drop-down menu.

3) Make changes to the desired weather option values. Changes to weather option values are made by 
left-clicking on the desired weather option fields and inputting new values, left-clicking and dragging the 
weather option sliders, and left-clicking and selecting drop-down menu options. In addition, you are able 
to left-click and drag the selected layer up down to change the altitude of the layer, and in some cases, 
you can drag the top and bottom of the selected layer to change the top and base altitudes of the layer.

4) Repeat the steps above to make weather option value changes to any other desired weather option pages 
and/or individual layers.

The Precipitation Base Altitude value in the Clouds page defines the altitude that precipitation stops. If you 
want precipitation to fall to the ground, this value should be set to zero or a negative value.

Changing Weather Option Values:
Weather option values, such as cloud coverage and type, precipitation, wind speed, temperature, dew point, 
barometric pressure, visibility, and much more can be customized in the Clouds, Wind, Temperature and 
Pressure, and Visibility pages. 

You are able to customize weather option values separately for each layer, which allows you to create multiple 
layers of varying weather. This gives you the ability to create very realistic weather profiles for specific 
environmental training conditions.

instructor station advanced weather page

Left-Click to Choose 
Select Layer (Blue)

Choose Weather
Option Values

Microburst and Downdraft properties, in addition to Season and Day/Night values are not used when 
creating User-Defined Weather profiles. These options are adjusted independently of any weather 

option values.

Saving User-Defined Weather Profiles and Applying User-Defined Weather to flight Simulator:
After making the desired weather option value changes to create a weather profile, you are able to apply that 
weather profile to all connected Flight Simulator sessions, and if desired, save the weather profile for later use.

Select Desired
Weather Option Page

Creating User-Defined Weather Profiles, Continued....
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instructor station advanced weather page

1) Left-click the User-Defined Weather radio button to select it.

2) If you want to save your weather profile at the same time you apply it to Flight Simulator, skip to step # 3 
below. If you want to apply your weather profile to all connected Flight Simulator sessions without saving 
it, ensure that the Save Weather Profile option is disabled (cleared) and press the Create Weather button. 
Your weather profile will be applied to all connected Flight Simulator sessions.

Saving User-Defined Weather Profiles and Applying User-Defined Weather to flight Simulator, Continued....

Press Create Weather

Select User-Defined Weather

3) If you want to save you weather profile, left-click the Save Weather Profile option to enable it (checked), then 
press the Create Weather button. Your weather profile will be applied to all connected Flight Simulator 
sessions and the Save a Weather Theme dialog box will open.

4) Type a name for your weather profile, navigate to desired folder you want to save your weather profiles 
in (if different that the default location), then press the Save button to save your weather profile in the 
selected folder.

Press Save
Name File

Select Save Weather Profile,
Then Press Create Weather



VISPRO VIRTUAL INSTRUCTOR STATION PRO USER'S GUIDE

63

In the default configuration, weather profiles are saved in the Flight1 Aviation Technologies | Virtual Instructor 
Station Pro | Plugins | wxprofiles folder. Within this folder are two temporary weather profiles (f1metar.wtb 
and f1weather.wtb). These temporary weather profiles contain weather data for the last METAR and the last 
User-Defined Weather Profile applied to Flight Simulator.  

1) Left-click the User-Defined Weather radio button to select it, then press the Load Weather Profile button. The 
Open a Weather Theme dialog box will open.

2) Navigate to the folder where your weather profiles are saved, highlight the desired weather profile and press 
the Open button to load it, then press the Create Weather button. Your weather profile will be applied to all 
connected Flight Simulator sessions.

instructor station advanced weather page

Loading User-Defined Weather Profiles and Applying User-Defined Weather to flight Simulator:
This section describes how to load a saved weather profile and apply that weather to all connected Flight 
Simulator sessions.

Press Open

Select File

Press Load Weather Profile

Clearing flight Simulator Weather:
The Clear Weather function is used to clear any applied User-Defined Weather or Real World METAR Weather 
from all connected Flight Simulator sessions and reset Flight Simulator's weather to "clear skies".

1) Press the Clear Weather button to clear the weather in all connected Flight Simulator sessions. The weather 
will be reset to "clear skies" and the barometric pressure will be reset to 29.92.

Pressing the Clear Weather button does not reset or otherwise change any of the weather option values in 
the various weather pages. It does not delete Microbursts and Downdrafts, or reset the season and time 

of day, since these are controlled independently of the weather engine. In addition, when you're using Real 
World METAR Weather, pressing the Clear Weather button will stop METAR weather. For more information, 
see the Using Real World METAR Weather section on pages 66 ~ 69.

Press Clear Weather
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instructor station advanced weather page

Changing the Season and Time of Day:
The season and time of day can be changed from within the Visibility page to suit your preference. For example, 
change the season from Summer to Fall or change the time of day from Day to Night. This allows the student 
to not only train under different weather conditions, but also different environmental conditions.

Changing the season and time of day are session-specific. If VISPRO is connected to multiple Flight 
Simulator sessions, make sure to first switch to the Flight Simulator session you want to control, prior to 

changing the season or time of day.

1) Left-click the Visibility page button to open the Visibility page.

2) To change the season, left-click the Season drop-down menu and select the desired season, either Winter, 
Spring, Summer or Fall.

3) To change the time of day, left-click the Day/Night drop-down menu and select the desired time of day, 
either Day, Dawn/Dusk or Night.

When you select a different season and/or time of day, the active Flight Simulator session will re-load 
immediately. This is normal.

Select Time of DaySelect Season

Changing Microburst and Downdraft Properties:
Microburst and Downdraft properties can be changed from within the Wind page to suit your preference. For 
example, you can change the radius values to increase or decrease the overall size of Microbursts and Downdrafts, 
or you can change the force values to increase or decrease the power of Microbursts and Downdrafts. In 
addition, you can change the altitude values of Microbursts and Downdrafts to allow you to create Microbursts 
and Downdrafts at ground level (for approach training) or at altitude (for enroute training).

The following Microburst and Downdraft properties can be changed:

 Total Radius and Radius - These values determine the outer radius of Microbursts and Downdrafts. The 
default values are 1500 Feet and 1000 Feet, respectively.

 Inner Radius - This value determines the inner radius of a Microburst. The default value is 500 Feet.

 Outer force and Inner force - These values determine the force that pushes you up and down in a 
Microburst. The outer force is the force that pushes you up and the inner force is the force that pushes you 
down. The default values are 3.0 Meters Per Second.
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1) Left-click the Wind page button to open the Wind page.

2) Left-click the desired field you want to change a Microburst or Downdraft value for, then enter a new value. 
When a new value is entered that new value takes effect immediately.

3) Repeat step 2 to change any other desired Microburst and Downdraft values. 

New values will not effect Microbursts and Downdrafts that have already been created on the Moving 
Map. New values only effect new Microbursts and Downdrafts that you create. For more information 

about creating Microbursts and Downdrafts on the Moving Map, see the Controlling Microbursts and Downdrafts 
section on pages 27 and 28.

instructor station advanced weather page

 force - This value determines the force that pushes you down in a Downdraft. The default value is 3.0 Meters 
Per Second.

 Altitude - This value determines the base altitude from which a Microburst or Downdraft extends up from. 
The default value is 0 Feet. When this value is set to zero, the base of the Microburst or Downdraft will be at 
ground level. All Microbursts and Downdrafts extend 400 feet up from the specified base altitude.

Changing Microburst and Downdraft Properties, Continued....

Deleting Microbursts and Downdrafts:
The latitude, longitude and altitude of each Microburst and Downdraft that you create is listed in the Remove 
Microbursts and Downdrafts field on the Wind page. This displays the location of all Microbursts and Downdrafts 
that you've created and gives you a place from which to delete them.

Microbursts and Downdrafts are displayed on the Moving Map and in the Remove Microbursts and 
Downdrafts field for all connected Flight Simulator sessions. If VISPRO is connected to multiple Flight 

Simulator sessions, make sure to first switch to the Flight Simulator session you want to delete Microbursts 
and Downdrafts from, prior to deleting them. This will ensure that you not only delete the entry (or entries) from 
the Remove Microbursts and Downdrafts field, but that those Microbursts and Downdrafts are actually deleted 
from the desired active Flight Simulator session.

If multiple Microbursts and Downdrafts are displayed and you don't want to delete them all at the same 
time, use the latitude, longitude and altitude values to determine which Microbursts and Downdrafts you 

want to delete.

Adjust Desired
Properties Values
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VISPRO is able to automatically apply METAR weather using either the Closest Airport option, which applies 
METAR weather using METAR information from the airport weather station that is closest to the active student's 
aircraft, or you can use the Input an Airport option to choose a specific airport and apply that airport's METAR 
weather to all connected Flight Simulator sessions. In addition, you are also able to dispatch the current 
METAR string to the active Flight Simulator session and have it scroll across the student's screen so that they 
can view the METAR information.

In order to use the Real World METAR Weather function, the PC that is running VISPRO must be connected 
to the Internet and have an active Internet connection.

1) Left-click the METAR/TAF page button to open the METAR/TAF page.

Using Real World MeTAR Weather:
For the ultimate in realism, VISPRO supports the use of Real World METAR Weather. The METAR/TAF page 
allows you to view the METAR report and TAF report (if supported by the reporting weather station), then apply 
that METAR weather to all connected Flight Simulator sessions.

1) Left-click to select the desired Microburst(s) and/or Downdraft(s) you want to delete. The selected entry 
(or entries) will be highlighted. If you decide you don't want to delete a highlighted entry, left-click the 
highlighted entry (or entries) to clear it. Entries that aren't highlighted won't be deleted.

2) Press the Remove Selected button. The selected Microburst(s) and/or Downdraft(s) will be deleted both 
from the Moving Map and from within the active Flight Simulator session.

Press to Remove

Left-Click to Select

instructor station advanced weather page

Deleting Microbursts and Downdrafts, Continued....

Left-Click to Select
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Applying MeTAR Weather Using the Closest Airport Option:
The Closest Airport Option allows you to view the METAR report and TAF report (if supported by the reporting 
weather station) from the weather station that is closest to the active student's aircraft and apply that weather 
to all connected Flight Simulator sessions. The METAR report displayed (and the METAR weather applied to 
Flight Simulator) will change based on the current position of the active student's aircraft position relative to 
the nearest weather station.

instructor station advanced weather page

Using Real World MeTAR Weather, Continued....

1) If it's not already selected, left-click the Closest Airport radio button to select it.

2) The airport identifier with a weather station that's nearest the active student's aircraft will be shown and 
that airport's METAR report and TAF report (if supported by the reporting weather station) will be displayed.

3) To apply the selected METAR weather, press the Real World METAR Weather radio button to select it, then 
press the Apply METAR Weather button. The Status indicator will change to Active and the current METAR 
weather will be applied to all connected Flight Simulator sessions.

Press to Apply

Left-Click to Select

Current METAR 
and TAF Reports

Left-Click to Select

In some cases, the Nearest Airport displayed may not actually exist in Flight Simulator. This can occur 
because the Real World METAR Weather function uses METAR information provided by the NOAA 

(National Oceanic and Atmospheric Administration). In some cases the NOAA database may not match the 
Flight Simulator or VISPRO airport database.

When using the Closest Airport option, METAR weather is updated once every minute to ensure the latest 
METAR weather information is applied to Flight Simulator. When the active student's aircraft nears a 

weather station, the weather will be automatically updated to reflect that weather station's METAR information.

If VISPRO is connected to two or more Flight Simulator sessions and you apply METAR weather using the 
Closest Airport option, the METAR weather reported by the active Flight Simulator session will be applied to 
all connected Flight Simulator sessions and will change for all connected Flight Simulator sessions when 
you switch from one session to another session. If the student's are in different geographic regions, the 
inactive Flight Simulator session student's can experience different weather when you switch to another 
student's Flight Simulator session that's in a different region.
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Applying MeTAR Weather Using the Input an Airport Option:
The Input an Airport Option allows you to choose a specific airport, view that airport's METAR report and TAF 
report (if supported by the reporting weather station), then apply that airport's METAR weather to all connected 
Flight Simulator sessions.

instructor station advanced weather page

Using Real World MeTAR Weather, Continued....

1) Left-click the Input an Airport radio button to select it.

2) Left-click the Input an Airport field and enter the desired airport identifier. That airport's METAR report and 
TAF report (if supported by the reporting weather station) will be displayed.

Press to Apply

Left-Click to Select

Current METAR 
and TAF Reports

Left-Click to Select

Input Airport Identifier

Stopping Real World MeTAR Weather:
Real World METAR Weather can be stopped at any time by pressing the Stop METAR Weather button. 
This option is generally used only when using the Nearest Airport option because that function updates the 
weather once every minute and when the active student's aircraft nears a new weather station.

1) Press the Stop METAR Weather button to stop METAR weather. The Status indicator will change to Idle 
and a snap-shot of the weather at the time you pressed the Stop METAR Weather button will be displayed 
in all connected Flight Simulator sessions until you apply METAR weather again or create and apply 
User-Defined weather.

Press to Stop
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Applying MeTAR Weather Using the Input an Airport Option, Continued....
3) To apply the selected METAR weather, press the Real World METAR Weather radio button to select it, then 

press the Apply METAR Weather button. The Status indicator will change to Active and the current METAR 
weather will be applied to all connected Flight Simulator sessions.

When you apply METAR weather using the Input an Airport option, the weather applied to Flight Simulator 
will be a snap-shot of the selected METAR at the time it's applied. Unlike when you use the Nearest Airport 

option, which is dynamic and continuously updated, the Input an Airport option is static.

instructor station advanced weather page

Using Real World MeTAR Weather, Continued....

Dispatching MeTAR Weather:
When you use Real World METAR Weather, the current weather METAR string can be dispatched to the 
active Flight Simulator session, so the student can view the METAR information.

Since the Dispatch METAR Weather function is session-specific, only the active student's Flight Simulator 
session will be able to view the METAR string. If VISPRO is connected to multiple Flight Simulator ses-

sions, make sure to first switch to the Flight Simulator session you want to control, prior to using the Dispatch 
METAR Weather function.

1) If VISPRO is connected to multiple Flight Simulator sessions, switch to the Flight Simulator session you 
want to dispatch the current weather METAR string to.

2) Press the Dispatch METAR Weather button. The current METAR string will be dispatched and will scroll 
across the top of the active student's screen once for each time you press the Dispatch METAR 
Weather button.

Press to Dispatch
METAR String

METAR String

plane icon maker

Plane Icon Maker is an application that allows you to create a new Moving Map aircraft icon to replace the 
stock Moving Map aircraft icon. For example, you can personalize the Moving Map by creating a custom 
aircraft icon that includes your flight school's logo. The Plane Icon Maker application can convert any basic 
image file (.jpg, .tiff, .gif, .bmp, etc.) into an aircraft icon.
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3) Left-click the saved image file and drag it anywhere onto the Plane Icon Maker application. Your custom 
aircraft icon will be displayed in the Preview Window on the left side of the application.

4) Click on the center of the aircraft icon to specify its center point. Specifying the center point will ensure that 
it displays correctly when turning on its axis along the Flight Track on the Moving Map.

5) If desired, change the width and the transparency of your custom aircraft icon by entering new values in the 
Icon Width and Transparency fields. How your custom aircraft icon appears in the Preview Window is how 
it will appear on the Moving Map.

6) Press the Save button to open the Windows Save As dialog box. Navigate to the Flight1 Aviation 
Technologies\Virtual Instructor Station Pro folder, name the file, then press the Save button to save the file.

Do not save the file with the name plane_icon or else the default aircraft icon will be overwritten. We 
recommend naming any custom aircraft icons something different.

7) After saving the file, press the Close button to close the Plane Icon Maker application.

2) Open the folder where you saved the image file, then run the Plane Icon Maker application located in your 
Start Menu at: Start - All Programs - Flight1 Aviation Technologies - VISPRO - PlaneIconMaker.exe

Saved File

Preview Window

plane icon maker

Creating a Custom Aircraft Icon:
1) Save the image file you would like to make into an aircraft icon in the folder of your choice on your PC.

The image file should be no larger than 256 x 256 pixels and it should be a minimum of 72dpi to ensure 
adequate resolution. In addition, the background of the image file should be white. For example, choose 

a black aircraft icon on a white background.

If using Windows 7 or Windows Vista, you may need to run the PlaneMakerIcon.exe with Administrator Rights 
and/or temporarily turn off User Account Control (UAC) in order to be able to save the icon file into Program 
Files and any sub-folders within.

VISPRO must be restarted for the new aircraft icon to be displayed.
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plane icon maker

Changing the Aircraft Icon:
In addition to any custom aircraft icons you create, there are four different stock aircraft icons located in the 
Flight1 Aviation Technologies\Virtual Instructor Station Pro folder. In order to display an aircraft icon on the 
Moving Map, the name of the desired aircraft icon must be named plane_icon.

1) Navigate to the Flight1 Aviation Technologies\Virtual Instructor Station Pro folder. Locate the file currently 
named plane_icon and rename it to something else, such as plane_icon.org. This will help ensure the file 
doesn't get overwritten if you would like to use it again later.

2) Rename the desired aircraft icon file, either your custom aircraft icon file or one of the other stock aircraft 
icon files, to plane_icon. That aircraft icon will now be displayed on the Moving Map.

Backup File
Rename File

object customization

An object customization file (colors.ini) is provided that allows you to adjust the color, line width and transparency 
of objects rendered on the Moving Map and the Google Earth Export View to suit your particular setup and 
personal preference.

The following objects can be adjusted for both the Moving Map and the Google Earth Export View separately, 
unless otherwise noted:

• Plotted Course
• Runways
• Scale (Moving Map Only)
• Measurement Tool (Moving Map Only)
• Terminal Intersections
• Details Text (Moving Map Only)
• Towered Airports
• Non-Towered Airports
• Victor Airways
• VORs
• VOR Disks

• Active Runway
• Class B Airspace Boundaries
• Class C Airspace Boundaries
• Class D Airspace Boundaries
• Military Airspace Boundaries
• Restricted Airspace Boundaries
• Approach Course
• Background (Moving Map Only)
• Compass (Moving Map Only)
• Compass Background (Moving Map Only)
• Details Border (Moving Map Only)

• Active Flight Track
• Inactive Flight Track
• Holds
• Holds Text
• ILS Feathers Outline
• ILS Feathers Fill
• Intersections
• Jet Airways
• Markers
• NDBs
• Inactive Aircraft Icon

Making Object Customizations:
1) Double-click the colors.ini file located in the C:\Flight1 Aviation Technologies\Virtual Instructor Station Pro 

folder. If Windows cannot find a program to open the colors.ini file, right-click the colors.ini file, then 
choose the Open With > Notepad Menu Bar option.
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3) After making the desired changes, save the colors.ini file by clicking File > Save Menu Bar option.

Changes made to any [MapColors] entries will be reflected on the Moving Map as soon as you save the 
colors.ini file. Changes made to any [GoogleEarthColors] entries will require you to re-export any previously 

saved Flight Tracks into Google Earth for the changes to be seen.

object customization

Making Object Customizations, Continued....
2) Follow the instructions inside the colors.ini file to make adjustments to the desired entries.

THIS SPACE INTENTIONALLY LEFT BLANK
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WELCOME
The Flight1 Aviation Technologies Garmin G1000 Student Simulator is a stand-alone software application designed 
to interface with Microsoft Flight Simulator X, Microsoft ESP or Lockheed Prepar3D™. The G1000 Student 
Simulator runs outside of Flight Simulator in its own windows (PFD, MFD and Audio Panel), and is not intended 
to be incorporated directly into a 2D instrument panel or virtual cockpit like typical gauges.

The G1000 Student Simulator can be run on the same PC as Microsoft Flight Simulator X, Microsoft ESP or 
Lockheed Prepar3D™ (using one or more monitors), or on a separate PC connected to Flight Simulator via 
a network. Running the G1000 Student Simulator on a dedicated networked machine will provide the best 
performance and user experience with no frame rate affect at all on Flight Simulator.

The G1000 Student Simulator will work with any aircraft loaded into Microsoft Flight Simulator X, Microsoft ESP 
or Lockheed Prepar3D™. Multiple aircraft-specific G1000 configurations are available. Each goes far beyond 
what the default Microsoft Flight Simulator X, Microsoft ESP or Lockheed Prepar3D™ G1000 (or derivative 
third-party add-ons), provide.

Some of the many things you’ll be able to do include: 

    l  Fly Fully-Coupled WAAS/LPV Approaches in Both Vertical and Lateral Modes

    l  Fly Holds

    l  Fly Procedure Turns

    l  Fly DPs and STARs

    l  Use GPSS Anticipated Steering and Prompts

    l  Store and Load Flight Plans

       
Additional features include: 

    l  An Integrated Garmin GFC 700 Autopilot

    l  Cities on the PFD Inset and MFD Maps

    l  North Up and Heading Up Map Configurations

    l  An Updatable Navigation Database So You Can Train Using the Same Frequencies You Use When You Fly

    l  Pop-Up Tooltips When You Hover Over Buttons and Knobs Makes Learning Easier, Plus Much More

       
Unlike part-task trainers like the G1000 simulator available from Garmin, the G1000 Student Simulator works 
together with Microsoft Flight Simulator X, Microsoft ESP or Lockheed Prepar3D™ to provide an immersive 
training experience. The G1000 Student Simulator provides a rich avionics simulation, and Microsoft Flight 
Simulator X, Microsoft ESP and Lockheed Prepar3D™ provides an unmatched aircraft and environmental simulation. 
By combining both, you can learn and master the G1000 in the same cognitive environment in which you’ll use 
it. You’ll have to manage the avionics while simultaneously managing the challenges of flying an airplane.

We’ve worked hard to make sure that our G1000 Student Simulator provides the features you need. We think 
that you'll agree the result is the most cost-effective and flexible G1000 simulation available.

Jim Rhoads 
Vice President, Flight1 Aviation Technologies
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Installing the G1000 Student Simulator Communication Module

The G1000 Student Simulator requires that the G1000 Student Communication Module be installed on the PC 
that is running Microsoft Flight Simulator X, Microsoft ESP or Lockheed Prepar3D™. This module allows the 
G1000 Student Simulator to communicate with Flight Simulator. For more information, see the Communication 
Module section on page 7.

Software Activation

Prior to using your software, it must first be Activated. The Product Activation Code (Serial Number or Registration 
Number) is printed on a sticker on the inside of the CD sleeve. For more information about software Activation, 
see the Activating Your Software section on page 6.

IMPORTANT INFORMATION
IMPORTANT! PleASe ReAd ANd UNdeRSTANd BefORe USe!

Although this software is designed to help you learn to use the Garmin G1000 Integrated Flight Deck, not all 
systems have been simulated, and some of those that have been simulated may not be entirely functional or 
simulated to 100%. Should any difference in functionality appear, always refer to the official Garmin G1000 
Integrated Flight Deck Pilot's Guide (see the About This Users Guide Section on the next page). Using this 
product doesn't replace the need to work with a certified instructor to ensure thorough and correct training!

Flight1 Aviation Technologies is not responsible for errors in training due to differences in functionality between 
the Garmin G1000 Flight Deck you're using and the G1000 Student Simulator software. 

Interfacing with flight Simulator

The G1000 Student Simulator can be run without connecting to Flight Simulator, however many of the features 
will not function properly. Although you can become familiar with some features if running the G1000 Student 
Simulator by itself, the G1000 Student Simulator should be connected to Flight Simulator to take full advantage 
of this software.

Continued on Next Page

Setup and User Tips

We've provided Setup and User Tips on page 5 to help you answer some more common questions that you might 
have regarding the G1000 Student Simulator and the G1000 Student Interface.

Important Information ............................................ Page 3

Setup and User Tips ................................................ Page 5

Activating Your Software ......................................... Page 6

Communication Module ........................................... Page 7

G1000 Student Simulator

Overview ........................................................... Page 8

Launching the G1000 Student Simulator .............. Page 9

Connecting to Flight Simulator ............................. Page 9

Disconnecting from Flight Simulator ....................Page 11

G1000 Student Simulator, Continued....

G1000 Student Interface Main Selection Tab .......Page 11

G1000 Student Interface Options Selection Tab ...Page 12 

Displaying the PFD, MFD and Audio Panel ...........Page 15

Multiple Monitor Support ....................................Page 15

Disable Pause on Task Switch .............................Page 15

Using the G1000 Student Simulator ....................Page 16

Appendix (Check for Late-Breaking Information) ......Page 20
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IMPORTANT INFORMATION
Product Support

Flight1 Aviation Technologies strives to provided timely, reliable support.

l Product support is available from Flight1 Aviation Technologies support staff using our Ticket-Based Support 
system. This system provides one-on-one support to ensure you get answers to your support questions quickly 
and directly. To access Product Support, visit our Support website at http://www.flight1tech.com/Support.aspx

l If you encounter problems with product Activation, please visit our Activation website at www.flight1tech.com/register

Printing This User's Guide

Even though this User's Guide is designed in color to make it easy to 
read on your computer screen, if you wish to print this User's Guide 
and save ink at the same time, please choose to print in Grayscale, 
via your PC’s print dialog screen.

To ensure that the entire User's Guide prints, make sure to choose 
Reduce to Printer Margins and Auto-Rotate and Center in your 
Adobe Acrobat Reader print dialog box.

About This User's Guide

Please read through this User's Guide to become familiar with the Flight1 Aviation Technologies G1000 Student 
Simulator. The G1000 Student Simulator is a feature-packed software product that offers many powerful features 
that you'll want to familiarize yourself with prior to use. Taking the time to do this now will allow you to get the 
most out of your new software.

Use the Bookmark Display option in Adobe Acrobat Reader to make it easier to find the information 
you need.

This User's Guide details the installation and Activation of the G1000 Student Simulator software package. In 
addition, it details using the G1000 Student Interface.

In this initial release, the G1000 Student Simulator is modeled after the Garmin G1000 Cessna NAV III 
Integrated Flight Deck. In addition to several different Cessna Aircraft Configurations, we've also provided a 
Diamond DA40 Aircraft Configuration. More Aircraft Configurations will be available as plug-ins in the future.

Along with this User's Guide, you will need to use the Garmin G1000 Cessna NAV III Integrated Flight Deck 
Pilot's Guide or the Garmin G1000 DA40 Integrated Flight Deck Pilot's Guide to familiarize yourself with the 
Garmin G1000 Integrated Flight Deck's intended real-world use.

The Garmin G1000 Cessna NAV III Integrated Flight Deck Pilot's Guide is available by download directly from 
Garmin at http://www8.garmin.com/manuals/G1000:CessnaNavIIISystemSoftware0563.18_PilotsGuide.pdf

The Garmin G1000 DA40 Integrated Flight Deck Pilot's Guide is available by download directly from Garmin at 
http://www8.garmin.com/manuals/G1000:Diamond_PilotsGuide_DA40_DA40F0369.11orlater_.pdf
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SETUP AND USER TIPS
l If necessary, you can reactivate your software at any time by running the Activation Console from your Start 

Menu. For more information, see the Activating Your Software section on page 6.

l  To allow the G1000 Student Simulator to communicate with Flight Simulator, the G1000 Student Simulator 
Communication Module MUST be installed on each PC that is running Flight Simulator whether it's a Local PC 
or a Remote PC. For more information, see the Communication Module section on page 7.

l  The first time you launch the G1000 Student Simulator, it may take few minutes to load the database. When 
you launch the G1000 Student Simulator subsequently, the database will load much faster.

l  Although the G1000 Student Simulator can be used on the same PC that Flight Simulator is installed on, it's 
designed to be used remotely on a PC separate from Flight Simulator. This allows the utmost in flexibility, 
performance and the best overall experience.

l  Flight Simulator must be loaded and running in the Free Flight Mode so that the G1000 Student Simulator can 
connect to it. When Flight Simulator is run, you may be asked by Windows Firewall or your own Firewall 
solution to allow Flight Simulator to Unblock the network connection for Flight Simulator. Please allow this.

l  When you make changes using the G1000 Student Interface, those changes are saved for both the current 
session and for any future sessions.

l  We strongly recommend that you enable the Show Tooltips option to help you familiarize yourself with the 
different PFD, MFD and Audio Panel control functions and click-spots. For more information, see the Show 
Tooltips section on page 13.

l  If you're running the G1000 Student Simulator on the same PC as Flight Simulator, keep in mind that Flight 
Simulator and the G1000 Student Simulator all reside in their own separate windows and only one window 
can have 'focus' at any one time. Due to Flight Simulator limitations, if any of the G1000 Student Simulation 
windows are allowed to overlap the Flight Simulator window, when you click on the Flight Simulator window to 
gain focus of it (for example, to lower the flaps), the G1000 Student Simulator windows will be hidden behind 
the Flight Simulator window. This is not an issue if Flight Simulator is displayed on a secondary monitor or if 
you're running the G1000 Student Simulator on one PC and Flight Simulator on another PC.

l  If you're running the G1000 Student Simulator and Flight Simulator on the same PC, you will NOT hear Flight 
Simulator sounds, including COM and ATIS, when one the G1000 Student Simulator windows has 'focus'. You 
will be able to hear NAV, DME and ADF Ident sounds, plus other G1000-specific sounds though. If you're 
running the G1000 Student Simulator on the same PC as Flight Simulator, you MUST disable the Flight Simulator 
Pause on Task Switch option for correct integration. For more information, see the Enable Engine Sounds 
section on page 13 and the Using the G1000 Student Simulator section on page 16.

l  If your PC supports multi-monitors, the G1000 Student Simulator and Flight Simulator can be run at the same 
time on the same PC using two or more monitors. For example, some users may prefer displaying Flight 
Simulator on one monitor and displaying the G1000 Student Simulator PFD and MFD on a second monitor 
instead of displaying them on the same monitor as Flight Simulator. For more information, see the Multiple 
Monitor Support section on page 15.

l Enable the Autohide Interface and Save Window Positions options to optimize launching the G1000 Student 
Simulator. When you launch the G1000 Student Simulation and after it connects to Flight Simulator, the G1000 
Student Interface will automatically minimize to the taskbar at the PFD, MFD and Audio Panel windows will 
open in the same position and size that was last used.
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ACTIVATING YOUR SOFTWARE

If necessary, you can re-activate your software at any time by running the Activation Console from your 
Start Menu at: Start - All Programs - Flight1 Aviation Technologies - G1000 Student - G1000 Student Activation.

Software Activation

The Activation Console will appear at the end of the installation routine and you will be required to enter your 
product serial number, along with your name and your Email address. The software will not function unless it has 
been successfully Activated on the PC the G1000 Student Simulator is installed on.

In the default configuration, Activation requires that your PC be connected to the Internet. If your PC is not 
connected to the Internet, you have the option of using a different Internet-connected PC to Activate your 
software. For more information, please visit http://www.flight1tech.com/register

Enter the product Serial Number in field 1.

The Serial Number is printed on a sticker on the 
inside of the CD sleeve.

Enter your full name in field 2.

Enter your Email address in field 3.

Re-enter your Email address in field 4 to confirm it.

Ensure that your PC is connected to the Internet, 
then press the Register button. After the Activation 
process completes (this process should only take 
a few seconds), press the OK button to close the 
Activation Console.

If your PC is not connected to the Internet, 
press the *This Computer has no Internet 

Connection button and follow the on-screen 
prompts.

You can View or Reset your Product 
Registration at any time by clicking on the 

Product drop-down box at the top of the Activation 
Console.
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COMMUNICATION MODULE
Overview

The G1000 Student Simulator Communication Module allows the G1000 Student Simulator to communicate with 
Flight Simulator. The Communication Module must be installed on the PC that is running Microsoft Flight Simulator X, 
Microsoft ESP or Lockheed Prepar3D™, regardless if the G1000 Student Simulator is running on the same PC or 
not. If you're using the G1000 Student Simulator and Flight Simulator on two separate PCs on the same network, 
the Communication Module does not need to be installed on the PC running only the G1000 Student Simulator.

Installing and Running the G1000 Student Simulator Communication Module

The G1000 Student Simulator Communication Module Installer runs automatically at the end of the G1000 
Student Simulator software installation routine, at which time you will be prompted whether you want to install 
the Communication Module or not. If Flight Simulator is installed on the same PC as G1000 Student Simulator 
you should install the Communication Module during the G1000 Student Simulator installation routine. If only 
G1000 Student Simulator is installed on the Local PC and Flight Simulator is installed on a Remote PC, it's not 
necessary to install the G1000 Student Simulator Communication Module on the Local PC.

The G1000 Student Simulator Communication Module Installer will automatically detect whether you have 
Microsoft Flight Simulator X, Microsoft ESP and/or Lockheed Prepar3D™ installed and display the path to the 
respective program executable in the dialog box.

If the path to the executable is incorrect, press the select button, navigate to the executable for your Flight 
Simulator version, then click on it to highlight it and display the path in the dialog box.

If not already checked, click the checkbox next to the Flight Simulator path that you want to install the G1000 Student  
Simulator Communication Module to.

After verifying the correct path(s), press the Install Flight Simulator module(s) button to install the G1000 Student 
Simulator Communication Module onto your PC, then press the OK button to close the G1000 Student Simulator 
Communication Module Installer.

If for any reason you need to uninstall the G1000 Student Simulator Communication Module, press the 
Uninstall Flight Simulator Modules button and follow the on-screen prompts.

G1000 Student Simulator Communication Module Installation on flight Simulator PC

To allow the G1000 Student Simulator to communicate with Flight Simulator, the G1000 Student Simulator 
Communication Module MUST be installed on each PC that is running Flight Simulator whether it's a Local 
PC or a Remote PC. To install the Communication Module onto a Remote Flight Simulator PC, copy the 
G1000_network_module.exe file located in your Flight1 Aviation Technologies\G1000 Student\Network Module 
Installer folder to the PC that has Flight Simulator installed, then double-click the file to Run it. Follow the 
on-screen prompts to install the G1000 Student Simulator Communication Module on the Remote PC.



Page 8

G1000 STUDENT SIMULATOR
Overview

Each time you launch the G1000 Student Simulator, you will be presented with the G1000 Student Interface. The 
G1000 Student Interface allows you to choose a number of custom program options and provides the launching 
point for the G1000 PFD, MFD and Audio Panel. The G1000 Interface also allows you to connect the G1000 
Student Simulator to Flight Simulator.

Although the G1000 Student Simulator can be used on the same PC that Flight Simulator is installed on, it's 
designed to be used remotely on a PC separate from Flight Simulator. This allows the utmost in flexibility, 

performance and the best overall experience.

Help and Website - Press the Help button to open the G1000 Student Simulator User's Guide. To check for 
G1000 Student Simulator product updates, press the Check for Updates button. 

Network Connection Controls - Provides the tools necessary to connect the G1000 Student Simulator to 
Flight Simulator. Included is a Connect button, which is used to connect the G1000 Student Simulator to Flight 
Simulator and a Refresh button, which is used to detect your Flight Simulator PC's IP address should the network 
connection be lost. A dialog box displays the IP address of the Flight Simulator PC found on your network. In 
addition, if no IP address is automatically detected, the option of entering the IP address of your Flight Simulator 
PC is provided. When the Do Not Ask Again option is selected and an IP address is manually entered, the G1000 
Student will connect to Flight Simulator automatically when you launch the G1000 Student. In addition, the 
Network Connection Status Indicator is also displayed.

Option Selections - Displays the options that can be configured by the user for each Selection Tab.

Pfd, Mfd, Audio Panel and exit Controls - Used to display the G1000 PFD, MFD and Audio Panel. Press 
the Show PFD, Show MFD and Show Audio buttons to display the G1000 PFD and MFD, and the Audio Panel, 
respectively. Pressing each button a second time will close that specific instrument. Pressing the Exit button will 
close all three instruments and shut down the G1000 Student Simulator application. 

Selection Tabs - Used to display the Category Options that can be changed by the user.

PFD, MFD, Audio Panel and Exit Controls

Network Connection ControlsSelection Tabs

Option Selections

Help and Website

Continued on Next Page
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launching flight Simulator and the G1000 Student Simulator

Launch Flight Simulator and select the aircraft you would like to fly. We recommend selecting an aircraft that 
is similar to what you will be training in or are flying regularly. After selecting your desired aircraft, choose any 
other desired options, such as weather, location, etc., then press the Fly Now! button. For more information, see 
the Using the G1000 Student Simulator section on page 16.

After Flight Simulator loads, launch the G1000 Student Simulator by double-clicking the G1000 Student.exe 
shortcut on your desktop. If no desktop shortcut is present, launch the G1000 Student Simulator from your 
Start Menu at: Start - All Programs - Flight1 Aviation Technologies - G1000 Student - G1000 Student.exe

The G1000 Student Simulator can connect with only one instance of Flight Simulator at a time, even though 
multiple instances of Flight Simulator may be running on your network at the same time. If more than one 
instance of Flight Simulator is running on your network, click to highlight the specific IP address you would like 
to connect to, then press the Connect button as described above.

After the Database successfully loads, the G1000 Student Interface will be displayed. If Flight Simulator is running 
and is found on your network, it's IP address will be displayed and highlighted in the Flight Simulators Found 
on the LAN dialog box. To connect to Flight Simulator, press the Connect button. When successfully connected, 
Network Connection Status Indicator will change to Green and read G1000 Connected, and the Connect button 
will change to Disconnect.

If you launch the G1000 Student Simulator prior to launching Flight Simulator, the G1000 Student Simulator 
will not automatically detect your Flight Simulator PC's IP address. For more information, see the Using 

the Refresh Button section on the next page.

G1000 STUDENT SIMULATOR

Connecting to flight Simulator

The first time you launch the G1000 Student Simulator, it may take few minutes to load the database. When 
you launch the G1000 Student Simulator subsequently, the database will load much faster.

Flight Simulator must be loaded and running in the Free Flight Mode as described above so that the G1000 Student 
Simulator can connect to it. When Flight Simulator is run, you may be asked by Windows Firewall or your own 
Firewall solution to allow Flight Simulator to Unblock the network connection for Flight Simulator. Please allow this.

Continued on Next Page
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Network Connection Status Indicator

The Network Connection Status Indicator is positioned at the bottom of the Network Connection Controls. When 
no network connection is Active, G1000 Disconnected will be displayed in Red. When a network connection is Ac-
tive, G1000 Connected will be displayed in Green. If the G1000 Student Simulator is attempting to reconnect to the 
network, G1000 Lost Connection, Reconnecting will be displayed in Red and the Connect button will be grayed out. 
If this occurs, allow up to 1 minute for the G1000 Student Simulator to reconnect to Flight Simulator.

Connecting to flight Simulator, Continued....

Using the Refresh Button

There may be a case where your Flight Simulator PC's IP address can't be found. For example, if you launch the 
G1000 Student Simulator prior to launching Flight Simulator, the G1000 Student Simulator will not automatically 
detect your Flight Simulator PC's IP address. In this case, press the Refresh button and the G1000 Student 
Simulator will detect your Flight Simulator PC's IP address. You can then connect to Flight Simulator as described 
in the Connecting to Flight Simulator section on the previous page.

G1000 STUDENT SIMULATOR

Entering the IP Address Manually

In some rare cases, the G1000 Student Simulator may not be able to automatically detect your Flight Simulator 
PC's IP Address. In this case, click the Enter IP Manually checkbox, enter the IP address of the PC running Flight 
Simulator, then press the Connect button. When successfully connected, Network Connection Status Indicator 
will change to Green and read G1000 Connected, and the Connect button will change to Disconnect.

Using the Do Not Ask Again Option

When the Do Not Ask Again option is selected, the G1000 Student Interface will save the IP address you manually 
entered and use it to connect to Flight Simulator automatically each time you launch the G1000 Student Simulator.

To locate your Flight Simulator PC's IP Address, use Windows Network and Sharing Center or contact your 
Network Administrator.

Continued on Next Page

If the G1000 Student Simulator cannot automatically reconnect to Flight Simulator, close the G1000 
Student Simulator, then launch it again and follow the procedures in the Connecting to Flight Simulator 

section on the previous page.
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disconnecting from flight Simulator

If desired, you can disconnect the G1000 Student Simulator from Flight Simulator at any time by pressing the 
Disconnect button on the G1000 Student Interface (the Connect button changes to the Disconnect button when 
the G1000 Student Simulator is connected to Flight Simulator). 

G1000 Student Interface Main Selection Tab

The Main Selection Tab allows you change options related to the V-Speeds that are displayed on the PFD Speed 
Tape. Seven preset Aircraft Configurations are provided to choose from. In addition, the Aircraft Configuration 
values can be changed and saved. This ensures that the PFD Speed Tape will display the correct V-Speeds for 
the specific aircraft you're flying.

Choosing a Preset Aircraft Configuration

Use the Aircraft Selection drop-down box to select one of the desired preconfigured aircraft we've provided. 
Choose from the Cessna 172S, Cessna 172R, Cessna 182T, Cessna 206H, Cessna T206H or the Diamond DA40. 
When a selection is made, the V-Speed values specific to that aircraft will be displayed in the V-Speed boxes 
and will be reflected on the PFD's Speed Tape.

Entering Custom V-Speed Values

If you're flying an aircraft that isn't one of the preconfigured aircraft we've provided, custom V-Speed values can 
be entered into each V-Speed box to match your specific aircraft. Once you enter your custom V-Speed values, 
press the Save button. Your custom V-Speed values will be saved until you change them again, choose another 
Aircraft Configuration or press the Reset Values button.

Resetting Custom V-Speed Values

Custom V-Speed values can be Reset to the V-Speed values of the currently selected aircraft in the Aircraft 
Selection drop-down box by pressing the Reset Values button.

G1000 STUDENT SIMULATOR

When you make changes using the G1000 Student Interface, those changes are saved for both the current 
session and for any future sessions.

Continued on Next Page
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G1000 STUDENT SIMULATOR

G1000 Student Interface Options Selection Tab

The Options Selection Tab allows you change options related to the G1000 Student Interface, the MFD Map, 
PFD Inset Map, Engine Sounds, Tooltips and more. Again, when you make changes using the G1000 Student 
Interface, those changes are saved immediately for both the current session and for any future sessions.

Autohide Interface

In the default configuration, the G1000 Student Interface will be displayed until you manually minimize it to the 
Taskbar. When the Autohide Interface option is selected, the G1000 Student Interface will automatically minimize 
to the Taskbar when launched.

V-Speed Symbols Definitions

The following V-Speed values are supported:

VSO  Stalling Speed or the minimum steady flight speed at which the aircraft is controllable in the landing 
configuration at maximum gross weight.

VS1  Stalling Speed or the minimum steady flight speed at which the aircraft is controllable.

VFE  Maximum Flap Extended Speed is the highest speed permissible with wing flaps in a prescribed extended 
position.

VNO  Maximum Structural Cruising Speed is the speed that should not be exceeded except in smooth air, and 
then only with caution.

VNE  Never Exceed Speed is the speed limit that may not be exceeded at any time.

VX Best Angle of Climb Speed provides the best altitude gain per unit of horizontal distance, and is usually 
used for clearing obstacles during takeoff.

VY Best Rate of Climb Speed provides the best altitude gain in the shortest amount of time.

VR Rotation speed. The speed of an aircraft at which the pilot initiates rotation to obtain the scheduled takeoff 
performance.

VG Best Rate of Glide Speed provides the best glide distance in an engine-out scenario.

Continued on Next Page
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G1000 STUDENT SIMULATOR

Show Tooltips

In the default configuration, Tooltips will not be displayed. When the Show Tooltips option is selected, Tooltip 
windows will display when you roll over a PFD, MFD or Audio Panel click-spot.

We strongly recommend that you enable the Show Tooltips option to help you familiarize yourself with 
the different PFD, MFD and Audio Panel control functions and click-spots.

Save Window Positions

In the default configuration, when you press the Show PFD button, Show MFD button or Show Audio button, the 
PFD, MFD and Audio Panel will open in the upper left corner of your monitor in the default window size. When 
the Save Window Positions option is selected, the PFD, MFD and Audio Panel window sizes and positions will be 
saved so that they will be the same size and in the same position the next time you launch the G1000 Student 
Simulator. This prevents you from needing to resize or move the windows to your desired position every use.

Regardless if the Save Window Positions option is selected or not, the G1000 Student Simulator will always 
remember if either the PFD, MFD or Audio Panel was open when you exit. For example, if you shut down 

the G1000 Student Simulator with the PFD and MFD windows open, the next time you launch the G1000 Student 
Simulator, the PFD and MFD windows will open, too, but they will open in the default size and position, unless the 
Save Window Positions option is selected.

Enable Engine Sounds

This option is for those users who are running the G1000 Student Simulator and Flight Simulator on the same PC. 
Because both Flight Simulator and the G1000 Student Simulator run in their own separate windows, only one window 
can have 'focus' at a time and this affects how you hear sounds. For example, when the Flight Simulator window has 
focus, you will hear Flight Simulator sounds, but no G1000 Student Simulator sounds. When one of the G1000 Student 
Simulator windows has focus, you will hear G1000 Student Simulator sounds, but no Flight Simulator sounds. This is a 
limitation of how Flight Simulator works. When the Enable Engine Sounds option is selected, you will be able to hear 
generic aircraft engine sounds when one of the G1000 Student Simulator windows has focus, but you will not be able 
to hear any other Flight Simulator sounds. When this option is disabled, you will not be able to hear aircraft engine 
sounds when one of the G1000 Student Simulator windows has focus.

Use the Volume slider to decrease or increase the volume of the G1000 Student Simulator engine sounds.

Continued on Next Page
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Show MOA, Show Railroads and Show Water/Ocean Names

In the default configuration, these options are enabled. When enabled, MOA (Military Operations Airspace), 
Railroads and Water/Ocean Names are displayed on the MFD Map and the PFD Inset Map. When disabled, MOA 
(Military Operations Airspace), Railroads and Water/Ocean Names are not displayed on the MFD Map or the PFD 
Inset Map. 

If you experience Map display performance issues, these options can be disabled to improve performance.

PFD and MFD Map Orientation North

In the default configuration, the PFD Inset Map is configured to display in Heading Up mode. When you select 
the Map Orientation North option, the PFD Inset Map will display in North Up mode.

In the default configuration, the MFD Map is configured to display in Heading Up mode. When you select the Map 
Orientation North option, the MFD Map will display in North Up mode.

G1000 STUDENT SIMULATOR
Options Selection Tab, Continued....

Continued on Next Page
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G1000 STUDENT SIMULATOR
displaying the Pfd, Mfd and Audio Panel

Because the PDF, MFD and Audio Panel each reside in a window, the windows can be resized or dragged to 
any desired position on your monitor, or even be moved to a secondary monitor (if using multiple monitors). 

To display the PFD, MFD and Audio Panel, press the Show PFD button, Show MFD button and/or Show Audio 
Panel button on the G1000 Student Interface. When one of these buttons is pressed, that specific instrument 
will be launched and displayed in its own window.

Continued on Next Page

Multiple Monitor Support

If your PC supports multiple-monitors, the G1000 Student Simulator and Flight Simulator can be run at the same 
time on the same PC using two or more monitors. For example, some users may prefer displaying Flight Simulator on 
one monitor and displaying the G1000 Student Simulator PFD and MFD on a second monitor instead of displaying 
them on the same monitor as Flight Simulator. To use multiple monitors, do the following:

Connect the G1000 Student Simulator to Flight Simulator following the procedures in the Connecting to Flight 
Simulator section on pages 9 and 10. If you're using two monitors, drag the PFD, MFD and Audio Panel windows 
to one monitor and leave Flight Simulator on the second monitor.

When using more than one monitor on a single PC running both the G1000 Student Simulator and Flight 
Simulator at the same time, overall performance may be reduced, particularly if your PC is near the lower end 
of the recommended specifications. We recommend using multiple monitors only if you have a high-end PC 
(Intel Dual or Quad Core with high-end video card such as nVidia GeForce GTX or equivalent).

disable Pause on Task Switch

If you're running the G1000 Student Simulator on the same PC as Flight Simulator, 
you MUST disable the Flight Simulator Pause on Task Switch option for correct 
integration.

If this option is enabled, every time you click on the one the G1000 Student 
Simulator windows, Flight Simulator will pause.
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G1000 STUDENT SIMULATOR
Using the G1000 Student Simulator

The G1000 Student Simulator is designed to interface with Flight Simulator to provide an immersive training 
experience. Although the G1000 Student Simulator can be used with any Flight Simulator aircraft, even add-on 
aircraft that you might have purchased separately, the G1000 Student Simulator PFD, MFD and Audio Panel reside 
in their own separate windows which can be placed anywhere on your monitor (or secondary monitor) and is not 
intended to be incorporated directly into a 2D instrument panel or virtual cockpit like typical gauges.

Continued on Next Page

Follow the steps below to configure Flight Simulator and the G1000 Student Simulator on a single PC, single 
monitor setup:

1) Launch Flight Simulator and select the aircraft you would like to fly. We recommend selecting an aircraft that 
is similar to what you will be training in or are flying regularly. After selecting your desired aircraft, choose any 
other desired options, such as weather, location, etc., then press the Fly Now! button. When Flight Simulator 
has finished loading, press the 'F10' key to switch to the 2D panel view.

2) Launch the G1000 Student Simulator and Connect to Flight Simulator following the procedures in the 
Connecting to Flight Simulator section on pages 9 and 10.

3) Open the PFD, MFD and Audio Panel following the procedures in the Displaying the PFD, MFD and Audio 
Panel section on the previous page. For the best training environment on a single monitor, we recommend 
configuring the G1000 Student Simulator and Flight Simulator windows as shown in the screenshot below. 
This allows you to view and control the G1000 instruments while Flight Simulator displays the scenery. 

Your aircraft's 2D instrument panel can be hidden by pressing the 'W' key four times or by pressing 'Shift+1'. To 
control your aircraft's systems during flight, such as mixture, flaps, lighting etc., we recommend using Flight 

Simulator Key Commands. For more information, see step 4 on the next page.
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The Garmin G1000 Cessna NAV III System Pilot's Guide is available by download directly from 
Garmin at:

http://www8.garmin.com/manuals/G1000:CessnaNavIIISystemSoftware0563.18_PilotsGuide.pdf

G1000 STUDENT SIMULATOR

G1000 Integrated Flight Deck Pilot's Guide

In this initial release, the G1000 Student Simulator is modeled after the Garmin G1000 Cessna NAV III Integrated 
Flight Deck. In addition to several different Cessna Aircraft Configurations, we've also provided a Diamond DA40 
Aircraft Configuration. More Aircraft Configurations will be available as plug-ins in the future.

Continued on Next Page

IMPORTANT! PleASe ReAd ANd UNdeRSTANd BefORe USe!

Although this software is designed to help you learn to use the Garmin G1000 Integrated Flight Deck, not all 
systems have been simulated, and some of those that have been simulated may not be entirely functional or 
simulated to 100%. Should any difference in functionality appear, always refer to the official Garmin G1000 
Integrated Flight Deck Pilot's Guide (see the About This Users Guide Section on the next page). Using this 
product doesn't replace the need to work with a certified instructor to ensure thorough and correct training!

Flight1 Aviation Technologies is not responsible for errors in training due to differences in functionality between 
the Garmin G1000 Flight Deck you're using and the G1000 Student Simulator software. 

The Garmin G1000 DA40 Integrated Flight Deck Pilot's Guide is available by download directly from 
Garmin at:

http://www8.garmin.com/manuals/G1000:Diamond_PilotsGuide_DA40_DA40F0369.11orlater_.pdf

Using the G1000 Student Simulator, Continued....

4) We recommend controlling the G1000 Student Simulator with your mouse and using Flight Simulator key 
commands to control your aircraft's functions during flight, such as mixture, flaps, lighting etc. This allows 
you to keep the Flight Simulator 2D panel hidden, while still being able to control Flight Simulator. 

If any of the G1000 Student Simulation windows are allowed to overlap the Flight Simulator window, when you click 
on the Flight Simulator window to gain focus of it (for example, to lower the flaps), the G1000 Student Simulator 
windows will be hidden behind the Flight Simulator window. This behavior is typical of all program windows. If Flight 
Simulator is displayed on a secondary monitor or if you're running the G1000 Student Simulator on one PC and 
Flight Simulator on another PC this is not an issue.

When running the G1000 Student Simulator on the same PC as Flight Simulator, keep in mind that Flight 
Simulator and the G1000 Student Simulator all reside in their own separate windows and only one window 

can have 'focus' and can be controlled at any one time. This is a limitation of Flight Simulator. For example, if 
you're using the G1000 MFD and need to raise your flaps, you will need to click on the Flight Simulator window 
to gain control of it, then raise the flaps by pressing 'F5'. Remember, a window must have 'Focus' to input a 
command, whether it be Flight Simulator or one of the G1000 Student Simulator window.

For information on using Keyboard Commands to control Flight Simulator, in a addition to a complete list 
of Flight Simulator Keyboard Commands, refer to the Flight Simulator Learning Center.
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G1000 STUDENT SIMULATOR
Using Click-Spots and Tooltips

All MFD, PFD and Audio Panel functions are controlled using click-spots. When you roll your mouse pointer over 
a click-spot, the mouse pointer will turn into a hand. This indicates you can left-click that spot to control its 
function. In addition, rotary dials can be turned using your mouse's scroll wheel. Moving the scroll wheel forward 
will increase function settings (turn dial clockwise) and moving the scroll wheel backward will decrease function 
settings (turn dial counter-clockwise).

If a control does not have a function associated with it, the mouse pointer will not turn into a hand or the 
Tooltip will read 'INOP'. In this case, the function is not modelled.

We strongly recommend that you enable the Show Tooltips option to help you familiarize yourself with the 
different PFD, MFD and Audio Panel control functions and click-spots. With this option enabled, when you 

hover the mouse pointer over a control, a small box will pop up describing the control's function. Each described 
control function is also a click-spot that controls that particular function. For more information, see the Show 
Tooltips section on page 13.

Tooltip

Tooltip

Continued on Next Page
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G1000 STUDENT SIMULATOR
Audio Panel Overview

This section details the modelled functions of the Audio Panel. The Audio Panel features a marker beacon receiver 
and controls for selecting and managing different audio sources, including COM receivers, NAV receivers, and 
ADF and DME receivers. In addition, the Audio Panel features a Display Backup button that shifts important 
information normally displayed on the MFD onto the PFD should the MFD fail for any reason (Revisionary Mode).

Functions for the PFD and MFD are referenced in the Garmin G1000 Cessna NAV III Integrated Flight Deck 
Pilot's Guide and/or the G1000 DA40 Integrate Flight Deck Pilot's Guide you downloaded separately. For more 
information, see the G1000 Integrated Flight Deck Pilot's Guide section on the previous page.

Only Audio Panel functions which are modelled are described.

Active COM and NAV frequencies are displayed in green on the PFD. In order to hear COM, NAV, DME and ADF 
audio, a valid frequency must be tuned and the aircraft must be within receiving range. 

1

3

5

6

8

2

4

7

9

10

1)  COM1 MIC - Selects the COM1 transmitter. Pressing COM1 MIC also turns 
COM1 audio ON.

2) COM1 - Press to turn COM1 audio ON or OFF.

3)  COM2 MIC - Selects the COM2 transmitter. Pressing COM2 MIC also turns 
COM2 audio ON.

4) COM2 - Press to turn COM2 audio ON or OFF.

5) MKR MUTe - Press to select and hear marker beacon sounds. When 
selected and a marker beacon sound is heard, press again to mute the 
marker beacon sound.

6) dMe - Press to turn DME receiver ident audio ON or OFF.

7) NAV1 - Press to turn NAV1 receiver ident audio ON or OFF.  

8) Adf - Press to turn ADF receiver ident audio ON or OFF.

9) NAV2 - Press to turn NAV2 receiver ident audio ON or OFF.

10) dISPlAY BACKUP - Press to enable Revisionary Mode. In this mode, 
important information normally displayed on the MFD will be displayed on 
the PFD. Press a second time to revert to Normal Mode.

Remember, if you're running the G1000 Student Simulator and Flight Simulator on the same PC, you will NOT 
hear Flight Simulator sounds, including COM and ATIS, when one the G1000 Student Simulator windows has 

'focus'. You will be able to hear NAV, DME and ADF Ident sounds, plus other G1000-specific sounds though.
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APPENDIX
This section includes information about the G1000 Student Simulator that was added after the original User's Guide 
was completed.

Updating the G1000 Student Simulator database

G1000 Student Simulator navigation data (AIRAC data) is provided by Navigraph, an online navigation database 
service. When desired, the G1000 Student Simulator navigation data can be updated to match current real-world 
navigation data by updating the AIRAC cycle. For more information, visit www.navigraph.com.

Currently installed Navigraph AIRAC data information can be found in the cycle_info text file located in your 
Flight1 Aviation Technologies - G1000 Student - Database folder.

WAAS approach data is provided by Flight1 Aviation Technologies and is separate from all other navigation data. 
To check for updates to WAAS approach data, please visit the G1000 Student Simulator sales page at 
www.flight1tech.com.

Using Keyboard Shortcuts

Keyboard shortcuts can be used to control many functions of the G1000 Student Simulator PFD, MFD and Audio 
Panel. Follow the procedures below to assign keyboard shortcuts to the functions desired:

1) Open the Keyboard INI file in a text editor (such as Notepad) by double-clicking the F1G1000_keyboard.ini 
file located in your Flight1 Aviation Technologies - G1000 Student folder. You will be presented with a list of 
functions that can be controlled by a keyboard shortcut. The functions that keyboard shortcuts can be 
assigned to for each instrument are separated by instrument name. For example, all functions that keyboard 
shortcuts can be assigned to for the PFD are listed under [G1000_PFD]. 

2) Scroll down to locate the function you would like to assign a keyboard shortcut to. For example....

 [G1000_PFD]
 ComSwap=

 ....then enter the keyboard shortcut you would like to use. For example....

 [G1000_PFD]
 ComSwap=ctrl+c

3) Repeat this process to assign keyboard shortcuts to any remaining functions you would like to, then SAVE 
and close the file.

Keyboard shortcuts must consist of combination commands only! For example, ctrl+c or shift+c or 
ctrl+shift+c. Single character commands are not supported. In addition, because only one G1000 Student 

Simulator window can be controlled at one time, duplicate key commands can be assigned to the same function 
for two different instruments for continuity. For example, you can assign the same command (e.g., ctrl+c) to 
control the Com Swap function on both the PFD and the MFD.

If you assign key commands while the G1000 Student Simulator is running, changes will not function without 
first closing the G1000 Student Simulator, then launching it again.

Flight1 Aviation Technologies is not responsible for errors in the AIRAC data. To report AIRAC data errors, please 
contact Navigraph at fmsdata@navigraph.com.
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